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n Artistic Expression

 

ion’s ability to use sophisticated 
hapes to create a stroke gives 
precedented creative freedom. Art-
choose from three different types 
s to apply to their illustrations:

 

l-Media Strokes

 

Media strokes mimic traditional 
ols such as paint brushes, pencils 
s.

 

 Element Strokes

 

 Element strokes include individual 
s and objects, similar to vector-
ip art, but can be applied along any 
 path.

   

Welcome  Page vii  Wednesday, November 6, 1996  4:57 PM
Welcome to Expression

Imagine... the stylistic expressiveness of 
pencils, brush strokes and other traditional 
artists’ tools, combined with the incredible 
flexibility, speed, editability and resolution 
independence of an advanced, vector-
based drawing application. As the first Nat-
ural-Media® drawing program, Fractal 
Design Expression software will change the 
way you think about vector-based illustra-
tion and the way you work as a computer 
artist. 

and simple, natural gestures, the Expres-
sion artist can vary stroke widths by press-
ing on the tablet. In addition, Expression is 
the first full-featured illustration applica-
tion to support transparency, allowing you 
to “layer” your strokes, an effect previously 
available only in bitmap paint programs.

The result is Natural-Media artwork never 
before possible in vector based drawing 
applications such as Adobe Illustrator™, 
Macromedia FreeHand™, and CorelDRAW!™.

Built-I
Express
vector s
users un
ists can 
of stroke

Natura

Natural-
artist to
and pen

Graphic

Graphic
drawing
based cl
drawing
iew Strokes

w strokes can incorporate both 
edia and graphic elements, but 

multiple views of the stroke. 
ion will automatically interpolate in 
 any of these views allowing the 
 add a more “random” look to his 
ions or even save them in Quick-
 AVI animations.

ion comes with over 350 built in 
 but the artist can easy create their 
tom strokes using any of the draw-
, or by importing graphics from 
ctor based drawing applications.
Expression’s power and agility come from 
its exclusive Skeletal Strokes™ technology. 
For the first time ever, artists can use a sin-
gle vector path to draw or edit sophisti-
cated, multi-element strokes or even 
complete illustrations. Simply select a 
drawing tool and a stroke style, and begin 
drawing.

To further enhance the Natural-Media feel, 

Multi-v

Multi-vie
natural m
contain 
Express
between
artist to
illustrat
Time or

Express
strokes,
own cus
ing tools
other ve
vii
Expression has full support for pressure 
sensitive tablets. Using the freehand tool 

Built-in artistic expression.



   

The artist has complete control to modify 

      

ment strokes, and more than 35 hatching, 

      

strokes. The fourth chapter describes how 
and choose colors for your images. 
th chapter contains information on 
ing and using strokes and fills.The 
hapter describes how to edit and 
e your paths and strokes. The sev-
hapter contains information on print-

st appendix describes common 
ms encountered while using Expres-
d possible solutions. The second 
ix is a glossary of new terms used 

hout the manual and in the Expres-
plication.

  

e realize that you may not have 
 read this entire manual, but the 
ation in Chapter 2 would be very 
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the stroke’s attributes. Strokes can include 
an unlimited number of separate paths and 
control points, variable widths, anchor 
points and repeatable areas.

Professional-level Illustration
Expression provides a full complement of 
professional-level drawing tools and a vari-
ety of vector-based operations such as lay-
ering, scaling, compounding, and blending 
of shapes. The Expression artist can rotate, 
skew, mirror and even add perspective to 
the vector objects in the illustration. This 
level of flexibility allows artists to create 
and transform objects easily.

A Powerful Complement to 

paper grain, and vector patterns. Expres-
sion also includes tools for fine tuning per-
spective, anti-aliasing, custom color 
support, as well as basic page layout capa-
bilities and font handling.

Compatibility
Expression works with art created in other 
drawing programs such as Adobe Illustra-
tor and CorelDRAW!. 

Expression supports export to: Photoshop 
2.5, BMP, PCX, PICT and TIFF rasterized bit-
map formats, Adobe Illustrator versions 3 - 
6, CorelDRAW! versions 3, 4, and 5, CGM, 
EPS, PICT and WMF vector formats, as well 
as AVI and QuickTime animation file for-

to use 
The fif
design
sixth c
arrang
enth c
ing. 

The fir
proble
sion an
append
throug
sion ap

Note: W
time to
inform
le in getting you comfortable enough 
t experimenting on your own.

ier Keys

a modifier key differs between the 
osh and Windows platform, the Mac-
 modifier is listed first followed by a 
nd the Windows modifier key. 
/Alt means Macintosh users press 
tion key and Windows users press 
. Key.

nces

a referral appears, directing you to 
r chapter in the book, it is high-
 in turquoise.
Existing Drawing Tools
While Expression is a full featured, stand-
alone application, it is also designed to 
complement existing drawing programs 
such as Adobe Illustrator, Micromedia 
FreeHand, and CorelDRAW!. The Expres-
sion interface and tools work similarly to 
these familiar applications. To streamline 
the integration with other desktop tools, 
Expression supports import and export to 
a wide variety of formats, including the 
standard vector formats, bitmap formats 
and animation formats.

Other Goodies
Expression ships with an array of content 

mats. 

About this User Guide
This user guide is a cross-platform manual, 
designed for use with the Windows and 
Macintosh versions of the Expression soft-
ware. Dialogs and windows displayed in 
this guide were taken from both versions of 
Expression. In some cases, where there 
were significant differences between plat-
forms, both versions are shown.

The Guide

The first chapter is an introduction. The 
second chapter provides a comprehensive 
tutorial to get you familiar with Expres-
sion’s features. The third chapter explains 

valuab
to star

Modif

When 
Macint
intosh
slash a
Option
the Op
the Alt

Refere

When 
anothe
lighted
viii Fractal Design Expression User Guide

that includes more than 150 Natural-Media 
and Multi-view Strokes, 200 Graphic Ele-

how to create paths on which you can 
apply Expression’s powerful vector 
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e information about Fractal 
roducts, see our World Wide 
 on the Internet:

  

http://www.fractal.com

ange tips and techniques with 
ers, see the following:

  

Keyword “Fractal”

 

erve:

 

 “GO GUGPRA”
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Conventions

There are several conventions used to 
identify paths to certain tools and controls. 
The convention to a menu follows the rule 
of the menu name> menu item. The 
convention to a palette follows the rule of 
the palette name: palette item.

Terms

Any term first introduced appears in italic. 
This word and its definition also appears in 
➤Appendix B, “Glossary.”

Technical Support
You will find the answers to most of your 
questions within the pages of this User 
Guide. Please check our Web site 
(www.fractal.com) for the most up to date 
information regarding Expression, a list of 
the most frequently asked questions and 
handy tips and tricks.

If you need further assistance, you may 
contact Fractal Design’s Technical Support 
in any of the following ways:

Phone: 408-430-4200 between the 
hours of 8am and 5pm,
Pacific Standard Time 

For M
For mor
Design p
Web site

www: 

To exch
other us

AOL: 

CompuS
te Symbol
 strokes includes in the Ult Symb 
irectory were chosen specifically 
n Expression from the Design 
s– A Digital Reference™, a collection 
than 3280 images by Ultimate 
Inc. All images are copyright © 1994 
 Symbol, Inc. 

e information or a free brochure 
e Ultimate Symbol Collection, 

 Symbol Inc. 
rness Drive
FAX: 408-430-9672

email: mac_support@fractal.com

win_support@fractal.com

Mail: Technical Support
c/o Fractal Design Corporation
P.O. Box 66959
Scotts Valley, CA 95067-6959

Ultima
The 200
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for use i
Element
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Ultimate

For mor
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31 Wilde
ix

int, NY 10980
14-942-0003
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r 1 • Overview of Expression

 

1

 

1

 

Overview of 
Expression

 

Even if you are experienced with 
vector-based graphics applications, 
this chapter will familiarize you with 
Expression’s interface and basic 
functions. If you are anxious to get 
started, you can skip this chapter 
and use it as a pictorial reference 
for tools and palettes. The tutorial 
in Chapter 2 can be used to 
acquaint you with most of 

 

Expression’s tools and techniques.
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Starting Expression

                       

2

 

Choose the 

 

New File 

 

button from the 

      

How an Expression Image 

 

ade

 

ost drawing software programs, 
sion’s objects are comprised of 

  

A path is a sequence of points 
) connected together as lines or 
. Expression allows an arbitrary mix-
 straight-lines, Bézier curves and 
e curves linked together to form a 

ath is assigned a 

 

stroke

 

 and a 

 

fill

 

. 
 refers to the outline or edge of an 
. Picking a stroke in Expression is 
 to picking up an artist’s brush.
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The first time you start Expression, you are 
asked for your serial number.

The serial number is located on the “Read 
This First” card and the Registration card.

To start Expression on a Macintosh:

1Double-click the Expression icon. The 
Expression tools and palettes appear.

2Choose the New File button from the 
Standard toolbar to open a new 

Standard toolbar to open a new 
document. You can also choose File 
menu> New.

Choose the New File button.

is M

Like m
Expres
paths. 
(nodes
curves
ture of
B-Splin
path. 

Each p
Stroke
object
similar
ers to the inside color or pattern. 
sion combines the stylistic expres-
ss of paint, brush strokes and other 
nal artists’ tools with the flexibility, 

 edibility and resolution indepen-
of an advanced, vector based draw-
lication.

path.
document. You can also choose File 
menu> New.

Choose the New File button.

To start Expression in Windows:

1Choose Start menu> Programs> 
Fractal Design Expression> Fractal 

Design Expression or double-click the 
Expression icon. The Expression tools 
and palettes appear.

Fill ref
Expres
sivene
traditio
speed,
dence 
ing app

Vector 
path with stroke.
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Vector path with stroke and fill.

Most drawing programs are limited to the 
attributes which can be assigned to strokes 
and fills. Expression removes this limita-
tion. With Expression, you can designate 
any vector picture as a stroke. This Skeletal 
Stroke™ technology can be applied to 
boxes, text, freeform shapes, lines—any-
thing you can create in Expression.

Expression uses three types of Skeletal 
Strokes:

• Natural-Media strokes

Graphic Element Strokes
These strokes contain vector drawings and 
objects. You can create a stroke out of any 
vector graphic. 

Graphic Element stroke.

Multi-View Strokes
Multi-view strokes incorporate both Natu-
ral-Media and graphic elements and consist 
w stroke of Natural-Media.

w stroke of a Graphic Element.
• Graphic Element strokes

• Multi-view strokes

Natural-Media Strokes
These strokes mimic traditional artist tools 
such as paint brushes, pencils and pens.

Natural-Media stroke.

of two or more related pictures. Expression 
automatically creates additional views in 
between those you start with, allowing you 
to quickly create related but non-identical 
images. 

As you can see in the examples, Expression 
creates in between views showing varying 
degrees of each element. Each time you 
apply a Multi-view stroke, you can specify 
which view is displayed or let Expression 
create them randomly. Multi-view strokes 
can also be saved as animations (Quick-
Time for Macintosh or AVI for Windows).

Multi-vie

Multi-vie
 1 • Overview of Expression 3
Chapter



   

Dip Right In!

                        

Expression’s Interface

 

sion’s interface consists of several 
f toolbars and palettes. Some of the 

rs and palettes open automatically 
ou launch Expression. You can hide, 
 or move any or all of the toolbars 
lettes on your workspace to meet 
articular working style. Each of the 
rs is explained later in this chapter. 
e will show you how to select and 
e toolbars in the Expression work-

 

Ch01.FM5  Page 4  Wednesday, November 6, 1996  5:40 PM
Since we know you are anxious to get 
started, we’ll introduce you to Expression 
at its most basic— creating a path and 
assigning a stroke.

Stroke Warehouse palette

Select a stroke from the Stroke Warehouse 
palette.

4Choose the Freehand tool from the Tools 
toolbar.

Expres
types o
toolba
when y
display
and pa
your p
toolba
First w
arrang
space.
Expression interface.

Try this:

1Choose File menu> New to open a new 
document.

2Scroll through the Stroke Warehouse 
palette to preview the hundreds of pre-
designed stokes available in Expression.

3Click on a stroke to select it.

Choose the Freehand tool.

5Using the Freehand tool, draw a path. 
The stroke you selected is applied to the 
path you created!

That’s all there is to it. Take some time to 
experiment with some of the other draw-
ing tools.
4 Fractal Design Expression User Guide



                      

K

 

. All selected toolbars appear on 
orkspace. You can resize and move 
rs as needed.

 

andard Toolbar

  

dard

 

 toolbar contains buttons for 
e menu commands. Choose 

 

Win-

enu> Toolbars

 

:

 

 Standard

 

 to tog-
tandard toolbar on and off. The 
 toolbar contains the following 

:

 

dard toolbar.
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The Toolbars

When you launch Expression some tool-
bars are displayed along the top and left 
side of the window.

Moving and Resizing Toolbars
To change the location of a toolbar, click-
drag in the gray toolbar frame area. Drag 
the toolbar to the middle of the window to 
let the toolbar float or drag a floating tool-
bar to the top, bottom, left, or right edge of 
the screen to dock the toolbar.

Resizing your toolbars.

Displaying Toolbars 
Expression allows you to customize your 
workspace by displaying the tools you use 
the most and hiding those you use less fre-
quently. 

3Click O
the w
toolba

The St
The Stan
basic Fil
dow m

gle the S
Standard
buttons

The Stan
e

a new Expression document.

ile

he standard Open dialog, allowing 
pen an existing Expression docu-
 graphics file. To limit file type to a 
file format, select the preferred 
m the Format or Files of Type field.
Moving your toolbars

The floating toolbars can be resized by 
dragging at the corners. Reposition a float-
ing toolbar by dragging its title bar.

To select which toolbars are displayed:

1Choose Window menu> Toolbars. 
The Toolbars dialog appears. Toolbars 
currently displayed on your workspace 
have a check mark in front of their name.

The Toolbars dialog.

New Fil

Creates 

Open F

Opens t
you to o
ment or
specific 
type fro
 1 • Overview of Expression 5
Chapter

2Click to select or deselect the toolbars 
you want to display.



             

The Composition Toolbar

               

e

 

 the currently selected object up one 
 the stack order of the current layer.

 

 One

 

 the currently selected object down 
el in the stack order of the current 
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Save File

Saves the current document to hard drive, 
floppy diskette, or other selected media.

Print

Displays the standard Print dialog, allowing 
you to print the current document. 

Cut

Removes selected object(s) from the work-

The Composition toolbar contains buttons 
that allow you to edit your document by 
clicking rather than using command key-
strokes. Choose Window menu> Tool-

bars: Composition to toggle the 
Composition toolbar on and off. The Com-
position toolbar contains the following but-
tons:

The Composition toolbar.

Up On

Moves
level in

Down

Moves
one lev
layer.

To Top
 the currently selected object to the 
el of the stack on the current layer.

ttom

 the currently selected object to the 
 level of the stack on the current 

e: Objects on the top draw last and 
re are not obscured by any other 

s. Objects on top appear to be in 
f any other objects on the same 
space and saves the selection to the Clip-
board until another selection is cut or 
copied. 

Copy

Copies selected object(s) to the Clipboard 
and saves the selection until another selec-
tion is cut or copied. 

Paste

Inserts information previously stored in the 
Clipboard into the document.

Select All

Selects all objects in the current document.

Deselect All

Deselects all objects in the current docu-
ment.

Delete Selection

Deletes all selected objects. The objects 
are not stored in the Clipboard. However, 

Moves
top lev

To Bo

Moves
bottom
layer.

; Not
therefo
object
front o
layer.
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you can use Expression’s Undo function to 
return the deleted selection.



                          

t Node Tool

 

s the characteristics of points from 
o curve or vice-versa.

 

ols

 

 tools.

 

 Node, Delete Node, Split Path, 
 Path and Change Start Point tools 
 to alter the path of a selected 
n order to use these tools the path 
 selected.
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Tools Toolbar
The Tools toolbar contains tools for basic 
object drawing and manipulation. Choose 
Window menu> Toolbars: Tools to tog-
gle the Tools toolbar on and off. For more 
information regarding the Tools toolbar 
see ➤Chapter 6, “Arranging and Editing 
Objects.” 

The Tools toolbar contains the following 
tools:

Selection Tools 

The Selection tools.

The Object Selection and Group Selection 
tools allow you to select individual objects 
or groups of objects.

Object Selection Tool

Selects objects or groups of objects.

Group Selection Tool

Conver

Convert
corner t

Path To

The Path

The Add
Reverse
are used
object. I
must be
de Tool

ew point along a selected path.

Node Tool

s a point from selected path.

th Tool

 path into two segments.
Selects an individual object within a group. 
Clicking again on the object selects the 
entire group.

Node Tools 

The Node tools.

The Node Selection and Convert Node tools 
are used to select and edit points within an 
object. Nodes are vector points used to 
define a path.

Add No

Adds a n

Delete 

Remove

Split Pa

Cuts the
 1 • Overview of Expression 7
Chapter

The Tools toolbar.
Node Selection Tool

Selects points on a path.



               

Classic Drawing Tools

 

assic Drawing tools

 

tools are used to draw freeform 
. After creating paths, you can use 

th tools (described above) to edit 
th. For additional information 
ing the drawing tools, see 

  

ter 3, “Creating Paths.”

 

and Tool

 

s shape paths by drawing freehand 
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Splitting a path, before and after.

Reverse Path Tool

Reverses the direction of the path and its 
Skeletal Stroke, if any.

Change Start Point, before and after.

Grabber Tool 

The Cl

These 
shapes
the Pa
any pa
regard
➤Chap

Freeh

Create
lines.
nd path.

ol 

s shape paths using standard Bézier 
.

Reverse path, before and after.

Change Start Point Tool

Relocates the starting point for the path, 
moving the starting point of any Skeletal 
Stroke to the new location.

Provides an alternative way to scroll an 
image. Click in the workspace and drag to 
move the page.

Magnifier Tool 

Allows you to magnify areas of an image 
when you are performing detailed work, or 
reduce your workspace to get an overall 
view of an image. Click to zoom in, or hold 
the Option/Alt key and click to zoom out. 
You can also drag a marquee to zoom into a 
specific area.

Freeha

Pen To

Create
points
8 Fractal Design Expression User Guide



                 

d Polyline path.

 

ol

traight lines. Hold down the Shift 
onstrain your line to 45° incre-
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Pen path.

Supplemental Drawing Tools

The Supplemental Drawing tools.

Expression’s Polyline, B-Spline and 
Smoothed Polyline tools provide additional 
ways of creating paths. These are espe-
cially useful for creating stylized artwork.

Polyline path.

B-Spline Tool

Draws smooth curves based on straight 

Smoothe

Line To

Draws s
key to c
or information on setting the angle 
raint, see ➤“Setting Preferences,” 
his chapter.

ect.

bject Tools 

pe Object tools.

ols are used to draw rectangles, 
, ellipses (ovals) and circles.
For more information regarding these 
tools, see ➤“Drawing Tools” in Chapter 3, 
“Creating Paths.”

Polyline Tool

Draws straight line and circular arc line 
segments.

line control polygon.

B-Spline path.

Smoothed Polyline Tool

Draws curved line segments.

ments. F
of const
later in t

Line obj

Shape O

The Sha

These to
squares
 1 • Overview of Expression 9
Chapter



Transformation Tools 

ansformation tools.

tools are used to transform selected 
s by rotating, scaling, mirroring, 

g, or applying perspective. For 
nformation regarding the Transfor-
 Tools, see ➤“Transforming 
s” in Chapter 6, “Arranging and Edit-
jects.”

ion Tool

 you to rotate selection. Click to set 
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Rectangle Tool

Creates rectangles and squares. Hold down 
the Shift key to constrain the object to a 
square.

Ellipse Tool

Creates ellipses or circles. Hold down the 
Shift key to constrain the object to a circle.

Text Tool

Objects containing gradients.

Dropper Tools 

The Dropper tools

The Tr

These 
object
shearin
more i
mation
Object
ing Ob

Rotat

Allows

ter of rotation, then click-drag to 

selection.

Tool

 you to change the size of selected 
. Click to set the anchor for the scal-
en click-drag to scale selection. 

r Tool

 you to create a mirror image of the 
d object. Click to set the center for 
lection, then click-drag to mirror the 
Creates text objects. Text objects can be 
applied to a path. Each letter can be 
assigned a distinct stroke and fill. Text can 
be converted to a path so you can edit the 
shape of each letter. For more information 
on working with text, see ➤Chapter 3, “Cre-
ating Paths.”

Gradient Tool

Controls the direction and rate of change 
for a gradient stroke or fill.

These tools allow you to quickly copy color 
or stroke and fill attributes from one part of 
your artwork to another.

Color Dropper Tool

Picks up color from one object, or area of 
an object, so you can drop the color onto 
another object or area. 

Attribute Dropper Tool

Picks up the stroke and fill attributes from 
one object, so you can drop the attributes 

the cen
rotate 

Scale 

Allows
object
ing, th

Mirro

Allows
selecte
the ref
on.
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r pattern a name. If you decide you 
nt to define the pattern press the 
ackspace key while the pattern 
lected.

 Tool/Repeat Tool

hor/Repeat tools.

ols are used to control the behav-
rticular parts of a Skeletal Stroke 
available only when the Stroke Defi-
indow is active. As a Skeletal Stroke 
d to a path it can be useful to have 
arts maintain their original pro-
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Shear Tool

Allows you to shear or skew the selected 
object. Click to set the center for the shear, 
then click-drag to skew the selection. For 
more information regarding the Shear tool, 
see ➤“Shearing Objects” in Chapter 6, 
“Arranging and Editing Objects.”

Perspective Tool

Allows you to apply a perspective effect to 
any selected object(s). This tool has two 
modes. In the first mode, an object is 
framed in preparation for applying per-

Definition Tools 

The Definition tools.

These tools are used to define Skeletal 
Strokes as well as Patterns to use as fills. 
For more information regarding these 
tools, see ➤“Creating and Editing Skeletal 
Strokes” and ➤“Applying Pattern Fills” in 
Chapter 5, “Applying Strokes and Fills.”

Stroke Definition Box

Opens the Stroke Definition window, allow-

Give you
don’t wa
Delete/B
box is se

Anchor

The Anc

These to
ior of pa
and are 
nition w
is applie
certain p
, while other parts of the same 
re stretched along the path. Like-
an be useful to specify that certain 
ould repeat along the path, rather 
etch.

e information regarding these 
e ➤“Using Anchoring” and 
ating Elements of a Stroke” in 
 5, “Applying Strokes and Fills.”

 Tool

ou to anchor selected points so 
ain a constant proportion when a 

Stroke is applied to a path. This is 
en you want specific parts of a 
spective. In the second mode, drag the cor-
ners of the frame to apply perspective.

When the perspective tool is first selected, 
it is in the framing mode. Drag the four 
small corner handles to set the perspective 
frame. Then click once off the object to 
switch to perspective mode; The handles 
become larger. Drag the handles to apply 
perspective.

ing you to create a Skeletal Stroke. Choose 
the Stroke Definition Box tool and drag a 
marquee around the artwork you wish to 
use as a Skeletal Stroke. The Stroke Defini-
tion window opens. To complete the 
stroke, click the Define button at the bot-
tom of the window. Give your stroke a 
name.

Pattern Definition Box

Allows you to define a new pattern from 
any artwork in the current document. 
Choose the Pattern Definition Box tool and 
drag a marquee around the artwork you 
wish to use as a Pattern. The artwork 

portions
stroke a
wise, it c
parts sh
than str

For mor
tools, se
➤“Repe
Chapter

Anchor

Allows y
they rem
Skeletal 
used wh
• Overview of Expression 11

Stroke to maintain their original 
ions. For example, the dog stroke 
Chapter 1

Before and after perspective.
within the marquee is repeated as a pat-
tern. To complete the pattern, click the 
Define button at the bottom of the window. 

Skeletal 
proport



below is defined with the head and tail The Actions Toolbar
tions toolbar includes controls for 

havior of node tangent handles as 
 the Ellipse Closure controls, Anchor 
peat controls and the Pressure Sen-
 buttons. Choose Window menu> 

ars: Actions to toggle the Actions 
r on or off. The Actions toolbar con-
he following buttons:

tions toolbar

Continuity Controls
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parts anchored to the beginning and end-
ing points of the stroke. The section 
between the two anchored areas can 
stretch on any long path but the tail and 
head remain the same.

Anchoring parts of a stroke.

To use this feature you must first use the 
Stroke Definition Box tool to select art-

Repeating parts of a stroke.

The Ac
the be
well as
and Re
sitivity
Toolb

toolba
tains t

The Ac

Node 
de Continuity controls.

of tangent handles is attached to 
ézier node on a path. The position of 
gent handles controls the shape of 

th between nodes. Nodes that are 
 points have their tangent handles 
ed so you can not see them. 

de Continuity buttons determine 
lected nodes and handles are con-
 when editing. Select a node then 
e preferred Node Continuity button. 
re information regarding Node Con-
 see ➤“Selecting and Moving Points” 
work that will be used as a stroke.

Repeat Tool

Allows you to define selected objects to 
repeat rather than distort as Skeletal Stroke 
is applied to path. For example, you might 
create a train with an engine, a passenger 
car and a caboose. Anchor the engine to 
the beginning point and the caboose to the 
ending point. Then define the passenger 
car as repeating. The length of path to 
which you apply such a stroke determines 
how many passenger cars are contained in 
your train.

The No

A pair 
each B
the tan
the pa
corner
retract

The No
how se
trolled
click th
For mo
tinuity
pter 6, “Arranging and Editing 
s.”
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ou to create an ellipse line segment 
y a pair of straight lines. These 
nect with each other in the center 

lipse.

ith pie line segments.
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Symmetrical

Positions the tangent handles so they are 
opposite each other and equidistant from 
the node.

Smooth

Positions the tangent handles so they are 
opposite each other. In this case, changing 
the distance from the node of one handle 
does not change the distance of the other. 

Ellipse Closure Controls

The Ellipse Closure controls.

These buttons allow you to control how an 
open ellipse is closed. Expression’s ellipse 
is a special case object. After creating an 
ellipse you can drag its single point with 
the Select Node tool to open it up, then use 
one of the following buttons to complete 
the shape. For additional information 
regarding the Ellipse Closure Controls, see 
➤“Editing Ellipses” in Chapter 6, “Arrang-
ing and Editing Objects.”

Pie

Allows y
closed b
lines con
of the el

Ellipse w
ord

ou to create an ellipse line segment 
at side. The ellipse is closed by a 
 line segment from beginning point 
g point.

ith a chord line segment.
Angle Locked

Positions the tangent handles so they are 
locked in relation to each other. Moving 
one handle causes the other handle to 
move the same angular distance and direc-
tion.

Unconstrained

Allows tangent handles to move indepen-
dently of each other.

Open Arc

Allows you to create an open ellipse line 
segment.

Ellipse as an arc.

Add Ch

Allows y
with a fl
straight
to endin

Ellipse w
• Overview of Expression 13
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Unconstrained tangent handles.



Anchor Controls

Repeating

s the selected objects within the 
 based on length of path.

Non-repeating

es the repeating function from the 
d objects. 

re Sensitivity Controls 

essure Sensitivity Controls
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The Anchor controls.

These tools are only available if the Anchor 
tool has been used to select anchor points 
in the Stroke Definition window. Use the 
Anchor Control tools to control the behav-
ior of anchored points. 

Within the Stroke Definition window, use 
the Anchor tool to drag a marquee to select 
the points you want to anchor. Then, click 
the Anchor Control that describes the type 
of anchor you wish to apply to the selected 
nodes. For additional information regard-
ing Anchor Controls, see ➤“Using Anchor-

Anchor at Fixed Point

Constrains selected points to a specific 
part of the Skeletal Stroke as it is applied to 
a path.

Free Anchor

Removes anchor constraint from selected 
point.

Repeating Control

Make 

Repeat
stroke

Make 

Remov
selecte

Pressu

The Pr
buttons toggle pressure sensitivity 
ff. These functions are only available 
 pressure sensitive drawing tablet is 
stead of a mouse.

re sensitivity applies only to the 
nd tool.

le Pressure Sensitivity

 a pressure sensitive graphics tablet 
ave just as a mouse device.
ing” in Chapter 5, “Applying Strokes and 
Fills.”

Anchor at Start

Constrains selected points to the start of 
the Skeletal Stroke as it is applied to a path. 

Anchor at End

Constrains selected points to the end of the 
Skeletal Stroke as it is applied to a path.

The Repeating Control tools.

These tools are only available if the Repeat 
tool has been used to select objects to 
repeat in the Stroke Definition window. Use 
the Repeating Control tools to control the 
behavior of repeating objects. 

Within the Stroke Definition window, use 
the Repeat tool to select the objects you 
want to repeat. Then, click the Make 
Repeating button to make the selected 
objects repeating or click the Make Non-
repeating button to remove the repeating 
function from the selected objects. For 
additional information regarding Repeat-
ing Controls, ➤“Repeating Elements of a 
Stroke” in Chapter 5, “Applying Strokes and 

These 
on or o
when a
used in

Pressu
Freeha

Disab

Allows
to beh
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Fills.”



a new path based on the outline of 
ted source paths as if they were 
into one object. Paths inside are 

efore and after.
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Enable Pressure Sensitivity

Allows you to vary the width of a Skeletal 
Stroke based on the amount of pressure 
applied when using a pressure sensitive 
graphics tablet. Strokes appear thin where 
light pressure is applied, and thicker where 
heavy pressure is applied.

Miscellaneous Toolbar
The Miscellaneous Toolbar controls Blend-
ing and Boolean operations (also known as 
pathfinder operations to Adobe Illustrator 
users). 

Choose Window menu> Toolbars: Mis-

Blend Paths

Creates a series of new paths based on two 
selected paths.

Union

Creates 
all selec
merged 
ignored.

Union, b
ack

a new path that contains areas in 
t path that are not overlapped by 
 the back path.

ck, before and after.
cellaneous to toggle the Miscellaneous 
toolbar on or off. For additional informa-
tion regarding Blending Paths ➤“Blending 
Paths” in Chapter 3, “Creating Paths.” For 
more information regarding Boolean Oper-
ations, see ➤“Using Boolean Operations” in 
Chapter 3, “Creating Paths.” The Miscella-
neous toolbar contains the following but-
tons:

The Miscellaneous toolbar. Blend Paths, before and after.

Front-B

Creates 
the fron
areas in

Front-Ba
• Overview of Expression 15
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The Palettes Displaying Palettes
indow menu contains the name of 
alette available in Expression. To 
 palette, choose a palette name from 
ndow menu. A check mark appears 
 open palettes. 
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Back-Front

Creates a new path that contains areas in 
the back path that are not overlapped by 
areas of the front path.

Back-Front, before and after.

Expression uses a variety of palettes to 
control specific functions. Most of these 
functions are not available elsewhere in 
Expression. You will find that certain pal-
ettes are so crucial to your work that you 
will always want them open.

Some palettes include tabs that open addi-
tional layers of the palette. Clicking a tab 
brings specific information forward so you 
can select options relating to the particular 
function listed on the tab.

Close Box

The W
each p
open a
the Wi
next to
marks appear next to open palettes.

 than describe each palette in depth 
e will refer you the chapter that 
s each palette in detail.
Intersection

Creates a new path that contains areas 
where the selected source paths overlap. 
Areas and paths that do not overlap are 
ignored.

Intersection, before and after.
A palette with tabs.

Use the close button in the title bar to hide 
unused palettes. The title bar also contains 
the name of each palette. Drag the title bar 

Tabs

Check 

Rather
here, w
explain
16 Fractal Design Expression User Guide

to move the palette on the screen.



olorize tab to adjust the colors 
 Skeletal Stroke.
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Paint Style Palette
This palette controls how your path is dis-
played including stroke, fill and color. Use 
the Paint Style palette to assign the stroke 
and fill you prefer. 

Your stroke may be none, Basic (a fixed 
width with solid color), Gradient (a fixed 
width with gradient color) or a Skeletal 
Stroke. Use the Stroke tab to select the 
style of stroke you prefer.

No Stroke Basic Gradient Skeletal

Select a fill style.

No Fill Color Gradient Pattern

Use the C
within a
Select a stroke style.

Your fill may be none, a plain color, a gradi-
ent or a pattern. Use the Fill tab to select 
the style of fill you prefer. For more infor-
mation regarding stroke and fill see 
➤Chapter 5, “Applying Strokes and Fills.”

The Colorize tab of the Paint Style palette 
gives you several ways of controlling the 
colors used in your strokes. Changes made 
in this area affect all selected objects and 
any new path you draw while the same 
Skeletal Stroke is selected. For more infor-
mation regarding Colorize, see ➤“Coloriz-
ing Objects” in Chapter 4, “Using Color.”
• Overview of Expression 17
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Color Palette Custom Color Palette 

oke Warehouse palette.

er Palette
is palette to quickly reposition your 
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This palette controls the use of colors. 
When you set the stroke and/or the fill to 
plain color or a gradient, you can then use 
the Color palette to select colors. 

Select a color model, then enter a color 
value (RGB and CMYK) or click on the color 
wheel to see the range of colors available in 
the Value Picker (HSL). For specific infor-
mation regarding color and gradients see 
➤“The Color Palette” in Chapter 4, “Using 
Color.”

Click to 
expand palette

This palette contains a list of custom colors 
which you can apply to any document. For 
more information regarding custom color, 
see ➤“Using Custom Colors” in Chapter 4, 
“Using Color.”

The Str

Pann
Use th
o you can draw in a manner that is 
rtable for you. Click the side arrows 
te the page clockwise or counter-
ise. Click the plus or minus button 
e the page forward or backward.

nner palette, Windows and Macintosh 
s.
The Color palette.

Color Table

Color Selection

Attribute buttons

Current Color

The Custom Color palette.

Stroke Warehouse Palette 
This palette contains a selection of pre-
designed Natural-Media, Graphic Element, 
and Multi-view strokes. Each stroke can be 
thought of as a customized brush. Strokes 
can be applied to any path in Expression. 
For more information about the Stroke 
Warehouse palette see ➤Chapter 5, “Apply-
ing Strokes and Fills.”

page s
comfo
to rota
clockw
to mov

The Pa
version
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 Palette
 palette to add, delete, select, 
ck/unlock or hide/show layers. For 
ormation on Layers, see ➤“Layer-
cts” in Chapter 6, “Arranging and 
bjects.”

rs palette.
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Font Palette
Use this palette to select the font and other 
attributes for Text objects. For more infor-
mation regarding Text, see ➤“Creating 
Text” in Chapter 3, “Creating Paths.”

The Font palette. 

Transformation Palette 
Use this palette to translate (move), rotate, 

The Transformation palette.

Alignment Palette
Use this palette to align, distribute or stack 
objects. For more information on Align-
ment, see ➤“Aligning Objects” in 
Chapter 6, “Arranging and Editing Objects.”

Layers
Use this
name, lo
more inf
ing Obje
Editing O

The Laye
nt Editor Palette
ette can be used to add, delete and 
ients. For more information on 

s, see ➤“Using Gradients” in 
 4, “Using Color.”

dient Editor palette.
shear, mirror or scale objects. Use the 
small arrows to the right or left of the tabs 
to display additional tabs as you need 
them. Click Apply to apply your changes to 
any selected object. Use the Duplicate but-
ton instead of the Apply button to create a 
duplicate of the selected object as you 
transform it, leaving your original object 
untouched. For more information on trans-
formation, see ➤“Arranging Objects” in 
Chapter 6, “Arranging and Editing Objects.” The Alignment palette.

Gradie
This pal
edit grad
gradient
Chapter

The Gra
• Overview of Expression 19
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Getting Acquainted with Workspace Sizing Your Workspace
ou create a new document, you can 
 size of your page, page orientation 
it of measurement to accommodate 
e of the drawing you are going to 
.

ust the size of your workspace:

ose File menu> Document Setup. 
Document Setup dialog appears.
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Expression’s Workspace

This section outlines how to customize the 
workspace to match your own style of 
work. You’ll learn how to use Grids and Rul-
ers and how to set your preferences. 

Creating a New Document
To create a new document choose File 
menu> New or Command/Ctrl+N or click 
the New File button on the Standard tool-
bar.

Use the scroll bars on the right and bottom 
of the document to move the page. The 
workspace is larger than the page that 
prints so be careful to keep your artwork 
inside the page outline if you want it to be 
part of your printed document. 

Use the remainder of the space as a desk-
top or drawing board. For example, you 
might work off the page when creating new 
strokes. Then work on the page when 
applying the stroke to a path as part of 
your image.

Scroll barDocument window

After y
set the
and un
the siz
create

To adj

1Cho
The 
ws Document Setup dialog.
The Expression workspace.

Zoom Ratio box

Windo
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ion also provides a snap to node 
nt by using View menu> Snap to 

hen you click or drag near an 
 node (point), the cursor snaps to 
.

atus Bar
wer left corner of the Expression 

 is the Status Bar. The Status Bar 
 information regarding the Snap To 
nap to Node functions and the size 

rid as set in the Preferences dialog 
.

Window menu> Toolbars: Sta-
ggle on/off the Status Bar at the 

of the main Expression window.
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Macintosh Document Setup dialog.

at the upper left corner. You can toggle the 
rulers by choosing View menu> Show 
Rulers.

You can also scroll the view by placing the 
cursor on the vertical or horizontal ruler. 
When the cursor changes to a hand, drag to 
scroll the view.

Click to change the ruler measurements.

Express
constrai
Nodes. W
existing
the node

The St
At the lo
window
displays
Grid or S
of the G
View tab

Choose 
tus to to
bottom 
ression status bar.

le Windows
 have multiple document windows 
ile you are working in Expression. 
dow menu provides a list of cur-
pen Expression documents. If you 
ltiple documents open, choose the 
 a document from the Window 
 bring the document to the fore-
and make it the active document.

dow menu also allows you to con-
 multiple windows are displayed. 
2Click on the pop-up next to the Width 
and Height controls to display and select 
a unit of measurement.

3Select or enter the size for your page and 
the orientation of the page.

4Click OK. The size of the workspace in 
the current document changes to reflect 
your selections.

Rulers
The document window includes rulers on 
the top and left side. As you move the cur-
sor around the window a line on each ruler 
indicates the cursor position. You can 
change the rulers from the default inches 

Grid and Node Constraints
Expression provides you with a grid to aid 
in arranging objects. To toggle the grid on 
or off choose View menu> Show Grid. 

For information on setting the size of the 
grid see ➤“Setting Preferences,” later in 
this chapter.

When View menu> Snap to Grid is 
active, all drawing and editing tools (except 
the Freehand tool) are influenced by the 
grid. When you click or drag near a grid line 
or intersection, the cursor snaps to the 
grid. The snap is stronger at grid intersec-
tions than along grid lines.

The Exp

Multip
You may
open wh
The Win
rently o
have mu
name of
menu to
ground 

The Win
trol how
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nctions are only available on the 
s platform.
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to pica or points by clicking the small box 
These fu
Window



Choose Window menu> Cascade to Navigating Your Center View Centers the printable page in 
cument window.

n also zoom in and out with the 
ier tool.

m in:

ose the Magnifier tool from the Tools 
bar. The cursor changes to a 
nifier. The plus sign (+) on the 
nifier indicates that you are 
easing magnification—zooming in.
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arrange open windows starting in the 
upper left corner with each additional win-
dow positioned slightly to the right and 
lower so you can see the title bar of each 
window.

Choose Window menu> Tile to arrange 
open windows as tiles.

Choose Window menu> Arrange Icons 
to arrange open minimized windows along 
the bottom of the screen.

Document

You can navigate through a document or 
image by changing the level of magnifica-
tion (zooming in or out), scrolling to a dif-
ferent part of the image, or rotating the 
page. By navigation, we mean moving 
around a document, changing views, or 
moving the page.

Zooming In and Out
By default Expression opens a document at 
100% view, but you can change the view to 
suit your needs. The Zoom Ratio box in the 

the do

You ca
Magnif

To zoo

1Cho
tool
mag
mag
incr
lower left corner of the document displays 
the current zoom ratio. Click-hold to 
choose another zoom ratio.

The View menu also offers you a variety of 
ways of changing the zoom ratio: 

Zoom in Enlarges the document window 
to the next largest zoom ratio.

Zoom out Reduces the document window 
to the next smallest zoom ratio.

Zoom on Selection Magnifies and centers 
the current selection to fill the document 
window.

View All Reduces the page to view all 
objects in the document window.
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Actual Size Enlarges or reduces the docu-
ment window to 100% size.



the Grabber Tool
bber tool gives you a quick way to 
 image.

ll by using the Grabber tool:

e the Grabber tool from the Tools 
r. The cursor changes to the hand 

r.

n the document window to pan or 
 your image.

 Grabber tool while another tool is 
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To zoom out:

1Choose the Magnifier tool from the Tools 
toolbar. The cursor changes to a 
magnifier.

2Hold down the Option/Alt key. The plus 
sign (+) on the Magnifier tool turns to a 
minus sign (-).

3While holding down the Option/Alt key, 
click the image. The magnification ratio 
appears in the Status Bar at the bottom 
of the window. 

Using 
The Gra
scroll an

To scro

1Choos
toolba
curso

2Drag i
move

To use the

hold down the Spacebar.
Click with the Magnifier to view an image 
close-up.

2Click the image. With each click, the 
image is magnified. The ratio of the 
magnification appears in the Status Bar 
at the bottom of the window.

To magnify a specific area:

1Choose the Magnifier tool from the 
Tools toolbar. Move the cursor to the 
drawing window and drag a rectangle 
around the area you want to magnify. 

The area inside the rectangle is magni-
fied to the closest magnification level 
that fills the screen.

selected, 
• Overview of Expression 23
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Changing Your View Preview Shows the path plus the stroke 

ew displays an additional window for 
g on the same document.
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In addition to controlling the Grid, Rulers, 
Snap To and Zoom Ratio the View menu 
controls the display quality for your paths.

Path Shows the path only.

and/or fill as applied to the path.

The Preview view displays the document as 
it would be printed.

Creating a New View
New Vi
workin
The Path view displays only the paths.

Wireframe Shows the path plus an outline 
of any stroke applied to the path.

The Wireframe view displays the path plus 

The View menu can also be used to open 
up an additional window showing a differ-
ent view of the document you are currently 
editing. This can be very useful when work-
ing on a complex image, as you can set 
each view window to its own zoom ratio. 

To open an additional view:

1Choose View menu> New View. An 
additional view window displays the 
name of the current document in the title 
bar, followed by a number defining 
which view it represents. Actions 
performed in one view window are 
immediately shown in any additional 
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opper: resets primaries This 
ce determines what happens when 

 the Color Dropper tool to drop 
to an object whose colors have 
been adjusted using the Fore-
Background color swatches or the 
 controls.

is preference is enabled (the 
, using the color dropper automati-
ets the Colorize or Foreground/
und information. This ensures that 
r you're dropping is the color you 
 see on the object.

e preference is disabled, the color 
p may not be the color you see on 
ct. For example, suppose you have 
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Setting Preferences

Expression’s preferences enable you to 
customize Expression to the way you like 
to work. There are four tabs to take you to 
the specific areas you can customize.

To set Expression Preferences:

1Choose File menu> Preferences. The 
Preferences dialog appears.

Options Tab
This tab controls settings for various 
options including Tools, Objects, Arrange-
ment and Miscellaneous.

Tools

Drawing tools: append to path When this 
option is enabled (the default), all drawing 
tools (except the Freehand tool) can be 
used to append points to an existing path. 
Just position the cursor over the endpoint 
of an existing path before starting to draw. 
A tilde (~) is added to the cursor, indicating 
that it is ready to append points to the 
existing path.

When this option is disabled, none of the 

Color Dr
preferen
you use
color on
already 
ground/
Colorize

When th
default)
cally res
Backgro
the colo
actually

When th
you dro
the obje
ale stroke with the foreground 
t to red, so your entire stroke 
 in reds of varying shades. Then 
 you use the color dropper to drop 

to an area of your stroke which is 
y medium red. The spot where you 
 color will not appear black, but 

will appear full red. This is because 
foreground color transforms all 
gions within the stroke into red. 

e information regarding colors, see 
er 4, “Using Color.”

rea) select Determines whether 
on a fill area selects an object or 
Preferences dialog.

2Click the tab for the area you would like 
to edit, then make your changes.

3Click OK.

drawing tools append points to existing 
paths. Clicking on the endpoint of an exist-
ing path creates a new path starting at that 
point. By holding down the Shift key, you 
can force any drawing tool to append 
points to an existing path.

Freehand Tool: Tightness of fit Controls 
the precision with which the path follows 
the movement of the mouse or stylus pen 
when using the Freehand tool. If the setting 
is too high every minor waver is captured, 
possibly resulting in a line that is quite 
irregular. If the setting is too low the result-
ing path may be less precise than you 
intended. 

In most cases the default setting should 

a graysc
color se
appears
suppose
black in
currentl
drop the
instead 
the red 
black re

For mor
➤Chapt

Objects

Quick (a
clicking 
• Overview of Expression 25

 you need to click on the path itself 
 to select an object.
Chapter 1

give you acceptable results. whether
in order



Transform patterns Controls the way a information regarding Boolean operations, Nudge increment Sets the increment 
 when you use the keyboard arrow 
 move an object.

Gap Size Sets the size of the gap (in 
) between objects when using the 
unction.

llaneous

with Skeletal strokes When this 
 is enabled, choosing a Skeletal 
 automatically removes any fill which 
en applied. If you want to fill an 
 which has a Skeletal Stroke applied, 
n choose the stroke first, then apply 

this option is disabled, the Skeletal 
 uses whatever fill is active in the 
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pattern is handled when an object contain-
ing a pattern is transformed (rotated, 
skewed, scaled). When this option is 
enabled, the pattern is applied to the 
object before the transformation and there-
fore transforms with the object. When this 
option is disabled the object is transformed 
and then the pattern is reapplied and not 
affected by the transformation. 

see ➤“Using Boolean Operations” in 
Chapter 3, “Creating Paths.”

Show resize handles Toggles on/off the 
on-screen resize handles that appear 
around selected objects. When on 
(default), resize handles are displayed at 
the corners of the bounding box and the 
transform handles appear on the top, bot-
tom and sides. 

applied
keys to

Stack: 
points
Stack f

Misce

No fill 
option
Stroke
has be
object
you ca
a fill. 

When 
Stroke
tyle palette. In most cases you prob-
 not want a fill with a Skeletal 

.

evels Sets number of Undo levels. 
 levels of Undo use up more RAM. 

 Match Tab
e Color Match tab to calibrate your 
r for the best match possible when 
g to a color printer. For more infor-
 on Color Match, see ➤“Setting 
alibration” in Chapter 4, “Using 
Original object with pattern before transform.

Object after skew with Transform patterns 
ON, then OFF.

Path operations: keep originals Toggles 

Object selected with resize handles.

When off, the path itself appears in color 
but no handles appear. 

Object selected without resize handles.

Arrangement

Angular constraint steps Sets the angle of 
constraint when holding down the Shift key 
while moving or rotating an object.

Paint S
ably do
Stroke

Undo l
Higher

Color
Use th
monito
printin
mation
Color C
Color.”
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on/off to keep or discard original objects 
after performing a Boolean operation. For 



r

rder
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Preferences dialog, Color Match tab.

View and Palettes Tab
This tab provides you options for the view 
displayed in your workspace and options 
for some of the palettes. These settings are 
applied when creating a new document.

Snap to Nodes When this function is 
enabled Expression automatically moves to 
the closest node on a selected path when 
you perform any action that applies to a 
node.

Show Grid Toggles on/off a non-printing 
grid that is useful for precise placement of 
points and objects. This option determines 
whether or not the Show Grid function is 
enabled when a new document is created.

Grid Spacing Sets the spacing/size for the 
grid in the workspace.

Color Palette

Draggable Color Wheel When this option 
is enabled, drag to rotate the Color Wheel. 

No borde

Black bo
rder

 Quality

Quality Determines the view 
ion defaults to when a new docu-
reated. You can choose from Path, 
e or Preview views. For additional 

tion regarding display quality, see 
ging Your View,” earlier in this 
.

mit (pts) Sets the minimum size 
t to be displayed on screen. Fonts 
Preferences dialog, View and palettes tab.

Grid

Snap to Grid  This option determines 
whether or not the Snap to Grid function is 
enabled when a new document is created.

The color touching the point of the Value 
Picker triangle or diamond is the active 
color. When this option is disabled the 
Color Wheel is stationary and you click the 
desired color to make it active. The Value 
Picker reflects the current color selection.

Color Palette Border Sets the display for 
the Color palette with no border between 
colors in the Color Table, with black border 
between colors or with white border 
between colors. To display the Color Table 
in the Color palette you must expand the 
Color palette. For more information on 
expanding the color palette, see ➤“Color 
Palette,” earlier in this chapter.

White bo

Display

Display 
Express
ment is c
Wirefram
informa
➤“Chan
chapter

Greek li
for a fon
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an actual text.
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Stroke Warehouse Plug-Ins Opening and Saving 
ments

sion can open and use most vector-
artwork. It can also save in most 
r formats, both vector, such as 
 Illustrator or CorelDRAW! and bit-
ch as Adobe Photoshop, TIFF (TIF) 
P.

r or Bitmap
ter graphics are either vector or bit-
 vector graphic is defined by placing 
(or vector points), then using a 
matical formula to describe the line 
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Animated stroke thumbnails Toggles on/
off the animation of stroke thumbnails in 
the Stroke Warehouse list. When this 
option is enabled, the Stroke Warehouse 
palette displays the currently selected 
stroke as an animation demonstrating how 
the stroke may appear when applied to a 
path. This is particularly useful for Multi-
view strokes. For more information regard-
ing Multi-view strokes, see ➤“Creating 
Multi-view Strokes” in Chapter 5, “Applying 
Strokes and Fills.”

Raster/Scratch Tab
This tab provides you the option for select-
ing a scratch disk and plug-in directory.

Set Directory The only plug-ins Expres-
sion uses are file format input/output fil-
ters. By default, Expression looks for these 
plug-ins in its own plug-ins directory. The 
only time it is necessary to change this 
directory is if you have other PhotoShop-
compatible file format filters in another 
directory and want to use those instead of 
the filters supplied with Expression.

Docu

Expres
based 
popula
Adobe
map su
and BM

Vecto
Compu
map. A
nodes 
mathe
nnects the points. Vector artwork is 
ferred to as outline. 

vantage of vector art is that it is reso-
ndependent and can easily be 
 at any time, still printing out beauti-
 a Postscript printer. Drawing pack-
ch as Adobe Illustrator, 

media FreeHand and CorelDRAW! are 
les of vector-based graphics pro-
 

Preferences dialog, Raster/Scratch tab.

Scratch Disk

Use Select a disk that has plenty of free 
space. The scratch disk is used only when 
rasterizing. It should only be necessary 

that co
also re

The ad
lution i
resized
fully on
ages su
Macro
examp
grams.
28 Fractal Design Expression User Guide

when you do not have enough RAM to keep 
the entire rasterized image in memory.



g Bitmap Resolution
u save a file as a bitmap you can 
e size and resolution of the file. 
w strokes saved as movies also 
 same options. 

on, in general, refers to the number 
er inch (dpi) that make up an 
hen you select a resolution, there 

e kinds of resolution to consider:

onitor’s resolution, measured in 
. Expression is preset to 72 pixels 
ch. The resolution of your monitor 
e different.

ocument’s resolution. You can 
 the resolution when an image is 
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Vector images at different resolutions.

Bitmaps have a real advantage when creat-
ing a textured look or for photographic 
quality images. Bitmaps can show subtle 
color changes and blends such as shadows. 
Graphics created by scanning, or by paint 
programs such as Fractal Design Painter 
and Adobe Photoshop, are examples of bit-
map artwork.

You can export artwork from Expression in 
either vector or bitmap format. If you want 
to place or edit your image in another 
application, while still retaining resolution 
independence, you should choose a vector 
format. If you want to refine it or generate 
color separations in a painting or image 
editing application, you should choose a 
bitmap format.

Settin
When yo
select th
Multi-vie
have the

Resoluti
of dots p
image. W
are thre

• The m
pixels
per in
may b

• The d
assign
ed or an image is rasterized (saved 
itmap) in Expression.

utput device’s resolution, 
red in dpi. Output device 
tions vary depending on the 
r.

ult resolution setting is screen res-
r 72 dpi. The image on-screen at 

the size it will be when it’s output. 
 printers, 72 dpi bitmap renders a 

mage, so you may want to choose a 
esolution value.

e using a personal laser printer, set 
map Width and Height in inches, 
ters, points or picas. Set resolution 
pi your printer supports. Your file 
Bitmap images at different resolutions.

Bitmap artwork is defined pixel by pixel or 

If your image contains transparent objects, 
you will need to save it in bitmap format 
(rasterized), since other vector-based 
applications and printers do not support 
transparency.

Always save a copy of your work in the Expression 
format (*.xpr). This will save your art in a vector 
format.

scann
as a b

• The o
measu
resolu
printe

The defa
olution o
100% is 
On most
coarse i
higher r

If you ar
your bit
centime
to the d
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dot by dot. Bitmaps have no outline, there-
fore, resizing such an image may result in 
stairstepped edges. 



will be output correctly at the best resolu- Opening Existing Documents

en dialog.
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tion for your laser printer and at the proper 
size.

If you are using a commercial printer or a 
more sophisticated output device, the 
dimensions should always be set to the 
actual size it will appear in the printed 
piece. It’s a good idea to check with your 
service bureau if you have questions about 
output device resolution.

Artwork created in other software applica-
tions can be brought into Expression for 
continued editing. You might use imported 
artwork as the basis for a path, a Skeletal 
Stroke or a Pattern. You can use Expression 
to work with images already existing in the 
following formats:

Vector

• Adobe Illustrator 5.5 and earlier (*.ai)

• CorelDRAW! 3, 4, 5 and 6 (*.cdr)

• Computer Graphics Metafile (Windows) 
(*.cgm)

• Vector PICT (Mac) The Op
ct the format or file type so you can 
 the available files or select All Files.

ct the file you want to open then 
 Open. Expression opens a new 
ment with the selected artwork.

ng Clipboard Images

n also use the Clipboard to bring art-
rom another application into Expres-
xpression supports the following 
s through the Clipboard:

or PICT (Macintosh)

 (Windows)

tal Design Expression
• WMF (Windows)

• Fractal Design Expression (*.xpr)

To open or import an existing image:

1Choose File menu> Open. The 
standard Open dialog appears.

2Sele
limit

3Sele
click
docu

Openi

You ca
work f
sion. E
format

• Vect

• WMF

• Frac
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• Text



file has been saved previously, 
ing File menu> Save replaces 
st saved version with the current 
n.

 and rename a document or to 
d select a different format:

e File menu> Save As.

 the file format you prefer.

 a name to your file and select a 
ory in which to save it.

Save.
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To open or import an existing image 
through the Clipboard:

1Copy the artwork from its current file by 
selecting it and using the Edit menu> 
Copy or Command/Ctrl+C. This places a 
copy of the image into the Clipboard.

2Paste the Clipboard image into the 
Expression document by using the Edit 
menu> Paste function or Command/
Ctrl+V.

Saving Documents
You can save your Expression artwork in 
several different ways:

It is a good idea to always save your document in 
the Expression format (*.xpr). If you only save your 
art in a bitmap format, it will be harder for you to 
make changes to individual paths.

Saving as Vector

Your Expression artwork can be saved in 
the following vector-based formats:

• Fractal Design Expression

• Adobe Illustrator (*.ai)

• Computer Graphics Metafile (Windows) 

If the 
choos
the la
versio

To save
save an

1Choos

2Select

3Assign
direct

4Click 
as Bitmap

ion allows you to save your artwork 
llowing bitmap formats:

 Photoshop 2.5

IF

 (Windows)

Windows)

Paint (Windows)

p PICT (Macintosh)

(without LZW compression)
• Expression format for use in Expression in 
a future session.

• Vector artwork for placement into a 
vector-based application such as Adobe 
Illustrator or CorelDRAW!.

• Bitmap artwork for placement into a 
bitmap application such as Fractal Design 
Painter or Adobe Photoshop.

• Movie format (Multi-view strokes only) 
for viewing an animation.

(*.cgm)

• CorelDRAW! Exchange (*.cmx)

• Vector-based PICT (Macintosh)

• WMF (Windows)

• EPS (This type of file stores only printer 
information. Expression EPS files cannot 
be edited.)

To save as vector:

1Choose File menu> Save. 

2If this is the first time you are saving the 
document you are prompted to select a 

Saving 

Express
in the fo

• Adobe

• TIFF/T

• Targa

• PCX (

• Photo

• Bitma

• BMP

• JPEG 
• Overview of Expression 31
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file format, name and location.



Anti-Aliasing yellow beachball on a blue background, 8Click Save. Converting vector artwork 
 raster artwork will take some time. 
ession displays a progression bar to 
ou know how much of the 
ersion has been completed.

-resolution bitmap images require 
 amounts of disk space. If you have 

ble saving a large bitmap, make sure 
have sufficient free space on your 
 disk.

g Multi-view Strokes As 
es
i-view stroke can be rasterized, then 
as an animation or as a series of bit-
d still images. The animation can 
e used in another application as a 
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Anti-aliasing is a process used to make 
color images appear smoother when the 
image includes curved and diagonal areas 
with high contrast. Without anti-aliasing 
the curves and diagonal lines may appear 
to be stairstepped. 

individual pixels along the edge of the ball 
are changed to shades of orange and green, 
fooling the human eye into “seeing” a 
smoother curve. 

Unless you are working on a project which 
specifically requires that images not be 
anti-aliased, such as multimedia cast mem-
bers, there is no reason to disable the Anti-
aliasing option. Anti-aliasing does not sig-
nificantly increase the time required to ras-
terize an image.

To save as bitmap:

1Choose File menu> Save Bitmap.

into
Expr
let y
conv

High
large
trou
you 
hard

Savin
Movi
A Mult
saved 
mappe
then b
 For more information on Multi-view 
s, see ➤Chapter 5, “Applying Strokes 
ls.”

view Strokes

rasterizing Multi-view strokes the 
 to produce a sequence of bitmaps to 
p an animation. To achieve this, 
arameters are required. Based on 

mber of frames per second (fps) and 
ration of the movie, Expression can 
ze the appropriate number of bit-

ust be in the Stroke Definition win-
d have open a Skeletal Stroke with 

 more views.
With and without anti-aliasing

With the Anti-Alias option enabled, Expres-
sion modifies areas with stairstepping, 

2Select or deselect Keep Proportions.

3Set Width and Height in inches, 
centimeters or points. 

4Set the Resolution of the bitmap. For 
more information on setting resolution, 
see ➤“Setting Bitmap Resolution,” earlier 
in this chapter.

5Select or deselect Anti-Alias as needed. 
For information on anti-aliasing, see the 
introduction to this section.

6Click OK.

7Select a directory in which to save the 

movie.
stroke
and Fil

Multi-

When 
goal is
make u
more p
the nu
the du
rasteri
maps. 

You m
dow an
two or
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changing some pixels to intermediate col-
ors. For example, if your image is a red and 

bitmap file. Set the file format and name 
the bitmap file.



the Options button to set 
ression settings, if desired.

Save. The status area indicates 
ess as the movie is rasterized.

 player is required to view your 
acintosh documents are saved as 

me movies. Windows documents 
d as AVI movies.

ng Operations
 Undo allows you to undo and redo 
within Expression. This gives you 

om to experiment freely without 
aking mistakes. 

ber of undos is set in the Prefer-
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Movie files can take up several megabytes 
of hard drive space, since they are essen-
tially sequences of many images (poten-
tially hundreds). The following factors 
contribute to the size of a movie: frame size 
(height x width), frame rate (frames per 
second), duration (in seconds), and com-
pression settings.

Not only do large movies take up a lot of 
space on your hard disk; they also tend to 
play very sluggishly on all but the fastest 
computers. You should experiment with 
the variables listed above to determine 
which settings produce movies that play 
smoothly on your computer and take up 
reasonable amounts of storage space. 
Below are some general guidelines which 

For web animation: Lower resolution, a 
small, fixed number of frames, save as 
sequenced JPEG images with compression. 
If you require GIF images, you will need to 
convert to GIF in another application.

To save an animation:

1Open a Multi-view stroke by double-
clicking it in the Stroke Warehouse 
palette. The Stroke Definition window 
appears.

2Choose File menu> Save Stroke as 
Movie.

3Select or deselect Keep Proportions.

ºClick 
comp

¡Click 
progr

A movie
movie. M
QuickTi
are save

Undoi
Multiple
actions 
the freed
fear of m

The num

und under File menu> Prefer-
Options. The default setting is ten 

or more information on setting 
ferences, see ➤“Options Tab” ear-
is chapter.

 an action:

e Edit menu> Undo or 
and/Ctrl+Z.
may help you. For more detailed informa-
tion, consult the documentation that came 
with your multimedia authoring or video 
production software or hardware.

For video to be exported to tape and 
played back on television: 640 x 480 pixels, 
30 fps, save as sequenced images, Quick-
Time, or AVI with no compression (most 
video production software and hardware 
solutions provide their own compression).

For multimedia productions to be played 
on a typical desktop computer: 320x240 
pixels, 15 fps, save as QuickTime or AVI 
with moderate compression.

4Set Width and Height in inches, 
centimeters or points. 

5Set the Resolution of the bitmap. For 
information on setting resolution, see the 
guidelines in the introduction to this 
section.

6Select or deselect Anti-Alias. For 
information on anti-aliasing, see ➤“Anti-
Aliasing” earlier in this chapter.

7Set the Movie Length and Frames per 
Second.

8Click OK.

ences fo
ences> 

levels. F
your pre
lier in th

To Undo

1Choos
Comm
• Overview of Expression 33
Chapter 1

9Select file destination and name the file.



Closing Documents and 
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To Redo an action:

1Choose Edit menu> Redo or 
Command/Ctrl+Y.

It is a good habit to save your file fre-
quently so you can choose File menu> 
Revert to Saved if you don’t like the 
changes.

Reverting to the Last Saved 
Version
Occasionally you will find it useful to revert 
to the last saved version of your file. This is 
especially useful if you have experimented 
with changes but decide you don’t want to 

Quitting

You can quit and close Expression docu-
ments the way you do in other programs.

To end a work session:

1Close a document by choosing File 
menu> Close or Command/Ctrl+W or 
clicking the close box in the upper left 
corner of the document (Macintosh) or 
the upper right corner of the document 
(Windows). 
keep the changes after all. You can also use 
the Undo/Redo function but there are some 
functions which can not be undone. If you 
save your file just before such an action 
you can revert to the last version saved if 
you decide you don’t like the changes.

To revert to last saved version:

1Choose File menu> Revert to Saved. 
Expression asks you to confirm that you 
want to revert to the last saved file.

2Click Revert and Expression replaces the 
document with the last version saved on 
disk.

If you have any unsaved changes, a dia-
log asks if you want to save changes. 
Click Yes to save your changes or No to 
discard them.

2Exit Expression by choosing File 
menu> Quit (Macintosh) or File 
menu> Exit (Windows) or Command/
Ctrl+Q.
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Tutorial

 

The best way to learn about 
Expression is to do this tutorial. Like 
all artist’s tools, Expression invites 
experimentation, so feel free to play 

 

around as you learn.
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About This Tutorial

    

Overview of the Sample 

    

e Expression Quick Reference Card handy as 
hrough this Tutorial. It helps you quickly 

 tools and buttons that are called for as you 

 

 acquainted with Expression.

 

utorial Files

 

 you start the Tutorial, check to see 
e Tutorial files are on your hard 
If you did a standard install, the files 
 there unless they were deleted. You 
ays do a custom install from your 

sion CD if you need to add the Tuto-
s to your hard drive.
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We designed this tutorial to introduce you 
to most of the techniques used when creat-
ing artwork with Expression. We encourage 
you to refer to other chapters in the 
Expression User Guide for more in-depth 
information about concepts introduced in 
this exercise. The Expression Creative 
Techniques guide offers other exciting 
techniques for you to investigate. Have fun 
expressing yourself!

Project

This sample project guides you through 
creating a poster, while developing many of 
the important concepts of the application. 
At any point, if you want more information 
on a subject, look at the related section of 
the manual before continuing with the 
project.

Have th
you go t
identify
become

The T
Before
that th
drive. 
will be
can alw
Expres
rial file
three lessons are planned so they 
 take 20-30 minutes each to com-
f you lose your way or want to start 
middle because you have been inter-
, we have included copies of the 
al file as it should look at the begin-
 each lesson. 

ng up Your Workspace
 Expression and take a look around 

pression workspace. You see tool-
ong the top and left side of the 
 as well as several palettes on the 
or this exercise you need the follow-
ettes and toolbars:
The finished image.

These 
should
plete. I
in the 
rupted
Tutori
ning of

Setti
Launch
the Ex
bars al
screen
right. F
ing pal
t Style palette

ke Warehouse palette
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• Pain

• Stro



                             

dow menu.
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• Color palette

• Layers palette

• Standard toolbar

• Actions toolbar

• Tools toolbar

• Composition toolbar 

To control toolbars:

If any of these toolbars are missing, or if 
you wish to close some you do not need, 
you may toggle them on/off by choosing 
Window> Toolbars then select or dese-
lect those you want.

The Win
it!
ion is going to become an impor-
t of your graphics toolkit. The time 
nd now, learning to use Expression 
to pay off as you learn to freely 
 yourself! As you create this sample 
 your own unique style comes 
 in your first Expression image.

xperiment, remember you can 
Edit menu> Undo or Command/
 undo most actions in Expression.
First, set up your workspace to be more 
efficient.

To control palettes:

If any palettes are missing you can open 
them by choosing the Window menu. Then 
highlight the name of the palette you need. 
Palettes you don’t need can be closed by 
clicking the close box in the upper left cor-
ner of the palette title bar (Macintosh) or 
the upper right corner of the palette title 
bar (Windows).

The Toolbars dialog. Enjoy 
Express
tant par
you spe
is going 
express
project,
through

As you e
choose 
Ctrl+Z to
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Lesson 1: The Dragonfly

                                           

To use any of the selection tools, choose 
l then click an object or drag a mar-

o select multiple objects. To add 
nal objects to the selection, hold 
he 

 

Shift

 

 key and click. 

 

mposition 

 

toolbar allows you to 
or deselect all objects with a single 
ou can also use it to delete a selec-
d change the order of objects in a 
lar layer. 

        

 All Deselect All

Delete
Selection
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In this lesson you will learn about:

• Opening a document

• Selecting objects

• Applying a Skeletal Stroke

• Editing strokes

• Adding color

• Saving a file

Expression can open most vector graphics 
files. This lesson starts with a file that was 
created in Adobe Illustrator™. The dragonfly imported from Adobe 

the too
quee t
additio
down t

The Co
select 
click. Y
tion an
particu

Select
ct all:

ose the Select All button from the 
position toolbar. The selected paths 
ow displayed in color with 
idual nodes (or vector points) 
le. The selection is enclosed in a 

mposition toolbar.
To open the Adobe Illustrator document:

1Choose File menu> Open.

2Select the file tutorial.ai from the 
Tutorial directory. If you do not see the 
file, make sure that the Illustrator format 
or All Files is chosen from the File Type 
menu in the Open dialog.

3Click OK.

This file includes an outline of a dragon-
fly. The first thing to do is enhance the 
dragonfly by applying a Skeletal Stroke to 

Selecting Objects
Expression provides several selection tools 
plus the Composition toolbar for selecting 
objects in your document.

The Selection tools include:

Object Selection

Selects objects or groups of objects. 

Group Selection

Selects individual object within a 
group. 

Node Selection

Illustrator.

To sele

1Cho
Com
are n
indiv
visib

The Co
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it. Before you can apply a stroke, you 
must select the paths or objects you 
want to edit. 

Selects points of a path.



        

e top of the Stroke Warehouse pal-
elect the main stroke directory or 
 up through nested folders.

u select a new Skeletal Stroke, sev-
gs happen: the stroke is applied to 

ction and the Paint Style palette 
 to display the currently active 

 

y a stroke:

  

e-click the 

 

Tutorial

 

 folder in the 

 

 Warehouse

 

 palette to display the 
s you need for this exercise.

  

any stroke in the list. We chose the 
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bounding box and the corners of the 
bounding box, the Resize Handles, are 
represented by triangles. 

Dragonfly with all paths selected.

Applying a Skeletal Stroke
Now that you have the dragonfly paths 
selected, you can apply a Skeletal Stroke. 
Expression includes a variety of Skeletal 
Strokes stored in the Stroke Warehouse 
palette.

Scroll bar

Directory list

list at th
ette to s
navigate

When yo
eral thin
the sele
changes
stroke. 

To appl

1Doubl
Stroke
stroke

2Click 

s

oal stroke.

Apply.  
Use the scroll bar to view additional 
strokes or folders of strokes. Double-click a 

The Stroke Warehouse palette.

Skeletal Strokes
Charc

3Click 
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ke Warehouse with the Tutorial 
en, Charcoal stroke selected.
folder to open it and view the strokes in 
that folder. Use the directory drop down 

The Stro
folder op



            

manual, we always tell you to click Apply. 

                         

 

 

Apply

 

.

        

the body path and apply the Circle 

Shear-
Width 
Handle
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The Paint Style palette showing the Charcoal 
stroke and the Auto option enabled.

Just ignore that direction if you choose to 
work with the Auto option active.

Take some time to experiment with differ-
ent Skeletal Strokes.

After you have tried a variety of strokes 
you are ready for the next step. Don’t 
worry about which strokes you have cur-
rently applied. We will instruct you on how 
to enhance each part of your dragonfly to 
create the Tutorial scene while learning 
various techniques of Expression.

To apply the Circle stoke to the dragonfly 
body:

4Click

Select 
stroke.
g the Stroke Instance
roke applied to the dragonfly body is 
 width we want.

nge the width and shear of the 
:

ce the Shear/Width handle at the 
r end of the path. Use the Shear/

th handle to control the width of the 
ke and to shear or slant the circles.
The selected stroke is animated to give you an idea 
of how the stroke appears when applied to paths of 
different lengths. This is especially useful for Multi-
view strokes, covered near the end of this tutorial. If 
you want, you can use the Preferences to turn off 
this animation in the Stroke Warehouse palette.

; Note: Both the Paint Style palette and 
the Stroke Warehouse palette include an 
auto apply function. When Auto is enabled 
all changes to the palettes automatically 
affect the selected objects. By default this 
is active. However, for the purpose of this 

1Click an empty space to deselect 
everything or click the Deselect All 
button from the Composition toolbar. 

2Using the Object Selection tool from the 
Tools toolbar, click to select the 
dragonfly body.

3Select the stroke named Circle from the 
Tutorial folder in the Stroke Warehouse 
palette. The Circle stroke is constructed 
from overlapping circles with some 
transparency.

Editin
The st
not the

To cha
stroke

1Noti
lowe
Wid
stro
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g Color

 

u begin to enhance the dragonfly 

ression’s Color palette to add color 
rtwork. The Color palette includes 
r Wheel, for selecting a color range 
Value Picker, for selecting a partic-
r within the selected range. A key 
per right corner of the palette 

nd closes the Color Table display. 
, leave the Color Table display 

 step to coloring your dragonfly 
 to color them yellow. 
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2Pull the handle straight out or in 
(perpendicular to the path) to control 

Pull the handle straight in or out to change 
the width of the stroke.

To control width and shear using the 
Paint Style palette sliders:

1Using the Object Selection tool, select 
the head.

2Apply the Circle Skeletal Stroke to the 
head also. You need to enlarge the head.

3This time, use the Width setting in the 
Paint Style palette to change the size of 
the head. Type in a higher number or 
drag the up arrow by the Width box until 
the head is the size you want. 

4You can also use the Shear slider in the 

Addin
Next, yo
wings. 

Use Exp
to your a
the Colo
and the 
ular colo
at the up
opens a
For now
closed.

The first
wings is
r palette.

Color Wheel

Value 
Picker
the width of the stroke. Drag the Shear/
Width handle for the body to make it a 
pleasing width as shown above. 

3Pull the handle at an angle to shear or 
slant the stroke, making the circles 
appear slightly slanted. 

4Click in an empty area of the document 
or click the Deselect All button.

Paint Style palette to shear or skew the 
head. 

Paint Style palette, Width entry box and 

Shear slider

Width entry 
box

The Colo
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4

 

Click 

 

Apply

 

 in the Paint Style palette to 

    

4Edit the color to a shade of purple.
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To select a color:

1Using the Object Selection tool from the 
Tools toolbar, drag a marquee to select 
the four paths that make up the wings.

apply that color to your selection.

Changing the Stroke and Color
Use the skills you learned above to change 
the stroke on the topmost wing path as 
follows:

To change the stroke and color on the 
top wing:

1Click an empty space to deselect 
everything or click the Deselect All 
button from the Composition toolbar. 

2Click to select the topmost wing path.
e Paint Style palette, set the stroke 
h to 20 pts.

 Apply.

g a File
 moving on, you need to save your 
the hard drive. Frequently saving 

age as you work is a good habit to 
p.

e:

he Air Brush stroke and change the 
2Click the preferred color, yellow, on the 
Color Wheel from the Color Palette. The 
Value Picker changes to display the 
range of yellows available. 

3Drag in the Value Picker. As you move 
the cursor, the color swatch at the 
bottom of the Color palette changes to 
display the current selection. When you 

Drag a marquee to select all four pieces of 
the wings.

Select the wing path.

5In th
widt

6Click

Savin
Before
file to 
your im
develo

To sav

Apply t
color.
ose File menu> Save As.
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see the color you prefer, release the 
mouse button. 3Apply the stroke named Air Brush. 

1Cho



g Attributes for Your Path
 in the Paint Style palette determine 
butes for the next path you draw. 
ou draw a path, be sure the Paint 
lette is set to the stroke and fill you 
use. 

troke and fill attributes:

the Deselect All button from the 
osition toolbar. 

the Stroke tab in the Paint Style 
e.

the None icon to set the stroke to 
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2Choose File type: Expression 

3Name the file dfly.

Saving the file.

Lesson 2: Adding More 
Detail to the Dragonfly

In this lesson you will learn about:

• Selecting stroke and fill attributes

• Drawing with the Classic drawing tools

• Using Natural-Media strokes

• Selecting by stroke

• Changing the stack order

• Layering

• Using Supplemental drawing tools 

Settin
Settings
the attri
Before y
Style pa
want to 

To set s

1Click 
Comp

2Click 
palett

3Click 

 

the Fill tab. 

the Color icon to set the fill to a 
color.

troke type to None.
4Select the Tutorial directory as the 
location to save the file.

5Click Save.

At this point you can continue with the 
next lesson or end your Expression work 
session.

Open the file you created in Lesson 1 (dfly) 
or open the file named lesson2.xpr.

One of the advantages of using Expression 
is that you can quickly change the look of 
your artwork by applying a different stroke 
and fill to any path.

To add more interest to the dragonfly 
wings you now fill them with color. You are 
going to use the Pen tool to draw shapes. 
The shapes have no stroke, because you 
don’t want a hard edge on the wings. The 
fill is a somewhat transparent light blue 
color.

None.

4Click 

5Click 
solid 

Set the s
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6Use the skills you developed in Lesson 1 by tangent handles. For more information 3Use the Node Selection tool from the 
ls toolbar to move nodes or tangent 
les as needed. 
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to select a light blue color. If you need a 
refresher on choosing colors, see 
➤“Adding Color,” earlier in this chapter.

Color icon

on the drawing tools, see ➤Chapter 3, “Cre-
ating Paths.”

To create a shape with the Pen tool:

1Click the Classic Drawing Tools icon in 
the Tools toolbar and choose the Pen 
tool. 

2Click and click-drag to draw a shape 
filling the inside of the top wing. To end 

Select the Pen tool.

Too
hand
the same technique to fill the other 
 segment. Be sure to stay inside the 
 outlines, because you will need to 

ct the outline later in this tutorial.

ce that the overlapped area shows a 
rent shade of blue, created from the 
sparent layers. Expression makes it 
 easy for you to add this kind of Nat-
-Media look.

 second wing. Notice transparency 
 where the wings overlap.
7Expression allows you to control 
transparency or opacity with the Opacity 
slider in the Paint Style palette. Make the 
dragonfly wings transparent by setting 
the Opacity slider to 50%.

Drawing Paths
Expression includes a variety of drawing 
tools. The Classic (two most common) 
drawing tools, Freehand and Pen, are 
together on the toolbar. The Freehand tool 
creates a path as you move the cursor with 
the button held down. The Pen creates a 
Bézier path by placing points (nodes). The 

Set the fill to Color and the Opacity to 50%.
the path click on the starting point or 
press the Return/Enter key.

4Use 
wing
wing
sele

Noti
diffe
tran
very
ural

Fill the
buildup
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lines connecting the points are controlled Fill the inside top of the wing.



 the Freehand tool from the Tools 
r, paint over the wings to add the 

extured stroke.  

e Freehand tool.
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Using a Natural-Media Stroke

Fill the other wings.

To set color for a multi-color stroke:

1Click the Stroke Color button in the 
Color palette, to ensure that the changes 
you make now apply to the stroke. 

4Using
toolba
new t

Select th
ing by Stroke
ion makes it easy for you to change 
an image that share attributes. 
 be a real help when editing a com-
ge. For this exercise we are going 
 paths that have the same stroke 
to them. In another situation you 
lect paths that have the same 
e same fill or a combination of 

tributes, such as all blue paths with 

er the wings.
Now you are ready to add some texture to 
the dragonfly wings.

To draw with Natural-Media stroke:

1Choose the Deselect All button from the 
Composition toolbar. 

2Select the stroke named Fine Brush. This 
Natural-Media stroke mimics a paint 
brush. It is composed of two colors 
which you can control by using the Color 
palette.

2The Color palette displays two 
rectangles representing the foreground 
(left rectangle) and background (right 
rectangle) colors. Click the foreground 
(left) color and select a bright blue. This 
is the predominant color for your stroke.

3Click the background (right) rectangle, 
then select a deeper blue color. This is 
the secondary color for your stroke.

Select the Stroke Color button.

Select
Express
parts of 
This can
plex ima
to select
applied 
could se
color, th
these at

Paint ov
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c stroke.
a specifi



In this case, the wing outlines are on the 
 of the stack, since they were drawn 

xpression makes it easy for you to 
n object up or down in the stack or 
 to the top or bottom. 

nge stack order:

g the Object Selection tool from the 
s toolbar, select the objects you 
 to bring forward. (If you have not 
ed elsewhere the wing outlines are 
selected.) 

ose the To Top button in the 
position toolbar. The selected 
cts are now on the top of the stack. 
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To select by stroke:

1Select a sample path, in this case, the 
lower wing outline path.

2Choose Edit menu> Select By. The 
Select By dialog appears.

Now that the similar strokes are selected 

Using Select By, all paths with the same 
stroke are selected.

bottom
first. E
move a
send it

To cha

1Usin
Tool
wish
click
still 

2Cho
Com
obje
 the To Top button to bring the current 
n to the top of the stack.
3Select Same Stroke. 

4Click OK. All three lower wing outline 
paths are now selected. The topmost 

Select the lower wing path.

In the Select By dialog select Same Stroke.

you can replace their current Skeletal 
Stroke with a different stroke by select-
ing a new stroke in the Stroke Warehouse 
palette. 

5Select the stroke named Silk. The Silk 
stroke is applied to all three paths.

Changing the Stack Order
When two or more objects are placed at the 
same location on the screen Expression 
has to decide which one to paint last. The 
object painted last appears to be on the top 
of the stacked objects. If you don’t change 
the stack order Expression paints objects 
in the order they were created. 

Choose
selectio
lected objects are now on top.
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wing outline path is not selected, since it 
has a different stroke applied to it. The se



e New. A new layer is created and 
d Layer 2.

ame and color for a layer:

yer is created.
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Adding Wing Detail
Before the dragonfly is complete, you need 
to add one more detail. 

1Using the Freehand tool from the Tools 
toolbar, draw a simple spiral shape on 
the topmost wing. Since the Silk stroke is 
still the active stroke in the Paint Style 
menu, your new path displays the same 
Silk stroke. 

Choose the Freehand tool from the Tools 
toolbar.

Layering
Another useful feature of Expression is Lay-
ers. You can put elements of your image on 
different layers which you can then lock or 
hide. A locked layer cannot be edited. This 
can be helpful when you want to ensure ele-
ments are not inadvertently changed. Hid-
den layers do not print. This can be useful 
when you want to trace over an image, then 
hide it. 

To create a new layer:

1Choose Window menu> Layers. The 
Layers palette appears. Each layer is 
assigned a unique color and name.

3Choos
name

To set n

A new la
 Layer 2.

the icon above the scroll bar to 
y the Layers pull-down menu.
Dragonfly with a Silk spiral on the wing.

2Click the icon above the scroll bar to 
display the Layers pull-down menu. 

Lock/Unlock Pull-down menu

1Select

2Click 
displa
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The Layers palette with pull-down menu.

Hide/Show Layers list



3Choose Info. The Layer Info dialog Using a Supplemental Drawing 

tion to the classic Freehand and Pen 
g tools, Expression includes three 

ful supplemental drawing tools: 

line Draws straight line and circle 
ine segments.

pplemental Drawing tools.

e tool

B-Spline tool

Smoothed 
Polyline tool
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appears.

4Enter the name “background” and select 

The Layer Info dialog.

To send layer to back:

1Click to select the background layer 
from the Layers palette.

Click the icon above the scroll bar to 
display the Layers pull-down menu.

Lock/Unlock and Hide/Show icons.

Locked
Unlocked

Hidden
Shown

Tool
In addi
drawin
power

Poly
arc l

The Su

Polylin
line Draws smooth curved line seg-
ts based on straight line control 
gon.

othed Polyline Draws curved line 
ents.

ay want to experiment with each of 
ools to become familiar with their 
l features. Use the scrolls to move to 
of the document that is off the page. 
ay you can doodle with the tools 
t adding any unwanted paths to 
nal printing page. Of course, you can 
any paths you do not want to keep.

re information on these drawing 
the color you wish to assign to the layer. 
You can also set the display quality, 
hide, and/or lock the layer in this dialog.

5Click OK.

To lock/unlock a layer:

1Click to select Layer 1.

2Click the Lock icon next to the layer’s 
name in the Layer palette. Now you can 
not mistakenly edit the dragonfly. If you 
decide later that you want to edit the 
dragonfly unlock the layer and you will 

2Choose Send to Back.

For more information regarding Layering, 
see ➤“Layering Objects” in Chapter 6, 
“Arranging and Editing Objects.”

Background layer selected and ready to send 
to back.

B-Sp
men
poly

Smo
segm

You m
these t
specia
a part 
That w
withou
your fi
delete 

For mo

ee ➤Chapter 3, “Creating Paths.”
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be ready to work. tools, s



n 3: Completing the 
r

sson you will learn about:

ing the direction of a path

g Text

ng a Skeletal Stroke

ng a repeating stroke

ing a Multi-view stroke

izing

e file you created in Lesson 2 
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Creating B-Spline Spirals

1With the Silk stroke still selected, click 
the Supplemental Drawing Tools icon in 
the Tools toolbar and choose the 
B-Spline tool.

2In the Color palette, select a blue color as 
your foreground color. 

3Using the B-Spline tool draw a spiral by 
clicking to place a series of points 
(nodes) as shown below. The B-Spline 

The B-Spline tool and other Supplemental 
Drawing tools.

4Use this same technique to create a 
group of spirals to frame your dragonfly. 

Frame your dragonfly with spirals.

Lesso
Poste

In this le

• Chang

• Addin

• Creati

• Creati

• Apply

• Raster

Open th

r open the file named lesson3.xpr.

ass
 are ready to add the green grassy 
 your image.

grass to the image:

an empty space or the Deselect All 
n so changes you make do not 
 your spirals. 

 the stroke named Taper from the 
 Warehouse palette.

the Classic Drawing Tools icon in 
tool creates a curved path based on a 
polygon defined by the points you place. 
To end the spiral, double-click or press 
the Return/Enter key. Have fun and don’t 
worry if your spirals are not exactly like 
those shown. 

Drawing a spiral with the B-Spline tool.

5Save your file. 

To save:

1Choose File menu> Save As.

2Name the file dfly2.

3Select the Tutorial directory.

4Leave other settings at the default and 
click Save.

At this point you can continue with the 
next exercise or end your Expression work 
session.

(dfly2) o

The Gr
Now you
leaves to

To add 

1Click 
butto
affect

2Select
Stroke

3Click 
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ols toolbar and choose the 
and tool. 
the To
Freeh



4In the Color palette, select a green color image than you get when you use the same 

t the image:

 an empty space or the Deselect All 
on. 

g the Object Selection tool from the 
s toolbar, select one of the blue 
als.

ing down the Shift key, click on each 
aining blue spiral until all of them are 
cted.

ct the Fluid stroke from the Stroke 
ehouse palette. The selected paths 
ge to reflect the new color.

Ch02.FM5  Page 50  Wednesday, November 6, 1996  10:40 AM
for your grass. 

5Draw a series of long, free flowing paths 
to represent the grass. Don’t worry if 
your image is not exactly the same. Have 
fun expressing yourself!

stroke to draw from bottom to top. When 
applying a Skeletal Stoke you need to be 
aware of the direction of your path. How-
ever, it is easy to change the direction if 
you need to.

To change direction of a path:

1Click the Path tools icon in the Tools 
toolbar and choose the Reverse Path 
tool.

To edi

1Click
butt

2Usin
Tool
spir

3Hold
rem
sele

4Sele
War
chan
Changing the Direction of a Path
Deselect All then use the same technique to 
add some cattails to your design by select-
ing the Skeletal Stroke named catstail.

When you draw the cattails, notice that the 

Draw the grass.

2Click the path. The path reverses 
direction.

Editing the Image
To soften the effect of the blue spirals, 
change their stroke to the stroke named 
Fluid stroke. 

The Reverse Path tool.

Changing the direction of the cattail path.
age after adding cattails and changing 
ke of the B-Spline spirals.
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direction of the path is important. If you 
draw from top to bottom you get a different The im

the stro



wers

the irises:

an empty space or the Deselect All 
n. 

 the Skeletal Stroke named Iris 
he Stroke Warehouse palette. 

e stroke width as you like for each 
ce of the iris. Remember, you can 
e Shear/Width handle or the Width 
g in the Paint Style palette.

the Reset Color button in the Paint 
palette to return to the default 
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5Click an empty space or the Deselect All 
button. 

6Click the Reset Color button in the Paint 
Style palette, so the color scheme 
returns to the default settings.

The Pond

To add a pond:

1Select the stroke named Airbrush from 
the Stroke Warehouse palette. 

2Edit the color to a light blue. This stroke 
includes transparency so the color 
builds up as the stroke crosses itself, 

The Flo

To add 

1Click 
butto

2Select
from t

3Set th
instan
use th
settin

4Click 
Style 
scheme.

the iris flowers, from the roots up 
 blossom.

 iris flowers from the roots up.
much like watercolor paint.

3Scribble a few lines with the Freehand 
tool to create the pond. Setting the 
stroke width to a larger size makes the 
job easier.

Adding the pond.

color 

5Draw 
to the

Draw the
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2Choose the Text tool from the Tools Creating a Skeletal Stroke
n create a Skeletal Stroke from any 
 you can draw or import. Now use 
t to create a new stroke.

ate a new stroke:

ose the Stroke Definition Box tool 
 the Tools toolbar. The cursor 
ges to a cross hair. 

oke Definition Box tool.
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toolbar. The Font palette appears.

3Select the font and style (Regular) you 
want. 

The Text tool.

The Font palette.

You ca
picture
the tex

To cre

1Cho
from
chan

The Str
ting at the upper left edge of the text, 
 a marquee enclosing the entire text 
ct. An arrow indicates the direction 
ur stroke. When you release the 
se button Expression opens the 
ke Definition window. 

 marquee around your object using 
ke Definition Box tool to open the 

Definition window. 
Adding Text
Expression makes it simple to add text to 
your artwork and also allows you to create 
some interesting special effects with text. 

To create a text object:

1Open a new document by choosing File 
menu> New.

Adding flowers to your poster.

4Set the size to 72.00. The cursor changes 
into an I beam, indicating the application 
is ready to create text. 

5Click in the center of your page and type: 
express yourself. 

6Close the Font palette.

2Star
drag
obje
of yo
mou
Stro

Draw a
the Stro
Stroke 
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the Anchor/Repeat Tools icon from 
ols toolbar and choose the Repeat 

 Stroke Definition window, click or 
rag to select all the objects you 

to set as repeating. For our 
le, drag a marquee to select the 

 text object.

e the Make Repeating button from 
tions toolbar. 

eat tool.
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3If needed, edit your artwork. 

4Click the Define button at the lower left 
corner of the Stroke Definition window. 

Edit art as needed.

5Scroll to select the Tutorial folder.

6Name your stroke Text1.

7Set the width to 72.00.

8Click OK.

Using Your New Stroke

Return to your original document. Make 
sure that your newly created stroke is 
selected in the Stroke Warehouse palette. 
Use the Freehand tool to draw a graceful 
curved path at the bottom of your scene. 
Adjust the width as needed. Use the Node 
Selection tool to edit the path if you wish. 

2Click 
the To
tool. 

3In the
click-d
want 
examp
whole

4Choos
the Ac

The Rep
the Define button at the bottom of 
roke Definition window. The Stroke 
tion dialog appears.

 your repeating stroke repeatx.

OK. 

e Repeating button.
The Define Stroke dialog appears, giving 
you the opportunity to select a folder in 
which to store your new stroke.

The Define button for the Stroke Definition 
window.

Creating Repeating Stroke
There are a lot of fun things you can do 
with a Skeletal Stroke. Now you are going to 
create a repeating stroke based on your 
text.

To make parts of a stroke repeating:

1In the Stroke Warehouse palette, double-
click the stroke you just created to take it 
back into the Stroke Definition window. 

Text stroke applied to a path.

5Click 
the St
Defini

6Name

7Click 

The Mak
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The Define Stroke dialog.



Applying the Repeating Stroke Multi-view Strokes dow there is a timeline across the top. A 
ker indicates each position or key-
e. 

 the left keyframe to see the iris fully 
ed. 

 the next keyframe to the right to 
the iris starting to close. 

 the right most keyframe to see the 
 completely closed. 
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In the Paint Style palette, be certain that 
your stroke, repeatx, is selected, with its 
color set to a medium blue. Now use the 
Freehand or B-Spline tool to draw a spiral 
in the pond. 

It would be unusual for all the flowers in a 
garden to look exactly the same. Nature 
doesn’t behave that way and there is no 
reason your artwork has to either. Expres-
sion’s Multi-view strokes provide you a way 
to quickly create a group of flowers that are 
related but different.

1Select the stroke named Multiiris from 
the Stroke Warehouse palette. Notice 
that its animation in the Stroke 
Warehouse palette shows an iris opening 
and closing again. 

2Double-click the stroke to display it in 
the Stroke Definition window. 

mar
fram

3Click
open

4Click
see 

5Click
bud
e the Stroke Definition window by 
ing the close button in the upper left 
er (Macintosh) or upper right 
er (Windows).

ltiiris stroke set to view the last 
e or 100%.
Draw a spiral in the pond.

The Multiiris stroke is made from five 

The Multiiris stroke in the Stroke Definition 
window. The first keyframe or 0% appears.

6Clos
click
corn
corn

The Mu
keyfram
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pictures moving from a fully open iris to 
an iris bud. In the Stroke Definition win-



the Image

age is almost complete. The next 
 do is make certain that the whole 
 within the printable area of the 

t by click-holding on the zoom but-
e lower left corner of the docu-
lect 0.5x which means the image 
 at half the actual size. If you still 
see the whole image select 0.35x to 
t even more. 
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Which View Displays?

When you apply a Multi-view stroke to a 
path, Expression determines which view 
appears. It may display the open flower, the 
closed bud or some variation between the 
two key pictures. Which shape or view 
appears is controlled by the Paint Style pal-
ette. 

To set which view displays:

1In the Paint Style palette, select the 
Random option. 

2Click Apply. Expression randomly 
assigns a view to each path you draw. 

Applying the Multi-view Stroke

To apply the Multi-view stroke:

1In your main document, using the Object 
Selection tool, click to select one of the 
iris flowers in your image. 

Center 

Your im
thing to
image is
page. 

Zoom ou
ton at th
ment. Se
appears
can not 
zoom ou
e 0.5% zoom.
You can choose Random or you can use the 
Shape slider to specify which view. With 
the Shape slider set to 0%, the first key 
frame appears. With the Shape slider set to 
100%, the last keyframe appears. Any set-
ting between the two extremes determines 
which in-between view actually appears. 
Expression automatically creates between 
views, based on the keyframe pictures you 
define.

The Paint Style palette.

2Choose Edit> Select By.

3Select Same Stroke to select all the 
flowers. 

4Click the Multiiris stroke to apply it to all 
the selected paths. Each flower appears 
slightly different.

Select th
Chapter 2 • Tutorial 55
A new view is assigned to each path.



en you intend to rasterize your image, it is a 
ea to always save the file as an Expression 
nt first. Once the image is rasterized you 
make changes to the rasterized artwork in 
ion. Take the rasterized image into an image 
application such as Fractal Design Painter for 
al changes.

ing Your Image
our artwork is ready to print. This 
includes transparency, a concept 
 difficult for most vector graphics 
tions and Postscript printers. 

Ch02.FM5  Page 56  Wednesday, November 6, 1996  10:40 AM
To resize the whole image:

1Make sure all the layers are unlocked.

2Choose the Select All button from the 
Composition toolbar.

3Using the Object Selection tool from the 
Tools toolbar, hold down the Shift key 
and drag the bounding box Resize handle 
toward the center of the image.

Holding down the Shift key as you resize a selection 
constrains the change to the current aspect ratio.

Even wh
good id
docume
cannot 
Express
editing 
addition

Print
Now y
image 
that is
applica
sion must rasterize or convert the 
 information into bitmap informa-
fore it can be printed.

nt:

ose File menu> Print. The Print 
g appears.

ct a printer from the Printer pop-up 
u.

he number of copies you want 
ted.

e this image includes a transparency, 
4Once the size is correct, click in the 
center of the image and drag to 
reposition it in the middle of the page. 

Save the Completed Express 
Yourself Poster

To save your completed image:

1Choose File menu> Save As.

2Name the file dfly3.

3Select the Tutorial directory.

4Leave other settings at the default and 
click Save.

Center your image on the page.

Expres
outline
tion be

To pri

1Cho
dialo

2Sele
men

3Set t
prin

4Sinc

le the Rasterize Before Printing 

on.
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5Set the dpi that your printer supports.

6Click OK. Expression converts the image 
to a bitmap image and sends the 
bitmapped image to the printer. The 
process of rasterizing takes some time to 
complete. Expression displays a 
progress bar at the bottom of the screen 
and the cursor changes into an hour 
glass.

Rasterizing
You may also want to save your artwork as 
a bitmap image so you can work with it in 
an image editing program such as Fractal 
Design Painter or Adobe Photoshop. 

5Select a directory in which to save your 
file, name the file and select the file 
format you prefer.

6Click Save. Converting a file to bitmap 
takes some time as each pixel in the 
image needs to be defined. A progress 
bar at the bottom of the window displays 
the percent completed. 

For more information on rasterizing, choos-
ing file formats, anti-aliasing and exporting, 
see ➤“Opening and Saving Documents” in 
Chapter 1, “Overview of Expression.”

The Save progress bar.
To rasterize an image:

1Choose File menu> Save Bitmap. The 
Bitmap Settings dialog appears. 

2Set the width and height you want.

3Set the resolution to match your 
printer’s capabilities. 300 dpi usually 

The Bitmap Settings dialog.

Now you are ready to freely “express your-
self” using Expression! Check the Expres-
sion Creative Techniques guide for more 
ideas on using Expression.
Chapter 2 • Tutorial 57
gives excellent results.

4Click OK.
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Creating Paths

 

Like other draw applications, 
Expression is object-based. This is 
what makes Expression artwork so 
easy to edit—after you create an 
object, you can select it and change 
its size, shape or paint 
characteristics. Objects in 
Expression are made up of paths. A 
path is simply a straight or curved 
line with points which allow you to 
edit its shape. This chapter 
discusses how to create and edit 

 

paths.
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Understanding Paths

         

rection of a path is very important in 
sion when using Skeletal Strokes. 
keletal Strokes often have a distinct 

nd end, you may want the stroke 

 

 a Skeletal Stroke from any vector 
..

he Skeletal Stroke to your path.

 

Ch03.FM5  Page 60  Thursday, November 7, 1996  9:27 AM
A path is a continuous line made up of one 
or more curved or straight path segments. 
Each path segment is defined by a series of 
points. These points, and the tangent han-
dles associated with the points, can be 
moved and edited to change the shape of 
the path. Expression uses standard com-
puter graphics tools to draw and edit 
paths.

Two or more paths can be combined to 
make a compound path. A compound path 
is a set of paths which Expression treats as 
a single object. Compound paths are useful 

Closed path.

The di
Expres
Since S
start a

Create
image.

Apply t
to be pointing in a certain direction.

nd path, left to right and right to left.
primarily for creating objects with holes. 
For more information regarding compound 
paths, see ➤“Creating Compound Shapes,” 
later in this chapter.

Every path has a beginning and end. 
Expression identifies the end point on a 
path with an arrow indicating the direction 
of the path. With an open path, it is very 
easy to identify the beginning and ending 
points. In a closed path, such as a circle or 
rectangle, the beginning and ending points 
are at the same location.   

Any path or shape you create can be 
defined as a Skeletal Stroke or can be com-
bined with other paths or shapes to create 
a Skeletal Stroke. The Skeletal Stroke can 
then be applied to a path.   

Compound path.

Create a simple path...

image 

Freeha
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Open path.



                                  

te a freehand path:

  

the 

 

Classic Drawing Tools

 

 icon in 

 

ols

 

 toolbar and choose the 

 

and

 

 tool. The cursor changes to a 
rush. 

  

he mouse or stylus across the 
pace. 

  

 your path is finished, release the 

 

he Freehand tool.
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Drawing Tools

Expression provides nine basic drawing 
tools:

• Freehand tool

• Pen tool

• Polyline tool

• B-Spline tool

• Smoothed Polyline tool

• Line tool

• Rectangle tool

Creating Freehand Paths
The Freehand tool allows you to create 
paths by drawing freely. Expression auto-
matically creates points based on the path 

The cursor changes as it nears the endpoint.

To crea

1Click 
the To
Freeh
paintb

2Drag t
works

3When

Choose t
e. A vector path is created. 

 a freehand path.
• Ellipse tool

• Text tool

These tools allow you to create new paths 
or to add points to an existing path. By 
default, all of the drawing tools (except the 
Freehand tool) automatically add points to 
an existing path when you position the cur-
sor over an existing endpoint and continue 
drawing. You can disable the behavior by 
setting a user preference. For more infor-
mation on setting user preferences, see 
➤“Setting Preferences” in Chapter 1, “Over-
view of Expression.”

You can force any drawing tool (including 
the Freehand tool) to continue an existing 

you draw. 

If you are using a stylus, the pressure sensi-
tivity can be enabled to take advantage of 
pressure strokes. For more information on 
using a stylus, see ➤“Using a Stylus,” later 
in this chapter. 

mous

Creating
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path by holding down the Shift key. The 
cursor changes as it is positioned near the 
endpoint.



   

Creating Bézier Paths

               

releasing the mouse button, the 

             

Clicking creates a point with tangent han-
 retracted (

 

corner point

 

). 

ging creates a point with preceding 
following tangent handles (

 

curve 
t

 

). Click then drag the tangent han-
 as needed to adjust the shape of the 
. This allows you to edit the Bézier 
 segments as the path is created.

 

 create a corner point.

Corner Point

Segment

Handle
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The Pen tool is used to create a Bézier path 
point by point. The tangent handles of each 
point control the shape of the path. 

You place a Bézier point by clicking or 
dragging, creating corner or curve points. 
The points of a Bézier path can be con-
verted from corner to curve or curve to 
corner. 

You can also use the following keys to cre-
ate other effects.

• Hold down the Shift key while dragging to 
constrain the angular relationship 
between the following tangent handle and 
the Bézier point. 

preceding tangent handle snaps back into 
the position symmetrically opposite the 
following tangent handle. 

dles

Drag
and 
poin
dles
path
path

Click to
efault, the preceding handle is sym-
ically opposed to the following tan-
 handle, an equal distance from the 
t you are creating. 

Curve Point

Segment

Handle

• Hold down the Option/Alt key before or 

during the drag to lock the preceding 
tangent handle in its current position: the 
drag thus affects the position of the 

Constraining the angular relationship, with 
and without the Shift key.

To create a Bézier path:

1Click the Classic Drawing Tools icon in 
the Tools toolbar and choose the Pen 
tool. The cursor changes to a pen. 

2Click or drag on the workspace to create 

Locking tangent handles while drawing, with 
and without the Option/Alt key.

Choose the Pen tool.

By d
metr
gent
poin
 create a curve point.
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following tangent handle only. If you 
release the Option/Alt key before 

a point. 

Drag to



                                    

ng B-Splines

  

line 

 

tool is used to draw smooth 
It works like a standard polyline 
u simply click to place points, or 

  

n the page. Instead of connecting 
s with straight line segments, the 

 tool creates a smooth curve which 
ear each node. 

raw, both the B-Spline curve and 
inary polyline connecting the verti-
isplayed to give you interactive 

k.

 

te a B-Spline curve:

  

the 

 

Supplemental Drawing Tools
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3Create other points as needed.

4Double-click or press the Return/Enter 
key to end the path.

Creating Polylines
The Polyline tool is used to create straight 
lines and arc segments. 

To create a polyline curve:

1Click the Supplemental Drawing Tools 
icon in the Tools toolbar and choose the 
Polyline tool. The cursor changes to a 
polyline cursor. 

4Drag to create an arc segment. The initial 
mouse click determines the tangent of 
the arc. The arc’s endpoint is determined 
by the position of the point when the 
mouse is released. 

5Click or drag to create other points as 

Drag to create an arc.

Drag

Release mouse

Creati
The B-Sp
curves. 
tool—yo
nodes, o
the node
B-Spline
passes n

As you d
the imag
ces are d
feedbac

To crea

1Click 

n the Tools toolbar and choose the 
ne tool. The cursor changes to a 
ne cursor. 

to create the first point and all 
 points as needed. No dragging is 
sary to create a B-Spline curve. The 
 is automatically stretched between 
 as you move the mouse.

he B-Spline tool.
2Click to place a point at the location of 
the click. 

3Click again to create a straight line 
segment. 

Choose the Polyline tool.

needed. 

6Double-click or press the Return/Enter 
key to end the path. The path is 
automatically converted to Bézier points.

Double-click to complete the path.

icon i
B-Spli
B-Spli

2Click 
other
neces
curve
clicks

Choose t
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Click to create a straight line segment.



                  

ing Smoothed Polylines

  

oothed Polyline

 

 tool creates a 
h path based on your placement of 

          

tion/Alt-click to create a corner point.

Corner point
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3Double-click to define the end point or 
click on the beginning point to create a 
closed shape. 

When you complete a shape, the path is 
displayed as a solid line while the 
imaginary polygon is displayed as a 
dotted line. 

Simply click to automatically create a curve.

• Moving or deleting an existing point 

B-Spline paths.

Start and 
end points 
are on the 
line

Points are 
offset from 
the line Creat

The Sm
smoot

Use Op
. While drawing, straight line seg-
appear, connecting each point cre-
pon completion, the straight line 

nts are replaced by smoothed 
, each point behaving as a Bézier 
point. 

ate a Smoothed Polyline curve:

 the Supplemental Drawing Tools 
 in the Tools toolbar and choose the 
othed Polyline tool. The cursor 
ges to a polyline cursor. 
• When using the B-Spline tool on an open 
path, the beginning and ending points are 
located on the line but all the points 
between the first and last points are offset 
from the path itself. On a closed path, all 
the points are offset from the path itself.

Double-click to complete the path.

modifies the shape of the B-Spline path. 

• Using the Add Point tool to add a new 
point converts the path into a standard 
Bézier path.

• Option/Alt-click starts a new B-Spline 
curve whose beginning point is the same 
as the end point of the previous curve. 
This creates a cusp or corner point on the 
path.

points
ments 
ated. U
segme
curves
curve 

To cre

1Click
icon
Smo
chan
 the Smoothed Polyline tool.
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Choose



                                

ng Rectangles or Squares

  

tangle

 

 tool creates a rectangle or 
One corner of the rectangle is set 
cation at which you start the drag 
e opposite corner is set to the posi-
hich you release the mouse but-

 

te a rectangle or square:

  

the 

 

Shape Object Tools

 

 icon in the 

  

toolbar and choose the 

 

Rectangle 

 

he cursor changes to a crosshair. 
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2Click to create the first point and all 
other points as needed. 

3Double-click to define the end point or 
click on the beginning point to create a 
closed shape. 

Create all points as needed.

Creating Lines
The Line tool creates straight path seg-
ments. The beginning point is defined by 
the first click and the end point, by the 
location at which the mouse button is 
released. 

To create a line:

1Choose the Line tool from the Tools 
toolbar. The cursor changes to a 
crosshair cursor. 

Creati
The Rec
square. 
to the lo
while th
tion at w
ton. 

To crea

1Click 
Tools 
tool. T
o create a rectangle. The path 
ws on screen as you drag.

own the Shift key to constrain the 
gle to a square. 

se the mouse button to complete 

he Rectangle tool.

reate a rectangle.
Double-click to finish the shape.

2Drag to create a straight line. The line is 
previewed on screen as you move the 
pointer. 

Hold down the Shift key to constrain the 
angle of the line between the beginning 
and ending points. The angle of con-
straint can be set by choosing File 
menu> Preferences: Options> Angu-
lar constraint steps.

3Release the mouse button at the location 
you want to use as an end point.

4Drag again on the end point to continue 

Choose the Line tool.

2Drag t
previe

Hold d
rectan

3Relea

Choose t

Drag to c
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ape.
your path with another straight line 
segment.

the sh



   

Creating Ellipses and Circles

    

3Release the mouse button to complete Creating Text
xt tool creates text objects based on 
ype or Type 1 fonts. (Bitmapped 
re not supported since Expression 
the vector based outlines.) You can 
racteristics for text objects, such as 
yle and size.

f the characters of a text object can 
s own individual stroke and fill 
tes. 

ate a text object:

ose the Text tool from the Tools 
bar. The cursor changes to an I-beam 
the Font palette appears. 
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The Ellipse tool creates a ellipse (oval) or 
circle. Each ellipse has a bounding box 
which is the smallest rectangle that can 
contain the ellipse. One corner of the 
bounding box of the ellipse is set to the 
location at which you start the drag while 
the opposite corner is set to the position at 
which you release the mouse. 

To create an ellipse or circle:

1Click the Shape Object Tools icon in the 
Tools toolbar and choose the Ellipse 
tool. The cursor changes to a crosshair 
cursor. 

the shape.

; Note: The Ellipse is a special class of 
path; unlike the rectangle and line segment. 
A complete ellipse is created by default, 
but you may move the ellipse’s special 
point to specify beginning and ending 
points, thus creating a partial elliptical line 
segment. 

You then use the Ellipse Closure controls in 
the Action toolbar to specify whether the 
open ends of a partial ellipse are uncon-
nected, connected to the center point of 
the ellipse with two straight line segments 
or connected by a single straight line seg-
ment. 

The Te
True T
fonts a
needs 
set cha
font, st

Each o
have it
attribu

To cre

1Cho
tool
and 
 at the position where you want to 
te your text object. 

 the Text tool.

nd enter your text.
2Drag to create an ellipse. The path 
previews on screen as you drag.

Hold down the Shift key to constrain the 
ellipse to a circle. 

Choose the Ellipse tool.

For more information regarding the use of 
the Action tools, see ➤“Editing Ellipses” in 
Chapter 6, “Arranging and Editing Objects.”

The Ellipse Closure controls.

2Click
crea

Choose

Click a
e characters as needed. 
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Drag to create an ellipse.
3Typ



e the Text tool from the Tools 
r.

on the path at the point you want 
xt to start. The cursor changes as it 
itioned over the path.

characters as needed. 

 is added to the path.
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To set characteristics for a text object:

1Using the Object Selection tool from the 
Tools toolbar, select a text object. 

2If the Font palette is not displayed, 
choose Window menu> Font to 
display the Font palette. 

Select the text object.

5Set the size by using the up/down arrows 
or highlight the Size entry box and type 
the size you prefer.

6Set the text alignment. You can choose 
from right, center, and left justify.

7Set the leading. The Leading entry box is 
only available when Auto Leading is 
deselected.

Using Text on a Path

Expression gives you the ability to assign 
text to flow along a path.

Some Text on a Path constraints:

• Multiple lines of text are not supported. 

2Choos
toolba

3Click 
the te
is pos

4Type 

The text
y existing text to an existing 

 the Object Selection tool from the 
toolbar, select the path, hold down 
ift key and select the text. 

e existing text and path, using the 
 to select multiple objects.
3From the pull down menu choose the 
font you prefer.

4From the Style list pull down choose the 
style you prefer. The selections available 
in this menu vary depending on the font 
selected.

The Font palette.

Only the first line of text is applied to a 
path.

• Text that extends beyond the end of the 
path proceeds in a straight line following 
the direction of the tangent at the end of 
the path.

; Note: Alignment and Leading are only 
useful when using more than one line of 
text.

To apply text to a path:

1Create a path or select a path using the 
Object Selection tool from the Tools 
toolbar.

To appl
path:

1Using
Tools 
the Sh

Select th
Shift key
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2Choose Objects menu> Text on 2Drag the text insertion beam along the Creating Compound 
es

mpound shape, two or more paths 
uped in a special way so that the 
of one path is “cut out” of the other. 
nction can be very useful in creating 
 such a A, O, P and R but can also be 
r creating more interesting shapes 
jects which you can “see through” to 
bjects beneath.

ate a compound shape:

g the Object Selection tool from the 
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Path> Attach. 

To change the origin point for text on a 
path:

1Using the Object Selection tool or Node 

The text is applied to the existing path.

path. 

To separate text from a path:

1Using the Object Selection tool from the 

Move the text insertion beam to move the 
origin point.

Shap

In a co
are gro
shape 
This fu
letters
used fo
and ob
view o

To cre

1Usin

s toolbar, select two or more paths.

your objects.
Selection tool from the Tools toolbar, 
select the path containing text. 

Select the text insertion beam.

Tools toolbar, select the path containing 
text.

2Choose Objects menu> Text on 
Path> Release. Text is released from 
the curve. 

Tool

Select 
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ro Winding Rule

 within the object, including over-
areas, are filled.

: The direction in which the path is 
akes a difference when filling a 

nd path with the Non-zero Winding 
ression automatically reverses 
 when you create a compound 
ut some shapes may still need to 
ath reversed. If you find yourself 
ape that is not being filled as you 

 it would try reversing one of its 
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2Choose Objects menu> Compound 
Object> Make. 

Filling Complex Shapes
On simple shapes, rectangle, ellipse, or 
closed path, it is easy to tell what is inside 

A compound shape is created from the 
selected objects.

These two choices are based on standard 
Postscript rules but you may find it sim-
plest to just experiment to get the desired 
effect. The traditional example used to 
illustrate the two methods is a star drawn 
with five lines, creating a pentagon in the 
center. With the Non-zero Winding Number 
rule the pentagon is filled. With Even-Odd 
rule the pentagon is empty. 

; Note: For more technical explanation of 
Non-Zero Winding Number rule and Even-
Odd rule, see ➤Appendix B, “Glossary.” 

Non-Ze

All areas
lapping 

; Note
drawn m
compou
rule. Exp
one path
shape. B
have a p
with a sh
thought
paths.
dd Rule

ping areas are not filled, and multi-
laps alternate between filled or not 

 compound shape:

 the Object Selection tool from the 
toolbar, drag a marquee to select 
r more over-lapping objects.
and should therefore be filled. On an open 
path an imaginary line connects the first 
and last points thus defining which areas 
are inside. 

However, on any shape where a path 
crosses itself, or where one path encloses 
another path, Expression must decide 
which areas to fill and which to leave 
empty. 

The Fill Rule Control in the Paint Style pal-
ette lets you set which of two methods is 
used in applying your fill to such an object:

• Non-Zero Winding Rule

• Even-Odd Rule

Non-Zero Winding Rule example.

Even-O

Overlap
ple over
filled.

To fill a

1Using
Tools 
two o
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Even-Odd Rule example.



2Choose Objects menu> Compound 4Click on the Fill tab. Using The Clipper 
king)

xpression’s clipper, you can mask 
lar areas of your artwork. A mask or 
 allows only those objects or parts 
cts that lie inside the mask path to 
n. This operation is similar to using a 
 cutter; the area you cut out of the 
 is the area you keep. 

asking object must be a simple or 
und path. Text and grouped paths 
t be used as masks.The top-most 
 is used as the mask and its original 
iscarded. Strokes and fills from lower 
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Object> Make. (Mas

Using E
particu
clipper
of obje
be see
cookie
dough

The m
compo
can no
object
fill is d
ase objects only appear in the 
d area.

 or mask an object:

te or import your mask and base 
cts as needed.

g the Object Selection tool from the 
s toolbar, place the mask object over 
ase objects to be clipped.

e mask object is not the front or top-
t object, select it, then choose 
nge menu> To Front or Com-
d/Ctrl+F to bring it to the top.
3Choose Window menu> Paint Style 

to display the Paint Style palette.

Original elements of the compound shape. 
5Click on the Fill Rule button and select 

Even-Odd rule or Non-Zero Winding 
rule. All objects fill according to the 
rules of your selection.

The Paint Style palette.
layer b
maske

To clip

1Crea
obje

2Usin
Tool
the b

If th
mos
Arra

man
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Even-Odd and Non-Zero Winding rule.



 Boolean Operations

ion supports Boolean operations 
llow you to create closed paths 
n the area enclosed by two source 

: Boolean operations are also 
s pathfinder operations to Adobe 
or users.

rce objects or paths may be 
or closed paths. The area enclosed 
en path is defined by an unseen 

 line segment connecting the begin-
 end points of the open path. Paths 

Ch03.FM5  Page 71  Thursday, November 7, 1996  9:27 AM
You may also wish to change the stack 
order of other objects within your mask. 
Choose Arrange menu> Up One or 
Down One change the order of the 
objects as needed. 

3Select the mask and the base object(s) to 
be masked. 

To release a clipped object:

1Using the Object Selection tool from the 
Tools toolbar, select the masked object.

2Choose Objects menu> Clipper> 
Release.

Using

Express
which a
based o
paths.

; Note
known a
Illustrat

The sou
opened 
by an op
straight
ning and
by Boolean operations are always 
aths and may also be compound 

 objects before Boolean operations.
4Choose Objects menu> Clipper> 
Make. 

Select objects to be masked.

A clipped object.

created 
closed p
paths. 

Original
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The Boolean functions supported are: Back minus Front Creates a new path that 2From the Options tab, select the Path 
ations: keep original checkbox to 
 the original paths or deselect to 

ard original paths after applying a 
lean operation.

ying Boolean Operations
n operations may be applied to a 
on containing more than two source 
In this case, the operation is applied 
 a pair of selected paths. Then the 
peration is applied to the new path 

e next path in the selection. This pro-
 continued until all source paths 
een processed. When applying Bool-
ctions to multiple paths, the 
d paths are processed in order 
ing on the type of Boolean functions 
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Union Creates a new path based on the 
outline of all selected source paths as if 
they were merged into one object. Paths 
inside are ignored. 

Union path.

contains areas in the back path that are not 
overlapped by areas in the front path. 

Intersection Creates a new path that con-
tains areas where the selected source 
paths overlap. Areas and paths that do not 
overlap are ignored.

Back minus Front path.

oper
keep
disc
Boo

Appl
Boolea
selecti
paths. 
first to
same o
and th
cess is
have b
ean fun
selecte
depend
e applying. 

or Intersection Order is of no 
ance.

inus Front Paths are processed 
e back to front.

inus Back Paths are processed 
e front to the back.

esulting from Boolean operations 
inted with the paint characteristics 
front-most selected path for Unite, 
ct and Front minus Back operations. 
ack minus Front operations the paint 
teristics are taken from the back-
elected path.
Front minus Back Creates a new path that 
contains areas in the front path that are not 
overlapped by areas in the back path. 

Front minus Back path.

Setting Boolean Preferences
Source paths can be retained or discarded, 
based on a Preference you set.

To set Boolean preferences:

1Choose File menu> Preferences. The 
Preferences dialog appears.

Intersection path.

you ar

Union 
import

Back m
from th

Front m
from th

Paths r
are pa
of the 
Interse
With B
charac
most s
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troke width

ty

 parameter of Multi-view strokes

eristics such as; stroke definition, 
 types, outline/fill types can not be 
ated. These characteristics are 
m the topmost source path in the 

 order. 

d paths:

 two paths. These paths may be 
or closed but may not be grouped. 
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To apply Boolean 6363Path Operations:

1Using the Object Selection tool from the 
Tools toolbar, select two or more paths.

2Choose Objects menu> Path 
Operations then select whichever 
operation you prefer. You can also use 
the Boolean Operator buttons on the 
Miscellaneous toolbar to complete the 
same functions. 

Boolean Operators.

Blending Paths

With Expression you can create a series of 
new paths based on two different source 
paths. 

• Line/S

• Opaci

• Shape

Charact
cap/join
interpol
taken fro
stacking

To blen

1Create
open 
o paths to blend.
The Blend command allows you to specify 
the number of steps in the blend, then auto-
matically generates the new paths based 
on the characteristics of the source paths. 
The resulting paths are placed into a single 
group. The original source objects are left 
untouched.

The following characteristics are interpo-
lated during a blend:

Blending paths.

Create tw
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• Node and object position

• Color



2Choose the Blend button from the 4Select a method for interpolating path Tagging Paths for Blending
n also set up a point-to-point corre-

ence between the two paths, which 
mes produces better results. 
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Miscellaneous toolbar or choose 
Objects menu> Blend Paths. The 
Blending dialog appears. 

3Select Group to create two or more 
blended shapes or select Just One to 
create one blended shape.

When you select a group of blended 
shapes use the Step box to specify the 

The Blend Path dialog.

geometry:

Linear Each pair of corresponding 
points is interpolated without regard to 
its relationship with other pairs of 
points.

Length Angle Interpolates the angle 
and distance between consecutive 
points. This usually results in more 
shape constancy along the steps of the 
blend.

5Click OK. The blended steps are 
displayed as a grouped object and are 
selected. 

You ca
spond
someti
ths do not need to have the exact 
umber of points. Expression auto-
lly compensates for any difference.

ault, correspondence between paths 
matic. However, this feature allows 
 tag specific points before using the 
command to manually set the point-
t correspondence.

 points for Blending:

 the Node Tools icon in the Tools 
bar and choose the Node Selection 

ng with tags
number of steps or new shapes you 
want. Use the up and down arrows or 
enter a number in the entry box.

Use the boxes labeled From and To to 
specify where you want the new shapes 
created. Expression automatically 
selects evenly spaced positions when 
you specify the number of steps. The 
From and To boxes give you additional 
control.

When you select Just One, use the slider 
or the % box to specify where you want 
the new shape created. Expression auto-
matically selects 50% as the position for 
the new shape. The slider or % entry box 

6If desired, choose Arrange> Ungroup 
or press Command/Ctrl+U to ungroup 
the new paths. 

Blended paths

The pa
same n
matica

By def
is auto
you to
Blend 
to-poin

To tag

1Click
tool

Blendi
.
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give you addition control. tool



ssion then matches each tagged 
on the first source path with the 
ponding tagged point on the 

d source path.

d did not come out as expected, reverse 
ion of one of the paths and try the blend 
oose Objects> Reverse Path or 
ath Tools icon in the Tools toolbar and 
e Reverse Path tool. 

ng More Than Two Paths
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2On first source path, starting from the 
beginning point and working toward the 
endpoint, click on the points you want to 
tag. The point changes from a white box 
to a larger solid box when selected. 

3On the second source path, starting from 

Tagged points change to solid boxes.

5Choose a method for interpolating path 
geometry: Linear or Length Angle.  

Linear interpolation with tagged points.

6Expre
point 
corres
secon

If the blen
the direct
again. Ch
click the P
choose th

Blendi

 use the Blend command on more 
 source paths. In this case, Expres-

nds the first two paths, creating the 
 of steps you requested, then 
he second path with the third path, 
th the same number of steps. The 
 continues until all source paths 
en blended.
the beginning point and working toward 
the end point, click to tag an equal 
number of points.

4Choose the Blend button from the 
Miscellaneous toolbar or choose 
Objects menu> Blend Paths. The 
Blending dialog appears.

Length Angle interpolation with tagged 
points.

You can
than two
sion ble
number
blends t
again wi
process
have be
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Using a Stylus
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In most cases, there is no different between 
drawing with the mouse verses drawing 
with a stylus. However, when using the 
Freehand drawing tool, you have the ability 
to take advantage of the pressure sensitive 
stylus to vary the width of Skeletal Strokes. 
A stroke appears thin where light pressure 
is applied, and thicker where heavy pres-
sure is applied.

To enable pressure sensitivity: 

1Choose the Freehand tool from the Tools 

toolbar.

2Choose the Enable Pressure Sensitivity 
button from the Actions toolbar.

To disable pressure sensitivity:

1Choose the Disable Pressure Sensitivity 
button from the Actions toolbar.
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4

 

Using Color

 

Color has a powerful impact on 
your artwork and Expression 
provides you with a variety of tools 
and methods for controlling color 
to match your needs. This chapter 
discusses the use of color in 

 

Expression.
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History of Colors

  

The Color Palette

       

Color Table

 

 the Color Table display on or off by 
g the 

 

key

 

 in the upper right corner of 
lor palette. When you select a color 
e color table the color pane, regard-

 mode, adjusts to reflect the color 
ve chosen.

lor Table can display the colors with 
der, black border or white border. 
re information on setting the border 
nces, see 

 

➤

 

“View and Palettes Tab” 
pter 1, “Overview of Expression.”. 

 

 Selection

 

ttom of the palette displays the cur-
selected color(s).
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Color is a function of light, the information 
our eyes gather based on light reflected off, 
or emitted from, objects. Through the cen-
turies artists have learned to use certain 
chemicals to create specific colors as pig-
ments. The way color pigment is mixed to 
create different colors is quite a science. 

Today an artist can purchase tubes of pig-
ment in a huge range of standard colors but 
even so, artists will always mix colors to 
create new ones. 

With the electronic age we are now capable 
of showing color on television and com-

The Color palette is divided into two parts: 
the Color Picker pane and the Color Table 
pane. The Color Picker pane enables you to 
edit the color currently selected in the 
Paint Style palette. The Color Table pane 
enables you to replace the currently 
selected color with a color from a library of 
colors.  

Color Table

Click to 
expand palette

Toggle
clickin
the Co
from th
less of
you ha

The Co
no bor
For mo
prefere
in Cha

Color
The bo
rently 
editing a Skeletal Stroke, two rectan-
pear at the bottom of the Color pal-

dicating the primary and secondary 
 that are currently selected. The left-
ectangle, which is in front represents 
mary color. The right-hand rectan-
the back represents the secondary 
A bar indicates which of the two 
watches is currently active. Click a 
 to make it active. A secondary color 

uently used in a Natural-Media 
. 

editing a Fixed Width stroke, only 
ctangle appears at the bottom of the 
alette. 
puter screens (CRTs or Cathode Ray 
Tubes), without applying pigment to can-
vas or paper. The media (paint, crayon, 
computer screen, etc.) determine which 
colors can be created. In the real world 
there are far more colors than we can faith-
fully reproduce with paint pigment or on a 
Cathode Ray Tube.

The Color palette.

Color Selection

Attribute buttons

Current Color

When 
gles ap
ette in
colors
hand r
the pri
gle, in 
color. 
color s
swatch
is freq
stroke

When 
one re
Color p
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t color using the HSL model:

   

Color palette

 

 is not displayed, 
e 

 

Window menu> Color

 

. The 
 palette appears.

  

the 

 

HSL

 

 tab in the Color palette to 
y the HSL color selections. 

     

Value Picker

Color Wheel

HSL Value 
Picker pop-up
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Current Color
Below the current color swatches is the 
name of the current color. The name will be 
the RGB or CMYK color model numbers, or 
the name you have assigned to a custom 
color. For information on color models, see 
the next section ➤“Using Color Models.” 
For information on creating a custom color, 
see ➤“Creating Custom Colors,” later in 
this chapter.

Color palette color selection rectangles.

Using Color Models

You can select colors in Expression visu-
ally by picking them from Expression’s 
Color palette. You can choose a color from 
the palette color table, from one of the 
three available HSL color pickers, or enter 
a specific RGB, or CMYK color value. Inter-
nally, Expression saves the color informa-
tion as CMYK or RGB information, 
depending on how the color was selected. 

Depending on the use or your final image, 
electronic or paper, determine which color 
model is appropriate for your project. As a 
rule of thumb, electronic images are best in 

To selec

1If the 
choos
Color

2Click 
displa
the Color Wheel to select a basic 
g hue. The Color Wheel can be 
r draggable. For more information, 

e next procedure.

 an HSL Value Picker from the pop-

r palette, HSL tab.

Fill Gradient
Attribute Buttons
Click one of the three buttons to choose 
which attribute to edit: Stroke Color, Fill 
Color or Gradient Color. For more informa-
tion on applying attributes to strokes and 
fills, see ➤Chapter 5, “Applying Strokes and 
Fills.”

Click Stroke Color to edit the color of 
the current stroke.

Click Fill Color to edit the color of 
the current fill.

Click Gradient to open the Gradient 
palette, then select the gradient you 
wish to edit. For more information on 

RGB, and printed images are most com-
monly created in CMYK.

Specifying HSL Colors
HSL defines shades using Hue, Saturation 
and Lightness. This color model describes 
the way artists generally think about color. 

Hue The color from the color spectrum, 
i.e., red.

Saturation The purity of the color. Gray 
has a saturation of 0% while pure red has a 
saturation of 100%. A low saturation of red 
creates a muddy red.

Lightness The light value in the color. 
100% lightness of any color gives white and 

3Click 
startin
fixed o
see th

4Select

The Colo

Stroke
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nu directly above the HSL color 
. The Value Picker displays all the 

ble colors within a predominant 
applying gradients, see ➤“Using Gra-
dients,” later in this chapter.

0% gives black. Pink has more light than a 
deep red.

up me
values
availa



   

hue. The Value Picker is represented as a 

                     

Understanding the Color Palette HSL 
 Picker

 

L Value Picker comes in three differ-
pes: triangle (the default), diamond, 

uare. The Picker's behavior is similar 
f its three shapes, so you can choose 
e which best suits your tastes. The 
nces between them are described 

ose the shape of the HSL Value 
, use the pull-down menu to the right 
color wheel, above the Hue, Satura-
nd Lightness fields. This pull-down 
ontains four icons. The first three 
epresent the three available shapes 
 Value Picker. The fourth icon (at the 
 of the menu) represents a special 
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triangle, diamond or square. Use the 
method that works best for you. For 
more information on Value pickers, see 
the following section, ➤“Understanding 
the Color Palette HSL Value Picker.” 

To select fixed or draggable Color Wheel: 

1Choose File menu> Preferences. 

2Click the View and palettes tab. 

The Preferences dialog, View and palettes 

Value

The HS
ent sha
and sq
in all o
the on
differe
below.

To cho
Picker
of the 
tion, a
menu c
icons r
for the
bottom
 mode which allows you to see 
er the current color falls within the 
le gamut. For more information, see 

cking the Gamut,” later in this chap-
5Click in the Value Picker to select a color. 
Dragging left or right controls saturation. 
Dragging up or down controls lightness.

HSL value pickers and the gamut display.
3Select or deselect Draggable Color 

Wheel. 

When this option is enabled, drag to 
rotate the Color Wheel until the desired 
hue is at the right tip of the triangle.

tab.

Drag to rotate the Color Wheel.

display
wheth
printab
➤“Che
ter.
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When this option is disabled, click on the 
color in the Color palette to select it.



             

ft half is a triangle pointing to the 
lementary (opposite) color and 
ons as a mirror image; dragging 
elects a muddier or grayer 
tion while dragging left selects a 

 hue. 

  

r drag the small crosshair to select 
lue you want. 

  

urrent selection is shown in the 
h at the bottom of the palette.

 

g the Gamut

 

th icon on the Value Picker pull-
enu selects the printable gamut dis-
de. This mode allows you to see 
 the current color falls within the 
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The Triangle Value Picker

The Triangle Value Picker displays all the 

HSL Value Pickers and gamut display.

Triangle

Diamond
Square

Gamut

Click or drag the small crosshair to select 
the value you want. The current selection is 
shown in the swatch at the bottom of the 
palette. 

• The le
comp
functi
right s
satura
purer

• Click o
the va

• The c
swatc

Checkin

The four
down m
play mo
whether
e gamut. When you choose the 
e gamut mode, the HSL Value 
 temporarily replaced with a dis-

ich shows the current color in rela-
he printable gamut.

u have checked the printable 
isplay, click anywhere within the 
to restore the HSL Value Picker.

table gamut display shows the 
lice corresponding to the intensity 
ess) of the current color being 
he shape of the gamut depends on 

ent color calibration settings, 
re specified in the Color Match tab 
eferences dialog. For more infor-
n the Color Match tab, see ➤“Set-
colors in a particular hue. The colors are 
organized in increasing saturation from left 
to right and in increasing lightness from 
bottom to top. The left edge of the triangle 
represents a 0% saturation and is therefore 
a neutral gray axis making the triangle 
Value Picker convenient for choosing neu-
tral grays. 

Dragging all the way to the right gives the 
purest color of the predominant hue. Drag-
ging to the left gives muddier or grayer col-
ors. Values span the triangle from top to 
bottom, with the top of the triangle being 
the highest value (white), the bottom the 
lowest value (black). 

The Diamond and Square Value Pickers

The Diamond and Square Value Pickers dis-
play all the colors in a particular hue as 
well as the complementary hue and all its 
colors. (The complementary hue is the one 
directly opposite the selected hue on the 
color wheel.) Think of the square and dia-
mond as two triangle Value Pickers, back to 
back. These two modes display a richer 
range of colors to choose from and are par-
ticularly useful for color design purposes 
where complementary color schemes are 
often used. The diamond and square Value 
Pickers behave the same; the square is just 
larger.

Color palette, triangle Value Picker. 
printabl
printabl
Picker is
play wh
tion to t

After yo
gamut d
display 

The prin
gamut s
(brightn
edited. T
the curr
which a
in the Pr
mation o
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r Calibration,” later in this 
.
• The right half of the diamond or square is 

the same as the triangle described above. 

ting Colo
chapter



   

The current color is represented as a small 

              

2

 

Click the 

 

RGB

 

 tab in the Color palette. 

  

st the three sliders to select a color 
ter specific numbers for each value. 

 can set specific values for red, green 
blue.

     

lor palette, RGB tab.

Sliders

Color values

Click to expand 
the palette
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circle on the display. If the circle is within 
the gamut, the color is printable; otherwise 
the output might not be what you would 
expect. The gamut display is not for picking 
colors. It is mainly for displaying how far 
off your chosen color is from the printable 
gamut. Since the gamut display only shows 
the gamut slice with the same intensity as 
the current color, it is possible that the 
gamut slice vanishes completely if the cur-
rent color is brighter than the brightest 
printable color.

Circle

Specifying RGB Colors
This model is based on how colored light is 
generated on a television or computer 
monitor screen. All colors are defined using 

A clipped color ring appears around colors 
outside the gamut.

Clipped color 
ring

3Adju
or en
You
and 

The Co
fying CMYK Colors
YK color model is used by printers 

rvice bureaus. CMYK is based on the 
s colors: cyan (C), magenta (M), yel-
), black (K) used in four color print-
is model is used for most printed 
als such as magazines, books and 
res. All shades are defined using 

nations of cyan, magenta, yellow and 

ind of ink absorbs different amounts 
 of different wavelengths, producing 
nt colors. A color model based on a 
e of inks is a subtractive color model.
Not all colors visible on the computer 
screen can be successfully reproduced 
when printing on paper. When you select a 
hue that is outside the gamut of printable 
colors, a clipped color ring appears around 
the selected color in the selection swatch 
at the bottom of the palette.

If a small circle does not appear in the 
gamut, the selected color may not come out 
as expected. 

combinations of red, green and blue phos-
phors. 

With all three kinds of phosphors emitting 
light at full intensity, a white color is per-
ceived. If no light is emitted, darkness or 
black is perceived. Because lights are 
added together to produce the effect of a 
particular color, RGB is considered to be an 
additive color model.

To select color using the RGB model:

1If the Color palette is not displayed, 
choose Window menu> Color. The 
Color palette appears.

Speci
The CM
and se
proces
low (Y
ing. Th
materi
brochu
combi
black.

Each k
of light
differe
mixtur
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 or define a color in the Color 
e. The color you created appears in 
lor selection rectangle at the 

m of the palette.

  

hold on the color selection 
gle at the bottom of the palette. 

olor Dropper cursor fills, indicating 
lor has been copied. 
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To select color using the CMYK model:

1If the Color palette is not displayed, 
choose Window menu> Color. The 
Color palette appears.

2Click the CMYK tab in the Color palette. 

Sliders

Color values

Building Your Own Color 
Tables

Custom color tables are used to organize 
groups of colors. You can customize your 
table to control the colors in particular 
projects or create groups of your favorite 
colors. You might name your color tables 
according to use or color family. Use the 
slider at the right of the Color table to 
scroll through the entire table.

CAUTION: Changes to the Color Table can not be 

3Select
palett
the co
botto

4Click-
rectan
The C
the co
 color selection rectangle to copy the 
3Adjust the four sliders to select a color 
or enter specific numbers for each value. 
You can set specific values for cyan, 
magenta, yellow and black.

The Color palette, CMYK tab.

undone.

To edit a color table:

1If the Color palette is not displayed, 
choose Window menu> Color. The 
Color palette appears.

2Display the color model tab in which you 
want to create the color. For more 
information on color models, see 
➤“Using Color Models,” earlier in this 
chapter.

Click the
color.
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5

 

Drag the cursor into the color table and 

                  

e color table:

  

ose 

 

File menu> Color Table> 

 

. You can also click-hold the pop-up 
u next to the Color Table and choose 

 

 Color Table

 

. 
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release the mouse over the swatch you 
want to replace. To load color table (replacing current):

1Choose File menu> Color Table> 
Load. You can also click-hold the drop 
down menu next to the Color Table and 
choose Load Color Table. 

To sav

1Cho
Save

men
Save
gn the color palette a name and 
tion.

 OK.

old to display the menu.
6Repeat all steps as many times as 
necessary. Once you have changed the 
table, it can be saved and opened as 
needed. See the following procedures.

Drop the color into the Color Table.

2Locate the color palette file and select it.

3Click OK.

Click-hold to display the menu.

2Assi
loca

3Click

Click-h
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 Custom Colors

ion also provides support for cus-
ot) colors. A custom color is a par-
olor to which you assign a name. In 
ion, custom colors are always con-
ternally to CMYK values and saved 

 

fined, a custom color can be saved 
lied to any number of objects 
our document. Each instance main-
eference to the custom color’s defi-
his makes it easy to use consistent 
n multiple objects and to make glo-
r changes. It also allows you to take 
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To sort the color table:

1Choose File menu> Color Table> 
Sort. Expression organizes the colors. 
You can also click-hold the pop-up menu 
next to the Color Table and choose Sort 
Color Table. 

Blending Color Table Colors
Expression can automatically generate 
color in the color table by interpolating 
(blending two existing colors).

CAUTION: Changes to the Color Table can not be 
undone.

To generate colors by interpolation:

1Drop a color into a swatch in the Color 

Using

Express
tom (sp
ticular c
Express
verted in
as such.

Once de
and app
within y
tains a r
nition. T
colors o
bal colo
ge of compatible software applica-
ich perform spot color separa-

ion also includes a large number of 
ed custom colors, named intu-
nd ready for your use (navy blue, 
ick, tomato, etc.).

rs which appear under the System 
e Custom Color palette, are from a 
n developed for the X Window Sys-
 the X Consortium.
Click-hold to display the menu

palette Color Table.

2Drop a second color into another swatch 
at any point in the Color Table. The 
number of swatches between the two 
colors determines how many 
intermediate colors are generated.

3Select the first of the two colors you 
copied to the Color Table.

4Hold down the Shift key. The cursor 
changes to a flag.

5Click the second color. The swatches 
between the two colors are filled with 
the blended colors, replacing colors 
previously in the Color Table.

advanta
tions wh
tions. 

Express
predefin
itively a
rose, br

The colo
tab in th
collectio
tem™ by
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Creating Custom Colors

e the name for the new custom color.

e color into the Custom Color palette.
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You can also name specific custom colors 
so you can use them on different objects. 
Editing a custom color edits all objects 
using that color.

To select a custom color: 

1If the Custom Color palette is not 
displayed, choose Window menu> 

Custom Color. The Custom Color 
palette appears. 

To define a new Custom color: 

1Select or create a new color in the Color 
palette. The new color appears in the 
color selection rectangle at the bottom 
of the Color palette. 

For information on creating a color in the 
Color palette, see ➤“Specifying HSL Col-
ors,” ➤“Specifying RGB Colors” and 
➤“Specifying CMYK Colors,” earlier in 
this chapter.

2Click-hold on the color selection 
rectangle at the bottom of the palette. 
The Color Dropper cursor fills, indicating 
the color has been copied. 4Typ

Drop th
s Return/Enter. The new name 
ars next to the color in the list box.

he custom color name.
2Click on a custom color name in the 
Custom Color list. The custom color 
becomes the currently selected color in 
the Color palette.

The Custom Color palette.

3Drag the cursor into the Custom Color 
palette’s color selection rectangle (at the 
bottom of the palette) and release the 

Click the color selection rectangle to copy the 
color.

5Pres
appe

Enter t
86 Fractal Design Expression User Guide

mouse.



hold on the color you want to copy. 
olor may be from an object or from 
lor Table. The Color Dropper 

r fills, indicating the color has been 
d. 

 a color using the Color Dropper tool.
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To delete a custom color: 

1Select the custom color from the Custom 
Color palette.

2Click Del. The selected color is removed 
from the Custom Color palette.

CAUTION: Deleting a custom color cannot be 
undone.

Copying Attributes From 
One Object to Another

Expression has two tools which allow you 
to copy color and stroke attributes and 
apply them to other objects with a couple 
clicks of the mouse. The Color Dropper 
tool picks up color from one object, or area 
of an object, so you can drop the color onto 
another object or area. The Attributes 
Dropper tool copies the stroke and fill 
attributes from one object to another.

Copying Colors
In addition to choosing colors from the 

2Click-
The c
the Co
curso
copie

Copying
o the object or area you want to 
then release the mouse button. The 
ow displays the new color. 

g in the new color.
Controlling Custom Color Tint
The tint control slider lets you specify a 
tint of the selected custom color. The set-
ting on the tint control slider does not 
change the definition of the custom color; it 
only affects the instance of the color 
applied to the current selection. Changes in 
tint are displayed in the Paint Style palette 
Color swatch and the Value Picker.

Color palette you can use the Color Drop-
per to pick up a color from an object and 
drop it onto another object.

To copy color from one area to another:

1Click the Dropper Tools icon in the Tools 
toolbar and choose the Color Dropper 
tool. The cursor changes to an eye 
dropper. 

The Color Dropper tool.

3Drag t
color 
area n

Droppin
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Copying Attributes 3Drag to the object to which you wish to Using Gradients

sion gives you complete control 
radients. You can select the direc-
pe of blend, colors used in the blend 

e rate of change. 

ying Gradients
int Style palette allows you to select 

ient scheme and apply it to a 
d object or path.

ct and apply a gradient stroke or 

Ch04.FM5  Page 88  Friday, November 8, 1996  10:54 AM
The Attribute Dropper tool allows you to 
copy one object’s paint attributes, (stroke, 
fill, and colorize settings) to another 
object. All paint attributes are copied, 
including stroke type, fill type, color, width, 
shear angle, etc.

To copy stroke and fill attributes from 
one object to another:

1Click the Dropper Tools icon in the Tools 
toolbar and choose the Attribute 
Dropper tool. The cursor changes to an 
eye dropper with an asterisk (*). 

apply the stroke and fill attributes, then 
release the mouse button. The object 
now displays the new stroke and fill. 

Release the mouse button to drop the 
attributes.

Expres
over g
tion, ty
and th

Appl
The Pa
a grad
selecte

To sele
fill:
g the Object Selection tool from the 
s toolbar, select an object or path.

e Paint Style palette is not displayed, 
se Window menu> Paint Style. 
Paint Style palette appears.

 the Stroke or Fill tab in the Paint 
 palette. If you want to apply the 
ient to a stroke, click the Stroke tab. 
u want to apply the gradient to an 
ct fill, click the Fill tab.

 the Gradient icon. The palette 
ges to reflect gradient related 
ces.
2Click-hold on the object whose attributes 
you want to acquire. The Attribute 
Dropper cursor fills, indicating the 
attributes have been copied.

The Attribute Dropper tool.

1Usin
Tool

2If th
choo
The 

3Click
Style
grad
If yo
obje

4Click
chan
choi
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Click-hold to copy attributes.



 start or end your drag away from 
ge, the first or last color in the gra-
is used to start or complete the gra-
. 

ng Gradient Color 
es

m the middle of the object to have a 
nd of beginning color.
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5Select a gradient scheme from the 
scrolling list. You also can create new 

The Paint Style palette, Gradient Stroke tab. 

Gradient icon

2Choose the Gradient tool from the Tools 
toolbar. 

3Drag across an object to set the gradient 
direction. 

When you start and end your drag very 
near opposite edges of the object, the 
gradient changes equally across the 
entire object. 

The Gradient tool. 

If you
an ed
dient 
dation

Creati
Schem

Drag fro
larger ba
ion includes a selection of default 
s which are ready to use. You can 
 these gradients or design your 

: Gradients are stored globally by 
ication. This means that editing a 
 affects all objects which use the 
adient pattern. If you want to edit a 
 on a particular object without 
 other objects, create a new 
 and apply it to the object, then 
new gradient.
gradients. For more information on 
creating gradients schemes, see the next 
section, ➤“Creating Gradient Color 
Schemes.”

Controlling Gradients
The Gradient tool is used to control the 
direction and rate of change for a gradient 
stroke or fill within an object.

To apply a default gradient:

1Using the Object Selection tool from the 
Tools toolbar, select an object to which a 
gradient stroke or fill has been applied.

Drag from the edge to control the rate of 
change.

Express
gradient
also edit
own.

; Note
the appl
gradient
same gr
gradient
affecting
gradient
edit the 
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ct or define a color from within the 
r palette. The color appears in the 
r selection rectangle at the bottom 
e Color palette as well as at the start 
e Gradient sample bar. 

 the next triangle arrow under the 

the Start Gradient icon.

Gradient 
Sample Bar
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To create a new gradient:

1If the Gradient Editor palette is not 
displayed, choose Window menu> 

Gradient Editor. The Gradient Editor 
palette appears.

The Gradient Editor palette.

3Enter a name for the new gradient, then 
click OK. The new gradient is added to 
the Gradient list. The initial settings for 
the new gradient are duplicated from the 
previously selected gradient.

4Edit the new gradient as described 
below.

The New Gradient dialog.

4Sele
Colo
colo
of th
of th

5Click

Select 
ient bar to select it.

ct or define a color from within the 
r palette. The Gradient bar changes 

isplay your choice.

tinue to edit the triangles to define 
r colors as needed.

 the triangles to adjust the spacing 
e colors. You can also use the input 
at the lower right corner of the 
ient palette to precisely set the 

tion of the selected triangle. Enter a 
ber or use the up/down arrows, then 
s Tab or Return/Enter.
2Click the New button below the Gradient 
list. The New Gradient dialog appears.

You can also create a new gradient directly from the 
Paint Style palette by choosing Gradient from the 
Paint Style palette’s Stroke or Fill tab and clicking 
the New button below the Gradient list. When you 
do so, the New Gradient dialog appears, and the 
Gradient Editor is automatically opened.

To edit a gradient:

1If the Gradient Editor palette is not 
displayed, choose Window menu> 

Gradient Editor. The Gradient Editor 
palette appears.

2Scroll through the list of gradients to 
select the one you wish to edit.

3If it is not already selected (filled) click 
the left triangle under the Gradient 
sample bar.

Grad

6Sele
Colo
to d

7Con
othe

8Drag
of th
box 
Grad
posi
num
pres
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lso delete a gradient directly from the 
 Palette by choosing Gradient from the 
 palette’s Stroke or Fill tab, selecting the 
ou want to delete, and clicking the Delete 
low the Gradient list.
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9If you want additional colors, click 
directly below the Gradient bar to add 
additional triangles. Apply colors to the 
new triangles as needed. 

ºTo remove a color from a gradient, 
simply drag its triangle down away from 
the Gradient bar.

¡Drag the diamond indicators above the 
Gradient bar to control the rate of color 
change between two colors between two 
adjacent colors.

™Select the type of gradient by clicking on 
the Gradient Type button to the right of 
the Gradient bar. You can choose from a 

£Click Apply.

To delete a gradient:

Radial gradient.

You can a
Paint Style
Paint Style
gradient y
button be
linear or radial gradient.

Linear gradient.

1If the Gradient Editor palette is not 
displayed, choose Window menu> 

Gradient Editor. The Gradient Editor 
palette appears.

2Scroll through the list of gradients to 
select the one you wish to delete.

3Click the Delete button. The gradient is 
deleted.
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Colorizing Objects The colors retain the value (light/dark) of little contrast, say black and forest green, 
 very little difference between the 
und and background color.

you have a fully colored Skeletal 
 and use foreground/background 
o colorize the stroke, the intensity 
tness) of the colors are taken to get 
 between the foreground and back-
 colors. The original hue of the col-
gnored; only the intensity value is 

ost intense (lightest) areas receive 
ckground color. The least intense 
st) areas receive the foreground 
All areas with intensity between the 
tense and least intense areas are 

ed colors between the foreground 
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Expression provides several ways of con-
trolling the colors used in your strokes. 
These colors are based on grayscale val-
ues. Any changes made affect all selected 
objects and any new path you draw while 
the same Skeletal Stroke is selected.

Why Colorize?
• To shift the color range of a portion or the 

entire picture as a whole without 
modifying the individual colors of the 
objects.

• To tint black and white objects such as 

the original but now reflect a different color 
scheme. Colorize each fish in your school 
to quickly create a school of related but dif-
ferent instances. 

How to Colorize
Expression offers two methods of coloriz-
ing: 

• Foreground/Background which applies to 
Skeletal Strokes only.

• Three Primaries plus Background which 
applies to any object.

Foreground/Background Mode
When working with a Skeletal Stroke that 

shows
foregro

When 
Stroke
mode t
(or ligh
a color
ground
ors is i
used. 

The m
the ba
(darke
color. 
most in
assign
ckground based on their relation-
 the two extremes. 

ly color using the Foreground/
round mode:

g the Object Selection tool from the 
s toolbar, select the object to be 
rized. 

e Paint Style palette is not displayed, 
se Window menu> Paint Style. 
Paint Style palette appears.

 the Colorize tab. The palette 
ges to reflect the Colorize options.
clip art.

• To swap the primary color channels to 
create a different impression.

• To control the color scheme of a multi-
colored Skeletal Stroke.

Experiment with the Paint Style palette’s 
Colorize tab. Use it to change the mood of 
your artwork, to change individual 
instances of a stroke or to restrict your 
color to a specific range.

For example, you want to create an image 
with a school of fish. The individual fish is 
created using three or four colors. Make 
the fish into a Multi-view stroke so each 
instance may be a slightly different view. 

includes two colors, such as a Natural-
Media brush stroke, control the colors 
using the Foreground/Background Mode. 

The foreground and background colors for 
Skeletal Strokes are applied based on value. 
Black areas are replaced by the foreground 
color while white areas are replaced by the 
background color. Gray areas (between 
black and white) are replaced by appropri-
ate hues based on the balance of black and 
white. 

In strokes with only black and white you 
see only the foreground and background 
color. In strokes with grays you see 
color(s) assigned to the particular gray-
scale value. A stroke with two colors, but 

and ba
ship to

To app
Backg

1Usin
Tool
colo

2If th
choo
The 

3Click
chan
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Then, select one copy and adjust the Col-
orize tab to give it a distinct set of colors. 



aries in the Additive color model is 
ging the colors of the light emitted 

omputer screen (or changing the 
the phosphors used in the CRT).

ost artists find the concept of sub-
 inks simpler than the concept of 
the CRT, this manual explains the 
 color substitution process in 
 the Subtractive model. The inter-
ks identically for the Additive 
nly the actual primary colors are 
.

ed Color Substitution

on to altering colors on an object 
ging the colors used for the prima-
 can alter the color by changing 
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4Click on the Fg/Bg Mode button. Two 
squares, appear in the palette, 
representing the foreground color 
(upper left) and the background color 
(lower right). 

Note: Colorizing a Skeletal Stroke using the 
Colorize tab has exactly the same effect as 
editing the Stroke’s primary and secondary 
colors in the Color palette.

Primary Colors Substitution 
Mode
The Foreground/Background mode is ideal 
for colorizing grayscale strokes. Since most 
of Expression's Natural-Media Strokes are 
designed in grayscale, this mode is very 
useful. However, it does not work as well 
for colorizing multi-colored strokes, since it 
replaces all of the original colors with just 
two. 

To alter the colors of multi-colored strokes, 
you can use the Primary Colors Substitu-

the prim
like chan
by the c
color of 

Since m
stituting
altering 
primary
terms of
face wor
model; o
different

Combin

In additi
by chan
ries, you
r of the intersection of the three 
 color circles. This way you change 
le color spectrum toward the new 
u have introduced. When you 
he intersection of the three circles 

ion actually changes the three pri-
lors to primaries that create that 

: The combined color represents 
imum intensity color possible with 
 primaries when the additive 
is chosen; or the minimum 
 color possible when the 
ive model is chosen. Therefore 

g black as the combined color 
e additive model would give three 
5If the Color palette is not displayed, 
choose Window menu> Color. The 
Color palette appears.

6Click within the Foreground swatch and 
select or define a color from the Color 
palette. The color is applied to the 
Foreground swatch.

7Apply a color to the background swatch 
the same way.

Paint Style palette, Colorize tab, Foreground/
Background mode.

tion mode. By allowing you to substitute 
different colors for the standard primaries, 
this mode enables you to apply subtle or 
dramatic color shifts to one or more 
objects in your illustration.

The Primary Colors Substitution mode 
allows you to selectively substitute the pri-
mary colors in a Stroke's color model to 
alter the appearance of the colors in the 
Stroke. You can work in the Subtractive 
color model (the default) where the prima-
ries are Cyan, Magenta and Yellow, or the 
Additive color model, where the primaries 
are Red, Green and Blue.

Substituting the primaries in the Subtrac-

the colo
primary
the who
color yo
change t
Express
mary co
color.

; Note
the max
the new
models 
intensity
subtract
selectin
under th
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s primaries, turning every color 
 such substitution. Similarly, 
8Click Apply. The new colors are applied 
to the selected object.

tive color model is like substituting differ-
ent colored inks for Cyan, Magenta, and 
Yellow in the printing process. Substituting 

blacks a
black on



selecting white as the combined color 3Click the Colorize tab. The palette 6Click to select one of the primary color 
es or the intersection of all three 
es, then select or define a color from 
in the Color palette. The color 
ars in the selected area.

ly a color to the other primary color 
ches the same way.

 Apply. The new colors are applied 
e selected object.

ving Colorization
ecide later on that you want a col-

 object to revert to its original colors, 
n reset the colorization option.
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under the subtractive model would give 
three whites as primaries, turning every 
color white.

Background Color Substitution

The background color, represented by a 
square in the Colorize tab affects how color 
is seen. It is equivalent to changing the 
color of the paper the object is printed on, 
except each object in your image could 
have a different background color. Chang-
ing the background color does not change 
the primary colors but does change the 
appearance of the object.

changes to reflect the Colorize options.

4Click on the Additive Model or 
Subtractive Model button. Three 
overlapping circles and a square appear 
in the palette. The circles display the 
primary ink colors. The square 
represents the background upon which 
the inks are placed.

circl
circl
with
appe

7App
swat

8Click
to th

Remo
If you d
orized
you ca
et the color:

g the Object Selection tool from the 
s toolbar, select the colorized 
ct. 

e Paint Style palette is not displayed, 
se Window menu> Paint Style. 
Paint Style palette appears.

 the Reset Color button. This button 
ly available if colorization has been 
ied to the selected object. The 
inal color is restored to the selected 
ct.
For a real-world example of colorizing objects with 
the primary substitution method, see the 
Expression Creative Techniques guide.

To apply color using the subtractive 
color model: 

1Using the Object Selection tool from the 
Tools toolbar, select the object to be 
colorized. This mode only works for 
Skeletal Strokes.

2If the Paint Style palette is not displayed, 

Changing one of the color circles repre-
sents changing an ink color. The stan-
dard inks, Cyan, Magenta and Yellow can 
be substituted with any other color to 
change the overall color scheme.

5If the Color palette is not displayed, 
choose Window menu> Color. The 

Paint Style palette, Colorize tab, Additive 
model.

To res

1Usin
Tool
obje

2If th
choo
The 

3Click
is on
appl
orig
obje
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choose Window menu> Paint Style. 
The Paint Style palette appears.

Color palette appears.



g Color Calibration

hat display on the computer screen 
 be approximated by printed color 
-versa. To get your printed output 
 as possible to the colors you see 
n you must calibrate your monitor. 
e using a color printer use Expres-
lor Match feature to calibrate your 

 to your printer.

puter uses a mix of three basic col-
 green and blue, to generate the full 
 colors displayed on your monitor. 
, however, use a mixture of four 
 colors, cyan, magenta, yellow and 
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Setting Colorize 
Preferences

Replacing colors with the Color Dropper 
tool is normally a straightforward pro-
cess—the color you pick up is simply 
dropped wherever you release the mouse. 
However, when you try to replace one of 
the colors in a Stroke which has previously 
been colorized, the process is sophisti-
cated. 

Expression cannot simply drop the color 
into the Stroke because the color you are 
dropping may not even exist within the 

To change the colorize preferences:

1Choose File menu> Preferences. The 
Preferences dialog appears.

2In the Options tab, select or de-select the 
Color Dropper: resets primaries 
checkbox.

3Click OK.

Settin

Colors t
can only
and vice
as close
on scree
If you ar
sion’s Co
monitor

The com
ors, red,
range of
Printers
basic ink
 create a similar range of colors. 
 these two methods are fundamen-
erent a perfect match between 
u see on screen and what you see 
is often impossible. 

librating your system with Expres-
olor Match feature to match the set-
 have in Fractal Design Painter, 
lustrator, Adobe Photoshop or 
AW!, you can print your Expression 
 from one of those applications and 
ed that the color will still print out 
s possible.

e, the best color matching can be 
 on 24-bit monitors which can dis-
Stroke's substituted color model.

Instead, Expression must do one of two 
things. By default, Expression resets the 
colors of the Stroke before dropping the 
new color in. This ensures that the color 
you pick up and drop with the Color Drop-
per is the color you actually see in your 
document. However, resetting the colors 
often drastically alters the appearance of 
the rest of the Stroke. 

If you prefer, Expression can instead leave 
the Stroke's substituted colors intact. In 
this case, however, the color you drop is 
not the color you see in your document—it 
is colorized along with the rest of the 
Stroke.

black, to
Because
tally diff
what yo
printed 

After ca
sion’s C
ting you
Adobe Il
CorelDR
artwork
be assur
as true a

Of cours
achieved
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lions of colors. Anything less than 
eans the colors will need to be dith-
approximated. A 24-bit monitor 
play mil
24-bit m
ered or 



offers you the largest number of colors to 2Click the Color match tab. The dialog paper. This will compensate for the color 
ur paper and better match the 

rs you see on your screen.

 OK. 

eturn the Color Match settings to the 
ult setting click the Reset to Default 
on. To return to the last settings, 
r to recent changes, click the Reset 
st button.
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choose from. 8-bit or 16-bit color monitors 
can not give you as large a selection of col-
ors.

The first step in color calibration is to 
acquire a printed sample of the standard 
color combinations, known as a progressive 
color bar. If you are taking your color image 
to a service bureau for output, the service 
bureau should supply you with this tool. If 
you have a color printer in your office you 
should use the progressive color bar sup-
plied with the printer. The progressive 
color bar contains color swatches of the 
following colors:

cyan, magenta, yellow, magenta/yellow, 
cyan/ yellow, cyan/magenta, cyan/

displays the color match selections. 

3In the gamma field, enter the same target 
gamma setting you used in Fractal 
Design Painter, Adobe Photoshop, Adobe 

The Preferences dialog, Color match tab.

of yo
colo

6Click

To r
defa
butt
prio
to la
magenta/yellow, white and black. 

To calibrate your color monitor:

1Choose File menu> Preferences. The 
Preferences dialog appears.

Illustrator or CorelDRAW! to calibrate 
your monitor in that application. 

If you have not calibrated your monitor 
in one of those applications, leave the 
gamma setting at the default 1.8. If you 
are using a third party monitor calibra-
tion utility, type in your gamma setting 
from that application.

4Hold the color printer’s progressive 
color bar up to the monitor and adjust 
the RGB sliders to match the screen 
colors as closely as possible to the 
printed colors.

5If you are using a paper color other than 
96 Fractal Design Expression User Guide

white, set the color patch labeled 
“White” to match the color of your 
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97

 

5

 

Applying Strokes 
and Fills

 

While a path is the basic 
component in Expression, the 
magic of Expression is how you 
paint the path. The appearance of 
an object depends on three 
parameters: the path, the stroke 
and the fill. 

 

➤

 

Chapter 3, “Creating 
Paths,” describes how to create a 
path. This chapter explains 
Expression’s stroke and fill 
techniques, which bring character 

 

to your path.
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Applying Paint: The Paint 

      

When no object is selected the Paint Style 

  

The preview windows near the bottom of 
lette display the selected stroke on 

t and the selected fill on the right. 

 

 Apply and Auto Apply

 

n set Expression to automatically 
ny attributes selected in the Paint 
alette by selecting the 

 

Auto

 

 box in 
er left of the Paint Style palette. 

               

tyle palette color preview windows.

Stroke

FIll
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Style Palette

You paint a path by specifying two main 
attributes: stroke and fill. The stroke you 
set determines the appearance of an 
object’s path(s). The fill you select deter-
mines the appearance of the area enclosed 
by the path(s). You control these attributes 
by using the Paint Style palette. 

palette displays the current attributes. 
These are the attributes applied to the last 
selected object or attributes to be applied 
to the next object created.

When a single item is selected, the Paint 
Style palette displays that object’s 
attributes. When multiple objects are 
selected the Paint Style palette displays 
those attributes which are common to all 
selected objects. If a particular attribute 
differs between the selected objects, that 
field is blank or displays a special item (i.e., 
a question mark) to indicate there is a dif-
ference. 

this pa
the lef

Using
You ca
apply a
Style p
the low

Paint S
Auto is selected, all changes made 
omatically applied to the selected 
). Otherwise, after making changes in 
int Style palette, click the Apply but-
apply the changes to your path(s). 

e: For the purposes of this manual, 
ume Auto is not selected.

rolling Opacity/
parency
y refers to the ability of material to 
ight, which is the inverse of trans-
y. Drag the Opacity slider near the 
 of the Paint Style palette to change 

acity of the selected object(s). 
The Paint Style palette.

Paint Style palette when two or more objects 

When 
are aut
path(s
the Pa
ton to 

; Not
we ass

Cont
Trans
Opacit
block l
parenc
bottom
the op
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are selected with different attributes.



                          

o stroke is displayed so there are 
ific parameters.

  

ath is drawn with a solid color.

 

t

 

Path is drawn with color chang-
ually from a starting color to an 
olor.

 

 Stroke

 

Path is drawn with the 
Stroke chosen from the 

 

Stroke 
use

 

 palette.

 

ing No Stroke

  

one

 

 is selected as your stroke from 
t Style palette, no stroke is dis-
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With Opacity set to 100%, your object is 
opaque and you can not see through it. Set 
Opacity to 0% to make the object com-
pletely transparent and invisible.

; Note: Since many file formats do not 
support Opacity, you need to consider 
your output plans when using this feature. 
For more information on printing, see 
➤Chapter 7, “Printing.”

Using the Paint Style Palette 
Tabs
Use the tabs at the top of the Paint Style 
palette to activate the controls for the 
attribute you wish to edit. To select Stroke, 
Fill or Colorize, click the appropriate tab. 

Changing Stroke 
Attributes

Expression allows you to choose from sev-
eral types of strokes: None, Basic, Gradient 
or Skeletal. Each stroke type has attributes 
specific to that type. The information 
within the tab changes to reflect the type of 
stroke selected. Click to select the type of 
stroke you want to apply. 

None Basic Gradient
Skeletal 
Stroke

None N
no spec

Basic P

Gradien
ing grad
ending c

Skeletal
Skeletal 
Wareho

Apply

When N
the Pain
n the selected object. If you set 
oke and fill to None, no image dis-
ith stroke set to None and Fill set 
, Gradient or Pattern you see the 
 pattern with no outline. 

s of objects with a fill, but no stroke.
For information on using the Colorize tab, 
see ➤“Colorizing Objects” in Chapter 4, 
“Using Color.” 

Stroke tab Fill tab

The Paint Style palette, Stroke tab.

played o
both str
plays. W
to Color
color or

Example
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The Paint Style palette, Stroke and Fill tabs.



   

Applying Basic strokes  

                           

5

 

If the 

 

Color 

 

palette is not displayed, 

              

Changing the stroke Width

 

sion allows you to set the width (in 
) of any Basic, Gradient or Skeletal 
.

 

nge the width of a stroke:

  

g the 

 

Object Selection

 

 tool from the 

 

ls

 

 toolbar, select an object.

  

k the 

 

Stroke

 

 tab in the 

 

Paint Style 

 

tte. If the Paint Style palette is not 
layed, choose 

 

Window menu> 

t Style

 

. 

  

e 

 

Width

 

 entry box, highlight the 
ent number displayed and enter a 
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This is similar to the standard stroke you 
use in Adobe Illustrator or CorelDRAW!. 
The stroke is displayed as a solid color, set 
to the width you prefer. Dashed lines can 
be created using a basic stroke. You can 
also specify corner joint type and end caps 
to be used.

Applying Color

Color can be applied to Basic, Gradient and 
Skeletal strokes. The method for applying 
color to each stroke varies. This section 
discusses applying color to Basic strokes.

For additional information on colorizing 

choose Window menu> Color. The 
Color palette appears.

6Select or define a color from within the 
Color palette. The color appears in the 
color selection rectangle at the bottom 
of the Color palette as well as in the Paint 
Style palette. 

For detailed instructions on picking a 
color, see ➤Chapter 4, “Using Color.”

Expres
points
Stroke

To cha

1Usin
Too

2Clic
pale
disp
Pain

3In th
curr
 number. You can also click the up 
 down arrows to increase or decrease 
width in increments of one point. 
 the up/down arrows to adjust the 
h more quickly.

k Apply.
Skeletal Strokes, see ➤“Colorizing Objects” 
in Chapter 4, “Using Color.”

To change the color of a basic stroke:

1Using the Object Selection tool from the 
Tools toolbar, select an object.

2If the Paint Style palette is not displayed, 
choose Window menu> Paint Style. 
The Paint Style palette appears.

3Click the Stroke tab. The attributes for 
strokes appear in the palette.

4Click the Basic icon. The palette changes 7Click Apply.

The color selected in the Color palette 
appears in the Paint Style palette.

new
and
the 
Drag
widt

4Clic
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to display the Basic stroke parameters.



                                

ng Corner Attributes

  

n

 

 buttons give you the ability to 
ow Expression applies a stroke to a 

 

ge corner appearance:

  

 the 

 

Object Selection

 

 tool from the 

  

 toolbar, select an object.

             

line using 90, 10 intervals.
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2Click the Stroke tab in the Paint Style 
palette. If the Paint Style palette is not 
displayed, choose Window menu> 

Paint Style. 

3Select the Dash check box.

4Enter a pattern of numbers indicating the 
size and interval for the dashes. For 
example, enter 20 10 to create a line that 
has dashes of 20 points separated by 
spaces of 10 points.

You can create more complex dash pat-
terns by entering sequences of more 
than one or two numbers.

Changi

The Joi
select h
corner.

To chan

1Using
Tools

Dashed 
the Stroke tab in the Paint Style 
e. If the Paint Style palette is not 
yed, choose Window menu> 

 Style. 

on a Join method button. You have 
llowing choices:   
Creating Dashes

Expression allows a dash pattern to be 
specified to a stroked path with each dash 
being an instance of your stroke. This 
works the same way for Basic, Gradient and 
Skeletal strokes.

To create dashed line:

1Using the Object Selection tool from the 

stroke width examples.

5Click Apply.  

Dashed line using 20-10 interval.

Dashed line using 10, 20, 30, 40 intervals.

2Click 
palett
displa
Paint

3Click 
the fo
Applying Strokes and Fills 101
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Tools toolbar, select an object. Miter.



                       

3

 

Click a 

 

Caps

 

 method button. You have 

        

Applying Skeletal Strokes

 

re of Expression is the Skeletal 
. In most graphic software when you 
 path you can set certain character-
f the path, such as color or fill. 

software allows you to use tools that 
 real world art tools, such as a callig-
pen or a dry brush. With Expression 
n go far beyond these standard char-
tics. 

sion gives you a Natural-Media feel, 
e advantages of resolution indepen-

rtwork. You can assign a path char-
tics of any other path or groups of 

 For example, you may create a path 
up of paths that create an image of a 
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Bevel.

the following choices:    

Flat cap.

Round cap.

Square cap.

The co
Stroke
draw a
istics o

Some 
mimic
raphy 
you ca
acteris

Expres
with th
dent a
acteris
paths.
or gro
ou can use that fish image to create a 
al Stroke which you can then apply to 
path. The fish image follows the 
 of the path to which it is assigned.
Changing End Cap Attributes

The Caps buttons define the shape of the 
ends of open paths or for dashed segments. 
Caps do not apply to Skeletal Strokes.

To change the endpoint appearance:

1Using the Object Selection tool from the 
Tools toolbar, select an object.

2Click the Stroke tab in the Paint Style 
palette. If the Paint Style palette is not 
displayed, choose Window menu> 

Paint Style. 

Round. Applying Gradient Strokes

When you select Gradient as your stroke, 
Expression displays the stroke as a Basic 
stroke but, instead of a solid color, the 
color is a simple or complex gradient, 
changing gradually from one specified 
color to another.

Gradient strokes are set in the same man-
ner as Gradient fills. For more information 
on gradients, see ➤“Using Gradients” in 
Chapter 4, “Using Color.” 

fish. Y
Skelet
a new 
shape
ng Skeletal Strokes.
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Stroke Warehouse 

 

palette is not 
yed, choose 

 

Window menu> 

e Warehouse

 

. The Stroke 
house palette appears.

 

 path. 
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You can also control the direction of the 
Skeletal Stroke and its width. 

Assign various attributes to your Skeletal 

For information on defining a stroke see 
➤“Creating and Editing Skeletal Strokes,” 
later in this chapter.

Applying a Skeletal Stroke

Just like any other type of stroke (Basic or 
Gradient), a Skeletal Stroke can be applied 
to any path. You can choose from any of 
the Skeletal Strokes in the Stroke Ware-
house palette.

Twisted and skewed strokes.

2If the 
displa
Strok

Ware

A simple
How is a Skeletal Stroke Created?

Each Skeletal Stroke is contained in its own 
individual reference frame or stroke defini-
tion box. The stroke may be as simple as a 
dot or as complex as a sailing ship but once 
it has been defined as a stroke you can 
apply it as a characteristic to any path you 
draw. 

The stroke definition box becomes the ref-
erence for the stroke. As it is pulled along 
the path, the artwork within the stroke is 
deformed based on the distortion of the 
box. You can even twist and skew the 
stroke. 

Strokes. “Painting” with a Skeletal Stroke is very 
simple—just choose a stroke from the 
Stroke Warehouse palette and draw with 
the drawing tool of your choice. Instruc-
tions for applying a Skeletal Stroke to an 
existing path appear below. 

Once you have applied a Skeletal Stroke, 
the Paint Style palette allows you to set sev-
eral special Skeletal Stroke parameters, in 
addition to the standard stroke parame-
ters. For additional information in applying 
attributes, see ➤“Setting Skeletal Stroke 
Parameters,” later in this chapter.

To apply a Skeletal Stroke:
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 stroke from the Stroke Warehouse 
Chapter 5 •

1Using the Object Selection tool from the 
Tools toolbar, select an object or path.

Select a
palette.



   

3

 

Click any stroke you prefer from the 

          

Using Quick Strokes 

                 

 a quick keystroke:

  

e the 

 

Quick Stroke number

 

. The 
cted stroke becomes highlighted in 
Stroke Warehouse palette and 
mes the active stroke in the Paint 

e palette.

 can also choose 

 

Stroke menu> 

 Quick Stroke

 

 and highlight the 
ropriate stroke.

 

g Skeletal Stroke Parameters

 

you select a Skeletal Stroke the 
 is drawn based on the stroke you 
 In addition to Width, Dash and Join, 

     

Ch05.FM5  Page 104  Monday, November 11, 1996  11:10 AM
Stroke Warehouse palette. The controls 
and the preview in the Paint Style palette 
are updated to reflect your choice.

4In the Paint Style palette, click Apply.

This feature can be used to assign single 
keystrokes to your favorite Skeletal 
Strokes. Instead of returning to the Stroke 
Warehouse palette each time you need to 
change your stroke, you simply use a key-
stroke to switch between strokes.

To set a quick keystroke:

1Click on a stroke in the Stroke 
Warehouse palette. 

2Choose Stroke menu> Set As Quick 
Stroke to display the sub-menu.

3From the sub-menu, choose the stroke 

To use

1Typ
sele
the 
beco
Styl

You
Use

app

Settin

When 
object
select.
bed earlier, you can set Skeletal 
 specific parameters including Mode 
n or Sausage), Shear, Twist and 

.

ormation on creating a new Skeletal 
, see ➤“Creating and Editing Skeletal 
s,” later in this chapter. 

ormation on changing the colors in a 
al Stroke, see ➤“Colorizing Objects” 
pter 4, “Using Color.”
The selected stroke is applied to the selected 
path.

number you wish to assign to the 
selected stroke. You can choose a 
number from 1 to 9. By default, the 
number 0 is assigned to a basic stroke.

You can also quickly assign quick strokes by 
selecting a stroke from the Stroke Warehouse 
palette then press Command/Ctrl+any number 
between 1 and 9. The number your select is the 
quick key number assigned to that stroke. 

descri
Stroke
(Ribbo
Shape

For inf
Stroke
Stroke

For inf
Skelet
in Cha
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ge the Skeletal Stroke mode:

 any of the Selection tools from the 
 toolbar, select an object to which a 
tal Stroke has been applied.

the Stroke tab in the Paint Style 
e. If the Paint Style palette is not 
yed, choose Window menu> 

 Style.
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Changing the Width of the Skeletal 
Stroke 

You can control the width of a Skeletal 
Stroke as you can for a Basic or Gradient 
stroke; by using the Width entry box in the 
Paint Style palette. In addition, you can also 
control the width by manipulating the 
Shear/Width handle assigned to each Skele-
tal Stroke. 

To manually change the width of a 
Skeletal Stroke:

1Using any of the Selection tools from the 
Tools toolbar, select the object. 

Shear is also adjusted. For more 
information on Shear, see ➤“Shearing 
the Stroke.” 

Changing the Mode

Expression offers two ways to apply a 

Changing the width of your Skeletal Stroke.

To chan

1Using
Tools
Skele

2Click 
palett
displa
Paint
t Style palette, Skeletal Stroke tab. 

2Drag the Shear/Width handle up or down 

to change the width. Holding down the 
Shift key constrains the change so only 
the width is adjusted. Otherwise, the 

A simple object with Skeletal Stroke.

Shear/Width handle stroke to a path: Sausage or Ribbon. The 
default mode is Sausage but you can 
change the mode simply by clicking on the 
mode icon that you prefer.

Sausage mode displays a more literal path 
with the Skeletal Stroke distorted accord-
ingly. The Skeletal Stroke remains perpen-
dicular to the path, turning as the path 
curves an turns.

Ribbon mode creates an image something 
like what you get with a calligraphy pen. 
The Skeletal Stroke remains oriented along 
the Y axis or the paper as it was originally 
defined.

The Pain
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3Click on a Mode button.  Note: Do not confuse this ability to shear In Sausage mode the Shear angle is relative 
particular Skeletal Stroke. In Ribbon 
the Shear angle is based on the glo-
xis or the paper on which the stroke 
ed.

l the shear by using the Shear slider 
 Shear/Width handle that is assigned 
h Skeletal Stroke.

just the shear:

g any of the Selection tools from the 
ls toolbar, select an object to which a 
etal Stroke has been applied. 
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Ribbon mode.

the Skeletal Stroke with the transformation 
handles on the bounding box of a selected 
object. The transformation handles on the 
bounding box affect the path. The Shear/
Width handle on the object itself and the 
Shear slider in the Paint Style palette affect 
the Skeletal Stroke. For information on 
shearing the path, see ➤“Shearing Objects” 
in Chapter 6, “Arranging and Editing 
Objects.”

to the 
mode 
bal Y a
is plac

Contro
or the
to eac

To ad

1Usin
Too
Skel
k the Stroke tab in the Paint Style 
tte. If the Paint Style palette is not 
layed, choose Window menu> 

t Style. 

le object with Skeletal Stroke.
4Click Apply.

Shearing the Stroke

Shear refers to the angle at which the 
stroke is drawn. Imagine the stroke shape 
as being on a clear piece of fabric. By 
default the clear fabric is a rectangular 
shape, with right angles. Using Shear you 
can pull that rectangular shape into a paral-

Sausage mode. Before shear.

After shear.

2Clic
pale
disp
Pain

A simp
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lelogram thus distorting the stroke. 



the Twist slider. 

 the Shape of a Multi-view 

sts and 1,080° twists.
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3Drag the Shear slider. 

40° shear and -25° shear.

2Drag the Shear/Width handle to the left 
or right to change the shear. 

Twisting a Stroke

You can twist your Skeletal Stroke by drag-
ging the Twist slider to set the number of 
turns you want.

To twist a stroke:

Changing the shear of your Skeletal Stroke.

3Drag 

Setting
Stroke

280° twi
s ordinary Skeletal Strokes are 
from a single picture, Multi-view 
are defined from a sequence of dif-
ut closely related) pictures. 

ion treats these pictures as differ-
s of a single stroke, any of which 

used each time you apply the 
or more information on Multi-view 

 see ➤“Creating Multi-view 
” later in this chapter.

w is assigned a shape parameter 
 0% and 100%, which allows you to 

which view to use. Because Expres-
omatically generates “in-between” 
om the original views in the Stroke 
n, a Multi-view stroke can have a 
To manually change the shear of a 
Skeletal Stroke:

1Using any of the Selection tools from the 
Tools toolbar, select an object to which a 
Skeletal Stroke has been applied. 

A simple object.

1Using the Object Selection tool from the 
Tools toolbar, select an object. 

2Click the Stroke tab in the Paint Style 
palette. If the Paint Style palette is not 
displayed, choose Window menu> 

Paint Style. 

A simple object.

Wherea
defined 
strokes 
ferent (b
Express
ent view
may be 
stroke. F
strokes,
Strokes,

Each vie
between
specify 
sion aut
views fr
definitio
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By dragging the Shape slider in the Paint 3Click the Stroke tab. The attributes for 

fects of the Shape slider.
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Style palette, you can specify which view of 
the stroke you want to use. Alternatively, if 
you enable the Random checkbox, Expres-
sion randomly chooses a view. The Shape 
slider and the Random checkbox are 
enabled only when the Paint Style palette 
contains a Multi-view stroke (Multi-view 
strokes are marked in the Stroke Ware-
house with a blue dot).

To set the shape of a Multi-view Stroke:

1Using any of the Selection tools from the 
Tools toolbar, select an object to which a 
Multi-view stroke has been applied.

strokes appear in the palette.

The ef
cify a randomly chosen shape:

g any of the Selection tools from the 
ls toolbar, select an object to which a 
ti-view stroke has been applied.

e Paint Style palette is not displayed, 
ose Window menu> Paint Style. 
 Paint Style palette appears.

k the Stroke tab. The attributes for 
kes appear in the palette.
2If the Paint Style palette is not displayed, 
choose Window menu> Paint Style. 
The Paint Style palette appears.

4Drag the Shape slider to select a 
percentage value. 0% (the default 
setting) specifies the stroke’s first view; 
100% specifies the last view. 

Each value in between specifies a partic-
ular view, which (depending on the 
stroke) may be a view from the original 
Stroke definition or a view automatically 
generated by Expression.

Using the Shape slider.
To spe

1Usin
Too
Mul

2If th
cho
The

3Clic
stro
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the Fill tab in the Paint Style 
e. If the Paint Style palette is not 
yed, choose Window menu> 

 Style. 

Fill Types
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4Enable the Random checkbox below the 
Shape slider. The Shape slider is now 
disabled, and a value is randomly 
generated.

Applying Fills

Expression allows you to choose from four 
types of fill; None, Solid, Gradient and Pat-
tern. The currently active fill is displayed 
and can be changed using the Paint Style 
palette’s Fill tab. 

The Paint Style palette tabs. 

Fill Tab

2Click 
palett
displa
Paint
a Fill Type icon to select a fill type. 
ave four fill options: 

No fill displayed. No parameters 

Fill is a solid color.

ent Fill is drawn with color chang-
adually from a starting color to an 
g color. 

n Fill is drawn with a repeating 
rn.

t Style palette, Fill tab
Using the Random setting.
Regardless of which fill type you choose, 
the Fill rule allows you to define which 
areas of your object are filled. There are 
two methods which can be used when 
applying a fill to complex objects:

• Non-Zero Winding Rule

• Even-Odd Rule

For more information on the Fill rules, see 
➤“Filling Complex Shapes” in Chapter 3, 
“Creating Paths.”

To select a fill:

1Using the Object Selection tool from the 

3Click 
You h

None
to set

Solid

Gradi
ing gr
endin

Patter
patte

The Pain
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Tools toolbar, select an object.



Applying Solid Fills 4Set the color by clicking the preferred Applying Gradient Fills
you select Gradient Fill, Expression 
ys the fill as a simple or complex gra-
changing gradually from one 
d color to another.

nt fills are set in the same manner as 
nt strokes. For more information on 
nts, see ➤“Using Gradients” in 
er 4, “Using Color.” 
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When you select Solid Fill, Expression dis-
plays the fill as a solid color.

To apply a solid fill:

1Using the Object Selection tool from the 
Tools toolbar, select an object. 

color in the Color palette. The display at 
the bottom right of the Paint Style 
palette updates. 

For more information on applying color, 
see ➤Chapter 4, “Using Color.”

5Click Apply. 

When 
displa
dient, 
selecte

Gradie
Gradie
gradie
Chapt

 

ying Pattern Fills
ns are tiled repetitions of pictures 
e used as Expression fills. Expres-
resents you with a selection of pre-
d fills but you can also create your 
ou can create a pattern out of any-
ou can draw.

 and radial gradient fill.

2Click the Fill tab in the Paint Style 

palette. If the Paint Style palette is not 
displayed, choose Window menu> 

Paint Style. 

3Click the Solid fill type icon. 

Select an object

The Solid fill type icon.

Applying a solid fill.

Appl
Patter
that ar
sion p
define
own. Y
thing y

Linear
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e a new pattern:

e or open a basic tile picture in the 
ssion workspace.

r open a tile pattern.
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To select a predefined pattern:

1Using the Object Selection tool from the 
Tools toolbar, select an object. 

6Click Apply. 

Creating a New Pattern

Expression's Pattern Definition tool allows 
you to create a pattern from any artwork in 

Applying a pattern fill

To defin

1Creat
Expre

Create o
the Definition Tools icon in the 
 toolbar and choose the Pattern 
ition Box tool. 

a marquee around the area to be 
d into a pattern. The size of the 
uee you draw defines the tile size 
ontrols the spacing between 
itions. For more space, drag the 
uee larger. For less space leave less 
pace within the marquee. 

ern Definition Box tool.
2Click the Fill tab in the Paint Style 
palette. If the Paint Style palette is not 
displayed, choose Window menu> 

Paint Style. 

3Click the Pattern fill type icon. 

4Scroll through the list of patterns. The 
selected pattern is previewed in the 
lower right of the Paint Style palette.

5Click to select the pattern you prefer.

Select an object

The Pattern fill type icon

your Expression document. You simply 
drag a marquee around the artwork to cre-
ate a Pattern Definition Box. The Pattern 
Definition Box is a special type of object 
which allows you to define the contents of 
a single pattern tile. 

By transforming the Pattern Definition Box 
with the transformation tools, you can cre-
ate a pattern whose tiles are skewed or 
rotated. This often results in a pattern with 
less obvious seams. Once you have 
adjusted the Pattern Definition Box to your 
liking, you define the pattern by clicking a 
button. After you define a pattern, it 
becomes accessible from the list in the 
Paint Style palette.

2Click 
Tools
Defin

3Drag 
turne
marq
and c
repet
marq
free s

The Patt
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creates overlapping tiles.
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When you release the mouse, a pattern 5Click the Define button in the lower left 

 the pattern to transform with 
:

ose File menu> Preferences. The 
erences dialog appears.

k the Options tab.

ct the Transform Patterns check 
. From now on, transformations 
lied to objects with a pattern fill are 
lied to the pattern as well. This 
on can be turned on and off in an 
ing session and the effect is 
mulative. 
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definition box is created. This box allows 
you to further adjust the pattern tile and 
displays a preview of the pattern.

Select the area to define the pattern 
boundaries.

corner of the Pattern Definition window 
to define the pattern. 

6Enter a name for the new pattern and 
click OK. The new pattern is added to the 
list of available patterns, ready for you to 
use.

Controlling the Pattern During Trans-
formation

Expression allows you to set a preference 
to determine whether pattern fills are 

Click Define to define the pattern.

To set
object

1Cho
Pref

2Clic

3Sele
box
app
app
opti
edit
accu
s with and without Transform Patterns.

4Using the Transformation tools from the 

Tools toolbar or the selection handles on 
the pattern definition box, rotate, skew, 
scale, etc., the pattern definition box as 

Release the mouse and a pattern definition 
box is created.

transformed (moved, scaled, rotated, or 
sheared) along with the objects to which 
they are applied. 

When the Transform Patterns option is 
enabled, a pattern is treated as part of the 
object to which it is applied and is subse-
quently affected when the object is trans-
formed. When this option is disabled, the 
object is like a window, simply revealing 
the pattern. Transforming the object may 
affect which part of the pattern is revealed, 
but the pattern itself is not transformed.

Object
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hin individual Expression docu-
ou don’t have to worry about miss-

erns when you re-open a file.

ns Within Strokes
stroke definition includes an object 
attern fill, the pattern is re-applied 
instance of the stroke. Therefore, 
ern is not deformed with the con-
 the stroke.

ns and Color Substitution
ou change the primary colors of an 
hose fill or Skeletal Stroke uses a 
 the colors of the pattern are 
 along with the rest of the object’s 
owever, the individual colors 
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To remove a pattern from the pattern 
list: 

1Click the Fill tab in the Paint Style 
palette. If the Paint Style palette is not 
displayed, choose Window menu> 

Paint Style. 

2Click the Pattern fill type icon.  

5Click the Define button in the lower left 
corner of the Pattern Definition window 
to define the pattern. A dialog appears 
prompting you to enter a name for the 
pattern.

6Enter a name for the pattern. If you save 
the pattern with the same name as an 
existing pattern, the new pattern 
overrides the exiting, and all objects to 
which the pattern is applied are 
changed. If you save the pattern under a 
different name, the original pattern is left 
unchanged.

7Click OK. 

kept wit
ments, y
ing patt

Patter
When a 
with a p
to each 
the patt
tents of

Patter
When y
object w
pattern,
affected
colors. H
 pattern cannot be edited on an 
y-object basis.

ing
pression you can mimic and extend 
itional pen and ink shading tech-
own as hatching. Hatching gener-

attern of strokes whose widths vary 
n the contrasting lightness/dark-
the source imagery you provide. 

pe, thickness and relative place-
 individual lines within the hatching 
determine how the object is per-
Hatching can indicate depth or cur-
s well as distance and texture. 
g is one of the features that gives 
3Select a pattern from the pattern list.

4Click the Del button.

To edit patterns: 

1Click the Fill tab in the Paint Style 
palette. If the Paint Style palette is not 
displayed, choose Window menu> 

Paint Style. 

2Click the Pattern fill type icon.

3Select a pattern from list.

The Pattern fill type icon.

To rename a pattern, save it with a different name, 
then delete the original pattern.

Pattern Storage
All patterns are stored in a single pattern 
file within the main Expression directory. In 
addition, each Expression document file 
contains the pattern definitions for all pat-
terns used in the document. 

If your pattern list becomes cluttered, you 
can simply delete patterns you use infre-
quently. Since pattern definitions are also 

within a
object-b

Hatch
With Ex
the trad
nique kn
ates a p
based o
ness of 

The sha
ment of
pattern 
ceived. 
vature a
Hatchin
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4Click Edit. Make changes as needed.

Express



are achieved by varying the width and Hatching Results
atching has been applied the bound-

th is deleted by default. Any other 
s used as source imagery are unaf-
. The final result of a hatching opera-
 simply a group of strokes.

ply hatching:

g the Object Selection tool from the 
ls toolbar, select an object.
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Applying Hatching

An example of hatching.

parameters of these component strokes at 
the time of application according to the 
source image.

Expression includes several patterns 
designed for hatching (they all have 
“hatch” or “hatching” in their name). You 
can also design your own patterns for 
hatching. Hatching patterns are defined 
and stored like any other pattern, and are 
kept in the same list. In fact, you can use 
any pattern for hatching, although patterns 
not specifically designed for hatching are 
not likely to produce good results. For a 
lesson in designing a hatching pattern, see 
the Expression Creative Techniques guide.

After h
ary pa
object
fected
tion is

To ap

1Usin
Too
an object.
Hatching is applied to a path, which defines 
the boundary of the region to be hatched.

Any imagery which falls within this region, 
including the fill of the path itself and any 
objects which overlap it, is used to gener-
ate the hatching. Often, simple gradients or 
blends make the best source imagery for 
hatching.

The widths of the individual hatching 
strokes depend on the varying lightness 
and darkness of the source image. Lighter 
areas are hatched with thin strokes, darker 
areas with thicker strokes.

In addition to selecting a path, you must 
choose your hatching pattern. Hatching 

Select 
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patterns are specialized patterns com-
posed of strokes. Variations in the hatching 



ing and Editing 
tal Strokes

ide you with a number of pre-
Skeletal Strokes located in the 
arehouse palette but the real 

f Expression comes as you create 
 your own Skeletal Strokes.

g Skeletal Strokes

ion allows you to create a Skeletal 
rom any vector picture, whether it 
rt, artwork you create in Expres-
 artwork you import from another 
ion.
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2Choose Objects menu> Hatch. The 
Hatch dialog appears.

3Choose a hatch pattern from Hatch 

The Hatch dialog.

6Click Use Background Color to color the 
hatching strokes with the object’s 
original color. When this option is 
deselected, hatching is applied to the 
object based on the intensity of the 
original color. The color is discarded and 
only hatching remains.

7Click Keep Original Paths to include the 
object’s original path in the hatched 
image. When this option is deselected, 
the path itself is discarded and the 
resulting object consists of only the 
hatching pattern.

8Click OK. The hatch is applied to the 
selected object.

Creat
Skele

We prov
defined 
Stroke W
power o
and edit

Creatin

Express
Stroke f
is clip a
sion, or
applicat
e a new Skeletal Stroke:

e or open a picture you would like 
 as a Skeletal Stroke.

the Definition Tools icon in the 
 toolbar and choose the Stroke 
ition Box tool. The cursor changes 
rosshair. 

ke Definition Box tool.
Pattern list.

4Scale the pattern by entering a value in 
the Scale Pattern entry box or click on 
the up and down arrows. This option can 
be used to enlarge or reduce the size of 
the tile used in the pattern.

5Click Scale Stroke Width to control the 
width of each hatching stroke based on 
the light and dark intensity of the 
background color. Control the contrast 
by adjusting the Min. Intensity scale and/
or Max. Intensity scale. When this 
checkbox is deselected, hatching 
behaves just like a pattern—the strokes 
do not vary in width.

Apply a hatch.

To defin

1Creat
to use

2Click 
Tools
Defin
to a c

The Stro
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3Drag a marquee around your picture 

 anchoring or repeating as desired to 
ntain the aspect ratio or repeat 
ain elements along a path.

more information on anchoring or 
ating, see ➤“Using Anchoring.” or 

ject appears in the Stroke Definition 
.
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defining its reference frame. An outline of 
the reference frame appears and an 
arrow indicates the direction of the 
stroke. 

Consider the following when creating the 

Define the reference frame.

Instead of using the Stroke Definition Box tool, you 
can select the objects you want to include in your 
Stroke, and choose Stroke menu> New 
Stroke Definition.

If an object you are including in a stroke definition 
contains a pattern fill, the pattern will appear to be 
scaled differently in the Stroke Definition window. If 
the pattern has an excessive amount of white space, 
it may not be visible in the Stroke Definition 
window. Don’t worry—the display of the pattern in 

4Use
mai
cert

For 
repe

The ob
window
epeating Elements of a Stroke,” later 
is chapter.

n you are happy with the picture, 
 the Define button at the lower left 
e window or choose Stroke menu> 
ine Stroke. The Define Stroke dialog 
ears.  

fine button.
reference frame:

Be aware of exactly how you draw your 
marquee: The stroke includes any space 
before, after, above or below the paths in 
your stroke, if that space is included in 
the reference frame. 

Any object partially or completely 
enclosed in the marquee is included in 
the selection. However, you can delete or 
edit the objects after you take them into 
the Stroke Definition window.

this window is for reference only. When you draw 
with the stroke, the pattern will be scaled correctly.

The Stroke Definition window appears 
displaying your new stroke and its refer-
ence frame. You can continue editing 
your picture from this window using the 
standard drawing tools described in 
➤“Drawing Tools” in Chapter 3, “Creat-
ing Paths.”

➤“R
in th

5Whe
click
of th
Def

app

The De
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 the same name to replace all 
ces with the edited stroke or enter 
 name to create a new stroke.

OK. The edited stroke is now saved 
 Stroke Warehouse palette and can 
ed on any path in Expression.

ne Stroke dialog.
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6Enter a name for your stroke and set its 
Default Width in points.

7Select a sub-directory if desired. Strokes 
must be stored in the Stroke directory or 
one of its subdirectories in order for 
Expression to find and use them.

The Define Stroke dialog.

You can also select an object with a Skel-
etal Stroke already applied. Choose 
Stroke menu> Edit Stroke Defini-

tion. The selected stroke appears in the 
Stroke Definition window. 

Double-click on a stroke in the Stroke 

4Enter
instan
a new

5Click 
in the
be us

The Defi
Anchoring
u apply a Skeletal Stroke to a path, 

etal Stroke stretches or com-
 to fit the path. When a stroke 
s or compresses, its aspect ratio—
 of width to height—changes, dis-
he appearance of the stroke. 

 control this distortion by using 
ng to constrain the aspect ratio of 
re stroke or just a part.
8Click OK. The stroke is now saved in the 
Stroke Warehouse palette and can be 
used on any path in Expression.

Editing a Stroke

After you have created a Skeletal Stroke, 
you can edit its definition at any time. 
When you edit a Stroke definition, the 
changes you make are automatically 
applied to all instances of the stroke in 
open documents.

To edit a stroke:

1Double-click on the stroke you wish to 

2Using the standard drawing tools, edit 
the picture. You can also edit the stroke 
and fill attributes of your artwork using 
the Paint Style and Custom Color 
palettes.

3When you are happy with the picture, 
click the Define button at the lower left 
of the window or choose Stroke menu> 
Define Stroke. The Define Stroke dialog 
appears.  

Warehouse palette to edit.

Using 
When yo
the Skel
presses
stretche
the ratio
torting t

You can
anchori
the enti
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edit from the Stroke Warehouse palette. 

The Define button.



 Creating Anchors 3Shift-click to select additional points or 
move points from the selection.

ose an anchor type from the Actions 
bar to create an anchor. You have 
following options:

hor node at the start of stroke. You 
also choose Stroke menu> Anchor 
tart. 

hor node at the end of stroke. You 
also choose Stroke menu> Anchor 
nd. 

hor node at a fixed point along the 
ke. 
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WIthout anchoring the heads and tails are 
distorted.

Anchoring allows you to define what part of 
the stroke maintains its proportion when 
the aspect ratio of a path is changed.

Anchors can be created at the beginning 
and/or end of a stroke, or at a fixed point 
along the stroke.

To create an anchor:

1From within the Stroke Definition 
window, click the Anchor/Repeat Tool 
icon from the Tools toolbar and choose 
the Anchor tool. 

to re

4Cho
tool
the 

Anc
can 
to S

Anc
can 
to E

Anc
stro
chor types. 

your stroke to a path.

r at Start Anchor at Fixed Point

nchor at End Free Anchor
With anchoring, the heads and tails maintain 
correct proportion.

2Drag a marquee to select all points to be 
included in the anchor. 

The Anchor tool.

The An

Apply 

Ancho

A
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Select points to be anchored.



ing Anchors

u have created an anchor, you can 
anywhere along the length of the 
eference frame. Moving an anchor 
t move the associated nodes; it sim-
ges the point to which they are 
d.

ate anchor:

 the Stroke Definition window, click 
nchor/Repeat Tool icon from the 
 toolbar and choose the Anchor 
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Removing Anchors

After you have created an anchor, you can 
remove a node from the anchor or remove 
the anchor altogether by using the Free 
Anchor button on the Actions toolbar.

To remove a node from an existing 
anchor:

1From the Stroke Definition window, click 
the Anchor/Repeat Tool icon from the 
Tools toolbar and choose the Anchor 
tool. 

3Click the Free Anchor button from the 
Actions tool. You can also choose 
Stroke menu> Free Anchor. The 
node is removed from the anchor. Any 
other nodes belonging to the same 
anchor is not affected.

To remove an anchor:

1From the Stroke Definition window, click 
the Anchor/Repeat Tool icon from the 

The Free Anchor tool.

Relocat

After yo
move it 
stroke r
does no
ply chan
anchore

To reloc

1From
the A
Tools
tool. 
an anchor icon horizontally to 
e its location.

hor tool.

2Click the node you wish to remove. Both 

the node and the anchor to which it 
belongs are selected.

The Anchor tool.

Tools toolbar and choose the Anchor 
tool.

2Click in the Stroke Definition window to 
select an existing anchor.

3Click the Free Anchor button from the 
Actions tool.

2Drag 
chang

The Anc
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Selected the node to be removed.



Repeating Elements of a Stroke 2Drag a marquee to select all objects to be 

 Repeat frame has draggable handles 

at frame appears.

Repeat frame handles
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You can designate certain elements of a 
stroke to repeat instead of stretching to fit 
your path. This function can be very effec-
tive if you plan your stroke carefully. 

For example, you could create a train con-
sisting of an engine, a passenger car and a 
caboose. By designating the passenger car 
as repeating, with just one path you can 
create a train consisting of numerous pas-
senger cars but only one engine and one 
caboose. 

included in the repeat.

3Shift-click to select additional objects or 
to remove objects from selection.

4Click the Make Repeating button from 
the Actions toolbar. A Repeat frame 
appears, indicating that the selected 
objects have been designated to repeat, 
rather than stretch along the path. 

You can also choose Stroke menu> 
Make Repeating.

Unlike the Anchor tool, which operates on node The

A Repe
h allow you to specify the portion of 
stroke (as a percentage of the entire 
ke length) over which the selected 
ct(s) should repeat. By default, the 
eat frame covers the entire reference 
e, meaning that the object(s) repeat 
 the entire length of the stroke.

sired, use the Repeat tool to drag the 
er handle on either end of the 
eat frame left or right. This specifies 
start and end points for the 
tition, as percentage values of the 

re stroke length.
To repeat part of a stroke:

1From the Stroke Definition window, click 
the Anchor/Repeat Tool icon from the 
Tools toolbar and choose the Repeat 
tool.  

Repeating stroke.

The Repeat tool.

selections, the Repeat tool operates on object 
selections. Individual nodes cannot be selected with 
the Repeat tool 

The Make Repeating button.

whic
the 
stro
obje
Rep
fram
over

5If de
cent
Rep
the 
repe
enti
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ing Repeating Parts

u have designated a particular 
o be repeating, you can always 

or the repeat frame, Shift-click on the 
andle

ng the Repeat frame eliminates gap 
 elements.
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The top and bottom handles on the right 
end of the Repeat frame allow you to 
scale the repeating object(s) up or down 
as they repeat. By default, the handles 
are set so that the object(s) do not scale.

6If desired, use the Repeat tool to drag the 
top or bottom handle on the right end of 
the Repeat frame up or down. This 
specifies the extent to which the 
object(s) are scaled as they repeat along 
the path. When you drag one handle the 
other mirrors it, constraining the scaling 
to be centered vertically on the stroke’s 
horizontal axis.

Anchoring the Starting and Ending 

To anchor the starting or ending point of 
the Repeat frame:

1From the Stroke Definition window, click 
the Anchor/Repeat Tool icon and choose 
the Repeat tool. 

2Select a Repeat frame to activate its 
handles.

3Hold down the Shift key and click the 

The Repeat tool.

Remov

After yo
object t

To anch
center h

Anchori
between
to go back and make it non-repeat-

rt a repeating part to a non-
ng part:

 the Stroke Definition window, click 
nchor/Repeat Tool icon from the 
 toolbar and choose the Repeat 

eat tool.
Points of a Repeat Frame

If you want, you can anchor the starting or 
ending point of a Repeat frame to the begin-
ning or end of the stroke, respectively. In 
this case, the limits of the Repeat region 
are not defined as percentages of the 
stroke length (proportional to its width), 
but as set distances from the ends of the 
stroke.

center handle on either end of the 
Repeat frame to anchor it.   

Squares are anchored at ends and the circle 
is a repeating element.

In some instances, the stroke will contain 
gaps between elements.

choose 
ing.

To reve
repeati

1From
the A
Tools
tool. 

The Rep
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2Click or drag a marquee to select a Creating Multi-view view stroke might be used to simulate a 
which spatters paint in spots of vary-
e and shape; because each instance 
stroke is slightly different, the simu-
is more convincing. The same princi-
o applies to Graphic Element 
s. You could design a Multi-view 
 to create an entire school of fish, 
ne slightly different, without the 
 of tweaking a bunch of duplicates.

n animate with Expression by treat-
ulti-view stroke's sequential views 

yframes in an animation. Expression 
atically creates the “in-between” 
. Any Multi-view stroke can be ras-
 (converted to a bitmap) and saved 

ovie. You can save movies in any of 
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repeating part, or click on a Repeat 
frame.

3Click the Make Non-repeating button on 
the Actions tool. You can also choose 
Stroke menu> Make Nonrepeating.

The Make Non-repeating button.

Strokes

Expression's Multi-view stroke feature is 
particularly useful for adding variations to 
your artwork. It also allows you to create 
simple animations with very little work. 
This section explains how to create and 
edit Multi-view strokes. 

Instructions for applying Multi-view strokes 
appear in ➤“Applying Skeletal Strokes,” 
earlier in this chapter.

Whereas ordinary Skeletal Strokes are 
defined from a single picture, a Multi-view 

brush 
ing siz
of the 
lation 
ple als
stroke
stroke
each o
tedium

You ca
ing a M
like ke
autom
frames
terized
as a m
lowing formats: QuickTime (Macin-
AVI (Windows), or a sequence of still 
 in any of the formats Expression 

rts. For more information on the 
of formats Expression supports, see 
ning and Saving Documents” in 

er 1, “Overview of Expression.”

sic process for designing a Multi-
troke is straightforward. You simply 
or import) artwork for the stroke's 
view. Then, within the Stroke Defini-
indow, you create additional views 
ting the initial artwork with Expres-
editing tools. The only limitation is 
ere must be a one-to-one correspon-

 between objects and nodes across 
stroke is defined from a sequence of differ-
ent (but closely related) pictures. Expres-
sion treats these pictures as different views 
of a single stroke, any of which may be 
used each time you apply the stroke. Each 
view is assigned a shape parameter 
between 0% and 100%, which allows you to 
specify which view to use. Because Expres-
sion automatically generates “in-between” 
views from the original views in the Stroke 
definition, a Multi-view stroke can have a 
wide range of appearances.

To add randomness to your artwork, you 
can create a Multi-view stroke and have 
Expression randomly pick a view each time 
you draw with the stroke. Or, if you prefer a 
more controlled approach, you can explic-

the fol
tosh), 
images
suppo
types 
➤“Ope
Chapt

The ba
view s
draw (
initial 
tion w
by edi
sion's 
that th
dence
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itly specify which view to use for each 
instance of the stroke. For example, a Multi-
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all of the views in a particular stroke. That 
is, you cannot add or delete objects or 
nodes from one view to the next.

To create a Multi-view stroke:

1Using Expression’s drawing tools, draw 
the initial view of your Multi-view stroke.

2Click the Definition Tools icon in the 
Tools toolbar and choose the Stroke 
Definition Box tool. The cursor changes 
to a crosshair. 

View bar
 any of the Selection tools and 
formation tools (Rotate, Scale, 
r and Shear), move and edit objects 
oints in the selected view. 

an also edit certain attributes of 
keletal Strokes within the view. For 
 information on editing within 
, see ➤“Adding Views,” later in this 
er. 

ew marker.
3Drag a marquee around the image(s) you 
created. You can also select the image(s) 
and choose Stroke menu> New 
Stroke Definition. A new Stroke 
Definition window appears, containing 
the selected image(s).

The Stroke Definition Box tool.

4Still in the Stroke Definition window, 
click the Add button. A new view is 
added to the stroke. A View marker 
representing the new view is added to 
the right end of the View bar. 

A selected marker indicates which view 
you are currently working on. The shape 
parameter of the current view (a percent-
age value between 0% and 100%) is dis-
played to the right of the View bar.

Define the area to be contained in the stroke.
5Using

Trans
Mirro
and p

You c
any S
more
views
chapt

Add a n
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9Click OK. The stroke is automatically paths to your liking. If your Multi-view 
 contains instances of other Skeletal 
s, you can also use the Paint Style 
 to change certain attributes of 

strokes width, shear angle and shape 
en views.

he positions of object and nodes and 
oke parameters listed above can be 

ed between views of a Multi-view 
. Any other changes you make while 
g in a particular view are applied 
 all of the views in the Multi-view 
. Such changes include adding or 
g objects, changing colors, etc.

Ch05.FM5  Page 124  Monday, November 11, 1996  11:10 AM
Edit the new view as needed.

added to the Stroke Warehouse palette. 
Multi-view strokes are identified in the 
Stroke Warehouse palette by a blue dot.

stroke
Stroke
palette
these 
betwe

Only t
the str
chang
stroke
workin
across
stroke
deletin
letal Stroke is used in the construction of a 
iew stroke, the shear and width information 
stroke is actually stored as the position of its 
idth handle. On generating the in-between 

he Shear/Width handles are interpolated in 
e manner as other nodes. This approach 
metimes result in a fluctuation of the shear 
th of a moving stroke between a pair of 
ven if the shear and width of that particular 
re identical in both views. The effect can be 
ed by inserting an extra view if the 
ion is particularly noticeable.
6Create additional views and adjust the 
spacing between views if desired. For 
more information on adding views, see 
➤“Adding Views,” below.

7Click the Define button in the lower left 
corner of the Stroke Definition window to 
define the stroke. 

8Enter a name for the new stroke, enter a 
default width and specify a directory in 
which to save the stroke.

Adding Views
A Multi-view stroke can have as many views 
as you like. Rather than draw each new 
view from scratch, you edit existing nodes 
(points) to create new views. You can add a 
new view at a specific point along the View 
bar, or automatically add a view halfway 
between two existing views.

When you create a new view, its initial 
appearance is automatically generated by 
Expression, based on the adjacent views. 
You can then use the Selection tools and 

Multi-view strokes are identified in the Stroke 
Warehouse palette by a blue dot.

If a Ske
Multi-v
of that 
Shear/W
views, t
the sam
could so
and wid
views, e
stroke a
minimiz
fluctuat
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the Transformation tools (Rotate, Scale, 
Mirror and Shear) to move and reshape the 



ve a view:

the Stroke Definition window, 
 a view marker in the View bar. 

the Del button to the left of the 
bar. The selected view is deleted.

g a View
u have created a view, you can drag 
er left or right along the View bar 
e its shape parameter. This allows 
lter the spacing between views, or 
 order of the views.

Ch05.FM5  Page 125  Thursday, November 7, 1996  10:39 AM
Try using one Multi-view stroke within the definition 
of another Multi-view stroke. You can use the Shape 
slider on the Paint Style palette to change the 
appearance of the nested Multi-view stroke from 
one view to the next. This allows the nested Multi-
view stroke to behave like an “animated sprite” 
within the other Multi-view stroke. For an example 
of this technique, see the Expression Creative 
Techniques guide which came with your 
documentation.

2Using any of the Selection tools and 
Transformation tools (Rotate, Scale, 
Mirror and Shear), move and edit objects 
and points in the new view. 

3Using the Paint Style palette, edit the 
width, shear angle and shape of any 
Skeletal Stroke in this view.

To create a new view halfway between 
two existing views:

1From the Stroke Definition window, 
select a view marker on the View bar.

2Click the Add button to the left of the 

To remo

1From 
select

2Click 
View 

Movin
After yo
its mark
to chang
you to a
even the
 a view (change its shape 
ter):

the Stroke Definition window, 
 a view marker in the View bar. 

he view marker left or right along 
ew bar to its new position. The 
 new shape parameter is displayed 
 right of the View bar.
To add another view:

1From the Stroke Definition window, hold 
down the Shift key and click along the 
View bar where you want to add the new 
view. A new view is automatically 
created and selected for editing. 

View bar. A new view is created halfway 
between the selected view and the next 
view. The new view is automatically 
selected for editing.

Removing a View
You can also delete a view from a Multi-
view stroke. When you do so, the stroke's 
other views are not affected.

Note: A Multi-view stroke must always have 
views with shape parameters of 0% and 
100%. If you delete the stroke's rightmost 
view (100%), the view with the next-highest 
shape parameter is moved to the end of the 
View bar to replace it. Likewise, if you 
delete the leftmost view (0%), the view with 

To move
parame

1From 
select

2Drag t
the Vi
view's
to the
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Add a new marker. the next-lowest shape parameter is moved 
to the left end of the View bar to replace it.



Saving Multi-view Strokes media animation, a frame rate of about 15 

e an animation:

ble-click on the Multi-view stroke 
wish to edit from the Stroke 
ehouse palette. The stroke must 
 two or more views.

 can also select an object with a Skel-
Stroke already applied. Choose 
ke menu> Edit Stroke Defini-

. The selected stroke appears in the 
ke Definition window. 
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as Animation

A Multi-view stroke may be saved as a 
movie, allowing you to create a simple ani-
mation. When you use a Multi-view stroke 
to animate, you can think of the stroke's 
views as key frames, and the View bar at 
the top of the Stroke Definition window as a 
timeline. The relative timing of the events 
in your animation depends on the spacing 
of the views along the View bar. The rectan-
gular reference frame in the Stroke Defini-
tion window acts as a viewfinder, 
everything within the frame is “on camera.”

fps and height and width of 320x240 pixels 
are typical. When producing animation for 
the Internet, lower frame rates and smaller 
sizes are often used to keep file sizes small. 
Television animation, by contrast, is gener-
ally 640x480 pixels at 30 fps. 

The type of compression you use also plays 
a role in the file size and playback rate of 
your animation. Experiment with the com-
pression options offered by QuickTime 
(Macintosh) and Video for Windows (Win-
dows) until you find the settings that best 
suit your needs.

A finished animation can be saved in any of 
the following formats: Quicktime (Macin-
tosh), AVI (Windows), or a sequence of still 

To sav

1Dou
you 
War
have

You
etal 
Stro

tion

Stro
he stroke in the Definition window.
To create a movie, Expression must raster-
ize the Multi-view stroke to create a 
sequence of bitmap images. You can spec-
ify the duration of the movie (in seconds) 
and the frame rate (in frames per second), 
as well as the height, width and resolution. 

If you leave the resolution set at 72 dpi (the 
default) and enter the height and width in 
points, then the height and width values 
you enter correspond to the actual height 
and width of the animation in pixels. This is 
generally recommended, since animations 
are for viewing on screen and are usually 
measured in pixels rather than real-world 
units.

You should consider the final format of 

images in any of the bitmap formats For 
more information on the formats sup-
ported by Expression, see ➤“Opening and 
Saving Documents” in Chapter 1, “Overview 
of Expression.”

Expression does not have the ability to play 
movies, so you need to view your com-
pleted animations in another application. 
Your computer probably came with a util-
ity for playing movies. If not, you can 
acquire a shareware movie player at little 
or no cost via the Internet, an on-line ser-
vice or a local user group.

Open t
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your animation when choosing its height, 
width and frame rate. For on-screen multi-



t file destination and name the file. 

Save. The Status bar at the bottom 
 document window indicates the 
 of the rasterizing process.
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2Choose File menu> Save Stroke as 
Movie. The Animation Settings dialog 
appears.

3Set the frame's Width, Height and 
Resolution by entering values into the 
appropriate fields. See above for some 
basic guidelines.

The Animation Settings dialog.

the edges between regions of contrasting 
color, eliminating the “jaggy” 
stairstepped edges typical of bitmap 
images. 

Unless you specifically require an anima-
tion which is not anti-aliased (for use as a 
sprite in a multimedia authoring pro-
gram, for example), there is no reason to 
disable this option. Anti-aliasing does not 
significantly increase the time required 
to rasterize an animation.

5Set the Duration and Frames per Second. 
See above for some more general 
guidelines.

ºSelec

¡Click 
of the
status
By default, the values in the Width and 
Height fields are constrained to maintain 
a constant aspect ratio (ratio of width to 
height). When you change either of these 
values, the other automatically changes 
proportionally. 

For any particular animation, the aspect 
ratio is determined by the proportions of 
the reference frame in the Stroke Defini-
tion window. If you want the aspect ratio 
of your animation to be different from 
that of the reference frame, disable the 
Keep Proportions checkbox. You can 
then set the Height and Width values 
independently.

6Click OK. The Save dialog appears.

7Select the file type. You can choose a 
movie format or sequenced stills. For 
more information on file types, see 
➤“Opening and Saving Documents” in 
Chapter 1, “Overview of Expression.”

8Click Options to select a video 
compression method. The Video 
Compression dialog appears. The 
compression options vary depending on 
the type of compressor you select. For 
more information on compression 
methods, see ➤“Choosing Video 
Compression,” in the following section.

9Click OK when you have set your 
Applying Strokes and Fills 127
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4Enable or disable the Anti-Alias 
checkbox. When anti-aliasing is enabled 
(the default), Expression smooths all of 

compression options. The Save dialog 
reappears.



Choosing Video 2Select one of the compressor options 
 the Compressor pop-up menu. The 

ons for the chosen compressor 
ar.

he options for the chosen 
pressor. Consult your QuickTime or 
o for Windows documentation for 
riptions of the various options.

 OK.
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Compression

Animations can consume a significant 
amount of hard disk space. If you have disk 
space limitations, you will want to com-
press any movies you make.

The software compression and decompres-
sion algorithms (called codecs) that you 
can select in the Video Compression dialog 
are provided with QuickTime (Macintosh) 
or Video for Windows (Windows). Codecs 
compress data when you render an anima-
tion and decompress the data when you 
play the movie. Any Macintosh or Windows 

To select a compression option:

1Click the Options button in the Save 
dialog. The Video Compression dialog 
appears.

from
opti
appe

3Set t
com
Vide
desc

4Click
system with QuickTime or Video for Win-
dows software can play back a compressed 
movie.

If you are using hardware for MPEG com-
pression, see the instructions that accom-
panied your board for a description of 
available compression options.

The Video Compression Options dialog. 
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An Example of Video 
Animation

The following is a pictorial example of a 
video animation.
.

.

Frame 1.

Frame 4.

Frame 2.

Frame 5.

Frame 3

Frame 6
Applying Strokes and Fills 129
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6

 

Arranging and 
Editing Objects

 

This chapter describes all of the 
tools and commands needed to 
edit, arrange, move and transform 
your paths. Once you have created 
a path, you can edit the vector 
points and line segments as you 
would in other drawing 
applications. Expression provides 
most of the common editing 
functions as well as some special 
features only available in 

 

Expression. 
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Objects, Paths and Points

        

Selecting Objects and 

               

•

 

Drag a marquee with the 

 

Object

 

 or 

 

Group 
ction

 

 tools to select all objects 
ded or partially included within the 
tion area. 

  

 a marquee with the 

 

Node Selection

 

 
to select all points contained within 

               

 marquee to select objects.
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Expression objects are paths. An object 
may be a simple or compound path, a 
group of paths, a clone of another object, 
or a text object. Each object is defined by 
points based on the particular drawing 
tools used in its creation. Before you can 
arrange or edit an object you must select 
the object or its points. 

; Note: Points are available for selection 
within a simple or compound path but are 
not available within a clone. For more 
information on clones, see ➤“Cloning 
Objects.” 

Points

The Object Selection, Group Selection and 
Node Selection tools are used for selecting 
and moving objects and points. The three 
tools have a lot in common and behave in 
Expression as they do in other applica-
tions.  

Object and Group Selection tools

Sele
inclu
selec

• Drag
tool 

Drag a
election area.

 an object (or point) to select that 
ct (or point), replacing the previous 
tion. 

 down the Shift key while clicking 
tional objects or points to add them 
e selection, or while clicking selected 
cts or point(s) to remove them from 
election.

 an object within a group with the 
ct Selection tool to select the whole 
p. 

 with the Group Selection tool to 
t an object within a group. Click the 
Mouse Hints and Tips
The following are hints and tips for select-
ing and moving objects with the mouse and 
Expression tools.

Selecting

• Click an object with any selection tool to 
select the object. 

Node Selection tool.

Select an object with any Selection tool.

the s

• Click
obje
selec

• Hold
addi
to th
obje
the s

• Click
Obje
grou

• Click
selec
ct again to select the entire group.
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obje



                                

rming

  

ne of the four transformation 
es to skew the selected path. 

         

ansformation handle to skew.

rmation handles
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Deselecting

• Click an empty space to deselect all. 

• Choose the Deselect All button from the 
Composition toolbar. This can be 
especially useful if you have a large 
background object, making it difficult to 
click in an empty space. 

Constraining and Moving

• Hold down the Shift key while moving a 
selection to constrain the movement to 
45° increments.

The Deselect All button.

Scaling

• Drag one of the four corner handles to 
scale the selection in both the x and y 
directions.

• Drag one of the four corner handles while 
holding down the Shift key to scale 
proportionately. The opposite corner 
serves as the anchor point as the scaling 
is done.

Corner handles

Transfo

• Drag o
handl

Drag a tr

Transfo
ne of the four transformation 
es while holding down the Shift key 
ate the selected path. 

ing Objects
ou can edit or arrange an object 
t select it. When an object is 
, its appearance changes indicating 
 selected.

s) and nodes are highlighted in the 
n color of the object’s layer. By 
Resize handles also appear, allow-
to transform the object directly. 

andles can be disabled via a user 
ce. For more information on set-

ferences, see ➤“Options Tab” in 
• Drag to move an object.

By default, Expression displays the Resize handles 
(four corner and four transformation handles). These 
handles can be used to scale, rotate, or skew the 
selection.

Drag a corner handle while holding Shift to 
scale proportionally.

• Drag o
handl
to rot

Select
Before y
you mus
selected
that it is

Its path(
selectio
default, 
ing you 

Resize h
preferen
ting pre
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You should select an entire object (as 

           

Selecting Points

            

3

 

Using the 

 

Node Selection

 

 tool, select a 
t. You can also drag a marquee with 
ode Selection tool. 

     

Unselected nodes
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opposed to some or all of its individual 
nodes) whenever you want to transform 
the object (move, rotate, scale, shear or 
mirror) without changing its basic shape. 

Transformations applied to an object are 
stored in memory and can be reset at any 
time, restoring the object to its original 
location, orientation and scale. For addi-
tional information on transforming objects, 
see ➤“Transforming Objects,” later in this 
chapter.

To select an object:

1Using the Object Selection or Group 

In order to change the shape of a path, you 
must be able to select individual points. 
When a node is selected, it is displayed as a 
large, solid-filled square in the selection 
color of the object’s layer. The path is also 
highlighted, and all of its unselected nodes 
are displayed as small, hollow squares.

Multiple nodes may be selected at once, 
whether they are on the same path or on 
several different paths. When more than 
one node is selected, Resize handles 
appear, allowing you to transform the 
multi-node selection. 

The Transformation tools also work on 
multi-node selections. Unlike transforma-

poin
the N
 down the Shift key and click 
tional points to add them to the 
ction. You can also click on 
idual selected point(s) to deselect 
.

ng individual points.

Selected nodes
Selection tool, select the object.

Resize handles appear around the object 
indicating that it is selected.

tions applied to objects, transformations 
applied to nodes actually change the basic 
shape of the path(s) and thus cannot be 
reset.

To select point(s):

1Select an object with one of the tools 
listed above.

2Choose the Node Selection tool from the 
Tools toolbar.

Node Selection tool.

4Hold
addi
sele
indiv
them

Selecti
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 points are shown with a dotted 
cating the imaginary polygon that 
 the shape of the B-Spline path. 

references are set to 

 

Show resize

 

 

  

, a triangle is positioned at each 
f the invisible bounding box con-
he object. These corner handles 

 

view, the path is shown by its 
representation
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Viewing Selected Objects and 
Points 
The appearance of an object or point varies 
depending on whether it is selected or 
unselected, as well as the View quality 
(Path, Wireframe or Preview) currently 
active.

To set view quality:

1Choose preferred view quality from the 
View menu.

For additional information on view qual-
ity, see ➤“Changing Your View” in 
Chapter 1, “Overview of Expression.”

In Wireframe view, a colored line indicat-
ing the path, is superimposed on the wire-
frame. 

Path view, object is shown by its path

B-Spline
line indi
controls

If your P
handles
corner o
taining t

Preview 
painted 
sed to resize the object. 

sformation handles are the center 
. These can be used to skew or 
e selected object or nodes, 

ng on whether or not a modifier 

andles on a selected object.
Selected Objects

In all selected objects, all points are visible, 
each represented by a small, filled square. 
The last node is always represented by an 
arrowhead indicating the direction of the 
path.

In Path view, a selected path is shown as a 
colored line. Set selection colors for each 
layer by choosing Arrange menu> 
Layer> Info. 

In Preview view, a colored line indicating 
the path, is superimposed on the color pre-
view of the object.

No Bézier tangent handles are visible when 
the entire object is selected. Handles are 
only displayed when individual points 
(nodes) are selected.

Wireframe view, the path is shown by its 
unfilled outline, including any Skeletal Stroke 
outlines.

can be u

The tran
handles
rotate th
dependi
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•

 

Drag the double arrows to skew the 

      

The beginning and ending points on a clone 

      

Transforming Objects

 

ormation is a general term that 
to changes or modifications to a path 
 not involve adding, removing or 
 points. The object remains the 
asic shape but is moved, scaled, 
, mirrored or skewed. Transforma-

re done by dragging the object’s 
s. You are given a real-time preview 
changes as you drag. Or use the 
ormation palette to make your 
s numerically.

 

ng Objects

 

are two methods for moving objects 
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object.

• Drag the double arrows while holding 
down the Shift key to rotate the object.

A selected text object is shown with its 
baseline.

Selected Text on a Path is shown with point 

Transformation handles on a selected object.

object are displayed as filled circles. You 
can not edit the shape of a clone object.

Selected Points

The path is displayed, as described above, 
depending on view quality you have set.

Selected points are represented by a large 
filled square.

Selected clone object.

Transf
refers 
that do
editing
same b
rotated
tions a
handle
of the 
Transf
change

Movi
There 
ession. You can move selected 
s and points manually using the 
, or you can enter specific distances 
e Transformation palette.

ve an object manually: 

g the Object Selection or Node 
ction tools from the Tools toolbar, 
ct the object(s) or point(s) you want 
ove.

 selected object(s) or point(s). A 
time preview appears as you move 
bject(s). 
of origin and baseline. 

Selected text object and text on a path.

Bézier points show tangent handles.

Unselected Points

Unselected point is represented as a hollow 
square. 

Selected and unselected points.

in Expr
object
mouse
into th

To mo

1Usin
Sele
sele
to m

2Drag
real-
the o
ase the mouse button after the 
ct or points are repositioned. 
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ay also be applied to individual points on a 

 

ell as the whole path. 

 

 using the Resize handles:

  

 the 

 

Object Selection

 

 tool from the 

  

toolbar, select the object you wish 
le.

  

he corner Resize handles to resize 
ject. Use the 

 

Shift

 

 key to resize 
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To move an object using the 
Transformation palette:

1Using the Object Selection or Node 
Selection tools from the Tools toolbar, 
select the object(s) or point(s) you want 
to move.

2If the Transformation palette is not 
displayed, choose Window menu> 

Transformation. The Transformation 
palette appears. 

3Click the Translate tab. The attributes for 
moving objects appear in the palette.

Scaling Objects
These settings increase or decrease the 
distance between selected points along the 
x and y axes. Scaling is proportional along 
the specific axis but a different scaling fac-
tor may be applied to each axis. Scaling is 
applied relative to the point you select to 
serve as anchor or remain stationary dur-
ing the scaling operation.

In addition to scaling selected objects using 
the Resize handles, scaling can be done 
using the Scale tool or the Transformation 
palette. 

Scaling m
path as w

To scale

1Using
Tools 
to sca

2Drag t
the ob
bject proportionally. 

our object using a selection tool.
4Enter distances in the X and Y axis or use 
the up and down arrows to scroll 
through the numbers.

5Click Apply to apply selections to the 
selected object or click Duplicate to 
create a copy with the translation 

The Transformation palette, Translate tab.

Original

Free

Proportional

Selected Anchor

your o
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rranging and Editing Objects 137
Chapter 6 • A

applied to the copy.

Scaling objects in Expression.



              

2If the Transformation palette is not Rotating Objects
n also change the angle of any 
d path. The distance between points 
hanged. You can rotate around the 

’s center or simply click to set a dif-
center of rotation.

n rotate objects using the transfor-
 handles, the Rotation tool or the 
ormation palette. 
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To scale an object using the Scale tool:

1Using the Object Selection tool from the 
Tools toolbar, select the object you wish 
to scale.

2Click the Transformation Tools icon from 
the Tools toolbar and choose the Scale 
tool. 

3Click to set the center point for scaling. If 

The Scale tool.

displayed, choose Window menu> 

Transformation. The Transformation 
palette appears. 

3Click the Scale tab. The attributes for 
scaling objects appear in the palette. 

The Transformation palette, Scale tab.

You ca
selecte
is not c
object
ferent 

You ca
mation
Transf
ate an object using the 
ormation handles:

g the Object Selection tool from the 
s toolbar, select the object you wish 
tate.

 before and after rotating.
no center point is set, the center of the 
object becomes the scale center.

4Drag to scale. Hold down the Shift key 
while dragging to scale the object 
proportionately.

5Release the mouse button to set the 
scale.

To scale an object using the 
Transformation palette:

1Using the Object Selection tool from the 
Tools toolbar, select the object you wish 
to scale.

4In the Center entry boxes, enter the 
location of center point for scaling 
transformation. 

5In the Scale entry box, enter the 
percentage of scaling for the X and Y 
axis. 

6Click Apply to apply selections to the 
selected object or click Duplicate to 
create a copy with the scale applied to 
the copy.

To rot
transf

1Usin
Tool
to ro

Objects
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the Rotate tab. The attributes for 
ng objects appear in the palette. 

 Center entry boxes, enter the 
on of center point for rotating 
ormation. 

sformation palette, Rotate tab.

Ch06.FM5  Page 139  Thursday, November 7, 1996  12:03 PM
2Drag the bounding box side handle while 
holding down the Shift key. The object is 
rotated using the center of the bounding 
box as the rotation center. 

3Release the mouse button to set the 

Rotating objects.

3Click to set the center of rotation. If no 
center point is set, the center of the 
object becomes the center of rotation.

4Drag to rotate. A set of lines and an arc 
appear as you drag, indicating the 
rotation as well as a preview. Hold down 
the Shift key while dragging to constrain 
the rotation angle as set in File menu> 
Preferences.

5Release the mouse button to finish the 
rotation.

To rotate an object using the 
Transformation palette:

3Click 
rotati

4In the
locati
transf

The Tran
 Angle entry box, enter the rotation 
 

Apply to apply selections to the 
ed object or click Duplicate to 
 a copy with the rotation applied 
 copy.
rotation.

To rotate an object using the Rotation 
tool:

1Using the Object Selection or Node 
Selection tools from the Tools toolbar, 
select the object you wish to rotate.

2Click the Transformation Tools icon from 
the Tools toolbar and choose the 
Rotation tool. 

1Using the Object Selection tool from the 
Tools toolbar, select the object you wish 
to rotate.

2If the Transformation palette is not 
displayed, choose Window menu> 

Transformation. The Transformation 
palette appears. 

5In the
angle.

6Click 
select
create
to the
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The Rotation tool.



Mirroring Images 2If the Transformation palette is not 
layed, choose Window menu> 

sformation. The Transformation 
tte appears. 

 the Mirror tab. The attributes for 
oring objects appear in the palette.

ansformation palette, Mirror tab.
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Mirroring inverts the position of each point 
in the selection, creating a mirror image 
based on the object’s center point or any 
point of reflection you set. 

To reflect or mirror using the Mirror 
tool:

1Using the Object Selection tool from the 
Tools toolbar, select the object you wish 
to mirror.

2Click the Transformation Tools icon from 
the Tools toolbar and choose the Mirror 
tool. 

The Mirror tool.

disp
Tran

pale

3Click
mirr

The Tr
e Center entry boxes, enter the 
tion of center point for mirroring 
sformation. 

e Angle entry box, enter the angle of 
ction. 

 Apply to apply selections to the 
cted object or click Duplicate to 
te a copy with the mirroring applied 
e copy.
Objects before and after mirroring.

3Click to set the center point of reflection. 
If no center point is set, the center of the 
object becomes the point of reflection.

4Drag to reflect the object. Hold down the 
Shift key while dragging to constrain the 
angle of the reflection axis.

5Release the mouse button to set the 
reflection.

To mirror an object using the 
Transformation palette:

1Using the Object Selection tool from the 
Tools toolbar, select the object you wish 

4In th
loca
tran

5In th
refle

6Click
sele
crea
to th
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o set the shear axis point. If no axis 
is set, the center of the object 
es the axis point.

o shear the object. Hold down the 
ey while dragging to constrain the 
of the shear plane.

se the mouse button to set the 
.

r an object using the 
rmation palette:

 the Object Selection tool from the 
toolbar, select the object you wish 
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Shearing Objects
You can think of shearing as the way an 
image printed on the edges of a book can 
be distorted by pulling the book at an 
angle. The original image is contained in an 
imaginary rectangle. Once sheared, that 
rectangle has been changed to a parallelo-
gram with the image distorted appropri-
ately. 

Shearing changes the angular relationship 
between each point in the selection and a 
specific point on the shear axis. A given 
point’s shear anchor point is the point on 
the shear axis nearest to the point’s origi-
nal position. You specify the shear axis 
(plane) and shear angle. 

more information on setting preferences, 
see ➤“Options Tab” in Chapter 1, “Over-
view of Expression.”

2Drag one of the transformation handles. 
Drag the top or bottom handles to skew 
horizontally. Drag the side handles to 
skew vertically. The object is sheared in 
the direction of the drag. 

Shearing objects.

3Click t
point 
becom

4Drag t
Shift k
angle 

5Relea
shear

To shea
Transfo

1Using
Tools 
ar.

Transformation palette is not 
yed, choose Window menu> 

formation. The Transformation 
e appears. 

the Shear tab. The attributes for 
ing objects appear in the palette. 
To shear an object using the 

transformation handles:

1Using the Object Selection tool from the 
Tools toolbar, select the object you wish 
to shear.

The Show resize handles preference in 
the Preference’s Options tab must be 
enabled to show the Resize handles. For 

Objects before and after shearing.

3Release the mouse button to set the 
shear.

To shear an object using the Shear tool:

1Using the Object Selection tool from the 
Tools toolbar, select the object you wish 
to shear.

2Click the Transformation Tools icon from 
the Tools toolbar and choose the Shear 
tool. 

to she

2If the 
displa
Trans

palett

3Click 
shear
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4In the Center entry boxes, enter the Changing Perspective replaced by the Perspective Control 
e, the smallest box that can enclose 
bject and all its handles, with small 

es at each corner.

 the corner circles to arrange the 
pective Control Frame to the size 
shape of your object.

rspective tool.
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location of center point for shearing 
transformation. 

5In the Angle entry box, enter the angle of 
shear. 

6In the Plane entry box, enter the degree 
of plane.

7Click Apply to apply selections to the 
selected object or click Duplicate to 
create a copy with the shear applied to 
the copy.

Shearing a Stroke

You can also adjust the shear of a Skeletal 
Stroke by adjusting the shear/width handle 

Expression’s Perspective tool allows you to 
quickly change the perspective of your art-
work. This tool is especially helpful to edit 
an object which already has some perspec-
tive. Take for example, the image of a 
child’s ABC block. In order to view this 
block from a different angle, you must set 
the Perspective Control Frame to the shape 
of one side of the cube, then use the Active 
Perspective Frame to change the angle.

The object’s Perspective Frame may be 
considered to be a piece of imaginary 
paper with your artwork on it. The Perspec-
tive Control Frame can be edited when it is 
displayed with small circles at each cor-
ner.Click anywhere with the Perspective 

Fram
the o
circl

 

3Drag
Pers
and 

The Pe
e the Perspective Control Frame to the 
 your object.
or the Shear slider in the Paint Style pal-
ette. The Shear/Width handle and the Shear 
slider adjust the shear of the Skeletal 
Stroke in relation to the path to which it is 
applied. The Shear tool, the transformation 
handles of the bounding box and the Shear 
tab of the Transformation palette adjust 
the shear of the path itself.

For more information on changing the 
shear of a stroke, see ➤“Shearing the 
Stroke” in Chapter 5, “Applying Strokes and 
Fills.”

tool to change the Perspective Control 
Frame into the Active Perspective Frame, 
represented by larger circles at each cor-
ner. When the Active Perspective Frame is 
available changes you make will transform 
the artwork. Click to toggle back and forth 
between the Perspective Frame and the 
Active Perspective Frame. 

To add perspective to an object:

1Using the Object Selection tool from the 
Tools toolbar, select the object whose 
perspective you wish to change.

2Click the Transformation Tools icon from 

Arrang
size of
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the Tools toolbar and choose the 
Perspective tool. The Resize handles are 



e Arrange menu> Repeat Last 
formation. The last 
ormation is applied again to the 
t selection.
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4Click anyplace to change to the Active 
Perspective Frame.

Click on the object to change to the Active 

Transformation Shortcuts
Expression’s Arrange menu also has some 
functions that assist you in using the Trans-
formation tools. You can repeat, undo and 
make transformations permanent.

To repeat last transformation:

1Using the Object Selection tool from the 
Tools toolbar, select an object.

2Transform the object using any of the 
methods described above.

4Choos
Trans

transf
curren
transforming an object two or more 
 you can quickly apply all the accu-
ed transformations to that object 
ther selection.

at Accumulated Transform:

 the Object Selection tool from the 
toolbar, select an object.

form the object several times using 

he transformation.

5Drag the corner handles of the Active 

Perspective frame to apply perspective.

Perspective Frame.

Drag the Active Perspective handles to apply 
perspective. 

3Select a different object or leave the 
original object selected.

Transform your object.

After 
times
mulat
or ano

To repe

1Using
Tools 

2Trans

Repeat t
rranging and Editing Objects 143

f the methods described above.
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3Select a different object or leave the Grouping and Ungrouping 
cts

ing allows you to designate a set of 
s to be treated as a single object. Any 
wo or more objects, even groups, 
 grouped. Any group can be 
ped. 

xpression operations can be applied 
ouped object. For example, if you 
a group, then apply a paint attribute 
group, the attribute is assigned to 
lement within the group.

er, individual objects and points 

Ch06.FM5  Page 144  Thursday, November 7, 1996  12:03 PM
original object selected.

4Choose Arrange menu> Repeat 
Accumulated Transform. The selected 
object is transformed in the same 
manner as the original object selected in 
step one, using the same reference point 
for transformations that require a 
reference point.

If you transform an object then later 
decide you do not want the transforma-
tion you can reset the object to its origi-
nal state.

To commit to transformation(s):

1Using the Object Selection tool from the 
Tools toolbar, select an object that has 
been transformed using any of the 
methods described above.

2Choose Arrange menu> Commit 
Transform. The object does not change 
appearance. However, if you continue to 
transform the object then later select 
Reset Transform the object returns to 
this committed state rather than the 
original state.

Obje

Group
object
set of t
can be
ungrou

Most E
to a gr
select 
to the 
each e

Howev

 a group can not be selected sepa-
with the Object Selection tool. To 
individual objects within a group you 
o use the Group Selection tool. To 
individual points within a group use 
de Selection tool. 

up object:

g the Object Selection tool from the 
s toolbar, select the objects you 
t to group. You can click and Shift-

oup Selection tool.
To Reset Transform:

1Using the Object Selection tool from the 
Tools toolbar, select an object that has 
been transformed using any of the 
methods described above.

2Choose Arrange menu> Reset 
Transform. The object is returned to its 
original state.

After you transform an object you can 
commit to the new state before continu-
ing. In that case, the Reset Transform will 
return the object to the state it was when 
you committed to it.

within
rately 
select 
need t
select 
the No

To gro

1Usin
Tool
wan

The Gr
 or drag a marquee to select objects.
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ing objects.
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2Choose Arrange menu> Group or 
press Command/Ctrl+G.

To ungroup objects:

1Using the Object Selection tool from the 
Tools toolbar, select the group of objects 
you want to ungroup. 

2Choose Arrange menu> Ungroup or 
press Command/Ctrl+U.

Duplicating Objects

You can create an exact copy of any object 
by duplicating it. You can duplicate by giv-
ing an explicit command or during a trans-
formation, transforming only the duplicate 
while leaving the original untouched.

To duplicate an object:

1Using the Object Selection tool from the 
Tools toolbar, select the object(s) you 
want to duplicate. 

Duplicat
icate an object while 
rming:

 the Object Selection tool from the 
toolbar, select the object you want 
nsform. Transform means to 
ate (move), rotate, scale, mirror or 
 an object. For more information on 
orming objects, see 
nsforming Objects” earlier in this 

er.

own the Option (Macintosh) or Alt 
ows) key while transforming the 

t. The original remains untouched 
 duplicate is created and 
ormed.
2Choose Edit menu> Duplicate or press 
Command/Ctrl+D. The original object is 
copied and the copy is offset from the 
original. 

If the object you duplicate is an object 
which is itself a clone, the new copy 
reflects the attributes of the original mas-
ter object, but is not itself a clone. 

To dupl
transfo

1Using
Tools 
to tra
transl
shear
transf
➤“Tra
chapt

2Hold d
(Wind
objec
and a
transf
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Cloning Objects

 and a duplicate of a clone.
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Transforming and duplicating objects.

A clone is similar to a duplicate, but a clone 
maintains a link with the original or master 
object. A clone may be made from any 
path. Whenever the master object is edited 
(except for transformations and paint 
style) the clone is updated. 

A clone may be transformed and its paint 
style may be edited, but it can not be 
edited in any other way. A clone is repre-
sented on screen with only the node(s) at 
its ends visible and these nodes are dis-
played as filled circles. 

A clone
ne an object:

g the Object Selection tool from the 
s toolbar, select the objects you 
t to clone. 

ose Edit menu> Clone or press 
mand/Ctrl+K.

 can not edit the shape of a clone 
ct. Editing the shape of the master 
 the shape of the clone in the same 

ner. Editing the paint style of the 
ter object does not change the paint 
 of the clone.

 can change a clone into a master 
You can also use the Transformation palette to 
make your changes then click the Duplicate button.

If you duplicate a clone you get a duplicate 
of the master object including the Paint 
Style from the master object.

An original and a clone object.

To clo

1Usin
Tool
wan

2Cho
Com

You
obje
edits
man
mas
style

You

ct, which can then be edited by 
king the link between the master 
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rranges selected objects along the 
 axis with a user-specified gap 
 the objects bounding boxes. The 
ap size is 0 pts. 

ng Objects
ression’s Align function to arrange 
exactly in relation to each other. 
nt is always based on the object’s 

 objects.
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object and the clone. Once the link is 
broken it can not be restored except by 
using Edit menu> Undo immediately.

To break link between master object and 
selected clone:

1Using the Object Selection tool from the 
Tools toolbar, select the clone object.

2Choose Object menu> Convert To 
Path. The selected clone is no longer 
linked to the master. You can now edit 
the shape of the object. Further changes 
to the master object do not affect the 
former clone.

Arranging Objects

Expression provides several arrangement 
functions so you can quickly position 
selected objects in relation to each other. 
Arranging applies to objects, not individual 
points. All arrangement operations work 
along the document’s horizontal and verti-
cal axes and are based on the objects’ rect-
angular bounding boxes.

There are three different arrangement 
operations that you can use with objects:

Align Arranges selected objects based on 
a particular line. 

Stack A
specified
between
default g

Aligni
Use Exp
objects 
Alignme

Stacking
g box. A bounding box is the small-
ngle that can enclose the entire 

r group, including it’s tangent han-
 shear/width handle.

s six variations:

[

efore aligning. 
Distribute Arranges selected object equi-
distant from each other between the two 
extreme objects. 

Aligning objects.

boundin
est recta
object o
dles and

Align ha

Objects b
rranging and Editing Objects 147
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Top The topmost selected object Left The leftmost selected object remains Vertical Center All of the selected objects 
ved vertically so that their centers 
ned with the original center of the 

le selection. 

ntal Center All of the selected 
s are moved horizontally so that 
enters are aligned with the original 

g objects, vertical center.
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remains stationary while the other selected 
objects are moved vertically so that their 
tops align with the topmost object’s top 
edge. 

Bottom The bottommost selected object 
remains stationary while the other selected 
objects are moved vertically so that their 

Aligning objects, top.

stationary while the other selected objects 
are moved horizontally so that their left 
edges align with the left-most object’s left 
edge. 

Right The rightmost selected object 
remains stationary while the other selected 
objects are moved horizontally so that 

Aligning objects, left.

are mo
are alig
multip

Horizo
object
their c

Alignin
 of the multiple selection. 

n objects:

g the Object Selection tool from the 
s toolbar, select two or more objects 
want to align.

g objects, horizontal center.
bottoms align with the bottommost 
object’s bottom edge. 

Aligning objects, bottom.

their rights align with the right-most 
object’s right edge. 

Aligning objects, right.

center

To alig

1Usin
Tool
you 

Alignin
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tal Centers: The leftmost and right-
lected objects remain stationary 
e other selected objects are moved 
ally so that the centers of all the 
 objects are evenly spaced. 

ing objects, horizontal center.
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2If the Alignment palette is not displayed, 
choose Window menu> Alignment. 
The Alignment palette appears.

Align left

Align center

Align right

Align top

Align center

Align bottom

Distributing Objects
Use Expression’s distribute function to 
evenly space selected items in relation to 
each other. Distribution is especially useful 
for creating images such as a picket fence 
or railroad track. 

Distribute has six variations:

Horizontal Distribution

Horizon
most se
while th
horizont
selected

Distribut
tal Rights The leftmost and right-
lected objects remain stationary 
e other selected objects are moved 
ally so that the right edges of all 

cted objects are evenly spaced.  

ing objects, rights.
3Click on the Vertical and Horizontal 
Align icons to select the type of 
alignment you prefer.

You can also choose Arrange menu> Align 
to select the alignment you want.

The Alignment palette

Horizontal Lefts The leftmost and right-
most selected objects remain stationary 
while the other selected objects are moved 
horizontally so that the left edges of all the 
selected objects are evenly spaced. 

Horizontal distribution, before. 

Horizon
most se
while th
horizont
the sele

Distribut
rranging and Editing Objects 149
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Vertical Distribution Vertical Centers The topmost and bot-

tribute objects:

g the Object Selection tool from the 
s toolbar, select three or more 
cts you want to distribute.

e Alignment palette is not displayed, 
se Window menu> Alignment. 
Alignment palette appears.

Dist. left

Dist. center

Dist. right
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Vertical Tops The topmost and bottom-
most selected objects remain stationary 
while the other selected objects are moved 
vertically so that the tops of all the selected 

Vertical distribution, before. 

tommost selected objects remain station-
ary while the other selected objects are 
moved vertically so that the centers of all 
the selected objects are evenly spaced.  

Distributing objects, vertical center.

To dis

1Usin
Tool
obje

2If th
choo
The 
 on the Vertical and Horizontal 
ribute icons to select the kind of 
ibution you prefer.

ignment palette.

Dist. top

Dist. center

Dist. bottom
objects are evenly spaced. 

Distributing objects, top.

Vertical Bottoms The topmost and bot-
tommost selected objects remain station-
ary while the other selected objects are 
moved vertically so that the bottoms of all 
the selected objects are evenly spaced. 

3Click
Dist
distr

The Al
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e leftmost object remains station-
e the other selected objects are 
orizontally so that there is a hori-

ap of the specified distance 
 each pair of neighboring objects. 

he rightmost object remains sta-
hile the other selected objects are 

 objects, left.
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You can also choose Arrange menu> 
Distribute to select the distribution you want.

Stacking Objects
Use Expression’s stack function to arrange 
two or more objects so there is gap of a 
specified distance between their bounding 
boxes. Set the gap to zero when you want 
objects to touch but not overlap.

To set the gap size, choose File> Prefer-
ences. For more information on setting 
preferences, see ➤“Setting Preferences” in 

Bottom (Down) The topmost object 

Stacking objects, up.

Left Th
ary whil
moved h
zontal g
between

Right T
tionary w

Stacking
orizontally so that there is a hori-
ap of the specified distance 
 each pair of neighboring objects. 

 objects, right.
Chapter 1, “Overview of Expression.”

Stack has four variations:

Top (Up) The bottom-most object 
remains stationary while the other selected 
objects are moved vertically so that there 

Objects before stacking. 

remains stationary while the other selected 
objects are moved vertically so that there 
is a vertical gap of the specified distance 
between each pair of neighboring objects. 

moved h
zontal g
between

Stacking
rranging and Editing Objects 151
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is a vertical gap of the specified distance 
between each pair of neighboring objects.

Stacking objects, down.



You can use the Arrange menu> Layer 
nd or the Layers palette to maintain 
yers. To display the Layers palette, 
 Window menu> Layers. 

ng New Layers

 can be added and used to control 
 of objects at once.

yers palette.
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To stack:

1Using the Object Selection tool from the 
Tools toolbar, select two or more objects 
you want to stack.

2If the Alignment palette is not displayed, 
choose Window menu> Alignment. 
The Alignment palette appears.

Stack right

Stack left

You can also choose Arrange menu> Stack 
to select a stacking method.

Layering Objects
Each Expression document consists of one 
or more layers. A layer may contain any 
number of objects and every object is 
assigned to a specific layer although you 
can change its layer. 

Layers are ordered from front to back with 
back layers being drawn first and front lay-
ers being drawn last, possibly obscuring 

comma
your la
choose

Creati

Layers
groups

The La
ate a new layer:

e Layers palette is not displayed, 
se Window menu> Layers. The 
rs palette appears.

 the icon above the scroll bar to 
ss the Layers pop-up menu (shown 
e) and choose New from the menu. 
new layer is placed at the front of 
ayering order and becomes the 
ent layer.
3Click on the Vertical and Horizontal 
Stack icons to select the type of stacking 
you prefer.

The Alignment palette.

Stack bottom

Stack top

parts of back layers. Use this feature to 
control the appearance of the image. You 
can create and delete layers, assign names 
to layers, lock them, and change the dis-
play quality of specific layers. 

Any object on any unlocked layer may be 
selected and manipulated. A multiple selec-
tion may include objects on several differ-
ent layers. Adding additional objects to a 
selection does not change the currently 
active layer. 

Removing objects from a multiple layer 
selection may change the currently active 
layer. If all remaining objects are from a sin-
gle layer, that layer becomes the current 
layer.

To cre

1If th
choo
Laye

2Click
acce
abov
The 
the l
curr
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ect Visible. Hiding a layer 
atically locks the layer as well. A 

r Info dialog.
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You can also choose Arrange menu> Layer> 
New. 

Deleting a Layer

Delete a layer when you want to remove all 
objects on a layer at one time.

To delete layer:

1If the Layers palette is not displayed, 
choose Window menu> Layers. The 

Hiding Layers

Layers can be hidden on your Workspace. 
This is useful if you do not want objects on 
the layer to be visible on the screen, you 
want to work on layers partially covered by 
other layers or you do not want certain lay-
ers to print.

To hide a layer:

1If the Layers palette is not displayed, 
choose Window menu> Layers. The 
Layers palette appears.

2Click the name of the layer you want to 
hide.

4Desel
autom

The Laye
n layer does not display on screen, 
es it print.

ayers palette, click on the eye icon next to 
ou want to hide. Click again to display the 
Layers palette appears.

2Click the name of the layer you want to 
delete.

3Click the icon above the scroll bar and 
choose Delete from the menu. The layer 
as well as all objects on that layer are 
removed. Undo is possible.

You can also choose Arrange menu> Layer> 
Delete. 

3Click the icon above the scroll bar and 
choose Info from the menu. The Layer 
Info dialog appears.

You can also choose Arrange menu> Layer> 
Info. 

hidde
nor do

From the L
the layer y
layer.
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Locking Layers

e Layers palette, click on the lock icon next 
yer you want to unlock. 

ing the Active Layer

 objects are created on the active 
hen you want to add an object to a 

lar layer, make it the active layer.

nge the currently active layer:

e Layers palette is not displayed, 
se Window menu> Layers. The 
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Layers can be locked to prevent accidental 
changes to a layer.

 To lock a layer:

1If the Layers palette is not displayed, 
choose Window menu> Layers. The 
Layers palette appears.

2Click the name of the layer you want to 
lock.

3Click the icon above the scroll bar and 
choose Info from the menu. The Layer 
Info dialog appears.

From the Layers palette, click on the lock icon next 
to the layer you want to lock. Click again to unlock 
the layer.

Unlocking Layers

Locked layers must be unlocked in order to 
edit or move objects within the layer.

To unlock a layer:

1Click the icon above the scroll bar and 
choose Info from the menu. The Layer 

From th
to the la

Chang

All new
layer. W
particu

To cha

1If th
choo
rs palette appears.

ct a layer you want to make active 
 the Layers palette.

te new objects as needed. New 
cts are automatically placed on the 
cted layer.
You can also choose Arrange menu> Layer> 
Info. 

4Click Locked. The objects in that layer 
cannot be moved or changed until you 
unlock the layer.

Info dialog appears.

2Click the name of the layer you want to 
unlock.

You can also choose Arrange menu> Layer> 
Info. 

3Deselect Locked. 

Laye

2Sele
from

3Crea
obje
sele
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g Paths

lected path with the following 

Selection tool

rt Node tool 

e tools.

election

vert Node
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Naming Layers

Layers can be named to help organize your 
document.

To name layer:

1If the Layers palette is not displayed, 
choose Window menu> Layers. The 
Layers palette appears.

2Choose Arrange menu> Layer> Info. 
The Layer Info dialog appears.

3Highlight current name and type new 
name.

Changing the Selection Color

Each layer is identified by its own color. 
This color appears as an outline on any 
selected object within a layer. The selec-
tion color can be changed as needed to 
assist you in identifying different layers.

To change selection color:

1If the Layers palette is not displayed, 
choose Window menu> Layers. The 
Layers palette appears.

2Choose Arrange menu> Layer> Info. 
The Layers palette appears. 

Editin

Edit a se
tools:

• Node 

• Conve

The Nod

Node S

Con
ode tool

 Node tool

ath tool

se Path tool

e Start Point tool 

 tools.

de

 Node

Split Path

Reverse Path

Change Start 
Point
4Click OK.

From the Layers palette, double-click on the layer 
name to display the Layer Info dialog. Change the 
name as described above.

3Drag Red, Green, Blue sliders to set new 
color.

From the Layers palette, double-click on the layer 
name to display the Layer Info dialog. Change the 
color as described above.

• Add N

• Delete

• Split P

• Rever

• Chang

The Path

Add No

Delete
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Selecting and Moving Points • Drag the point’s tangent handle or an • Drag a B-Spline control line point to 
sition it. 

ging Point Continuity
sion gives you several choices for 

havior of tangent handles when you 
iting. This makes it easier for you to 
ur paths just the way you want to. 

 B-Spline control point to reposition.
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The Node Selection tool lets you select a 
particular point along a path. Selected 
points are shown as filled squares. Use this 
tool also to manipulate tangent handles to 
alter the shape of your path.

• Using the Node Selection tool from the 
Tools toolbar, select a point. A selected 
point is displayed as a large filled square 
and its tangent handles as well as the 
tangent handles before and after the 
point, if any, are also displayed. 

adjacent line segment to edit the shape of 
the path. 

Tangent handle behavior depends on the 
assigned Node Continuity. For more 
information on changing tangent han-
dles, see ➤“Changing Point Continuity” 

Drag a point’s tangent handle to reshape.

repo

Chan
Expres
the be
are ed
edit yo

Drag a
r preference by selecting Edit 
 Node Continuity Mode or by 

g on the preferred button in the 
s toolbar. 

t a toolbar not currently visible choose 
w menu> Toolbars. 

etrical Angle Locked
• Drag the Bézier point to reposition it. 

Select a point.

Drag a Bézier point to reposition

following. The default Node Continuity is:

Freehand and Smoothed Polyline 
tools Smooth

Pen tool Symmetrical

Polyline tool Unconstrained

Set you
menu>

clickin
Action

To selec
Windo

Symm
ne Continuity controls.

Smooth Unconstrained
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strained Moving one tangent 
e does not change the position of 
her tangent handle at all. 

rting Points
vert Node tool changes a corner 
ith tangent handles pulled in, into a 
int with tangent handles visible for 

ained continuity.
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To set node continuity:

1Using the Node Selection tool from the 
Tools toolbar, select an object you want 
to edit.

2Select the point you want to change. The 
point becomes a larger solid square. 

Select the node you want to change.

Smooth As you move one tangent han-
dle the other handle remains opposite 
but the distance between the point itself 
and the other handle is not changed. 

Angle Locked As you move one tangent 
handle, the other handle moves so that 
the angle between the two handles is 
maintained. 

Smooth continuity.

Uncon
handl
the ot

Conve
The Con
point, w
curve po

Unconstr
ation. The same tool changes a 
int, with tangent handles visible, 
rner point with tangent handles 

d. It also changes the Node Conti-
en used on a tangent handle.

n a Bézier curve point to retract 
he preceding and following tangent 
es, turning it into a Bézier corner 

 standard B-Spline point to turn it 
 B-Spline cusp point.

 standard B-Spline cusp point to 
 into a standard B-Spline point.

n a Bézier corner point to turn it 
3Choose Edit menu> Node Continuity 
or click the preferred button in the 
Actions toolbar.

Symmetrical Tangent handles remain 
opposite each other and equidistant 
from the point itself. 

Symmetrical continuity.

Angle Locked continuity.

manipul
curve po
into a co
retracte
nuity wh

• Click o
both t
handl
point.

• Click a
into a

• Click a
turn it

• Drag o
rranging and Editing Objects 157

 Bézier curve point and show its 
t handles.
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The drag gesture determines the posi- For more information on constraints, see 

end an existing open path:

ct the drawing tool you want to use 
tend a path from the Tools toolbar.

tion the cursor over the beginning or 
point of an open path. A tilde (~) is 
d to the cursor indicating that any 
n will extend the line. 
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tions of the new tangent handles, just as 
drag behaves when drawing with the Pen 
tool.

Hold down the Shift key while dragging 
to constrain the angular relationship 
between the opposite tangent handle 
and the Bézier point.

Hold down the Option/Alt key before or 
during the drag gesture to lock the oppo-
site tangent handle in its current posi-
tion: the drag thus affects the position of 
one tangent handle only. If you release 
the Option/Alt key before releasing the 
mouse button, the opposite tangent han-
dle snaps back into the position symmet-

➤“Changing Point Continuity” earlier in 
this chapter.

Adding Points
The Add Node tool allows you to add addi-
tional points to an existing path segment. 

To add additional points between 
existing points: 

1Click the Path Tools icon in the Tools 
toolbar and choose the Add Node tool. 

To ext

1Sele
to ex

2Posi
end 
adde
actio
 or drag on an end or beginning 
t to continue creating the path. 

n possible to create a path with B-Spline 
 for part of the shape and Polyline or other 
 for a different part of the path.

rsor changes when positioned over an 
beginning point.
rically opposite the tangent handle you 
have moved.

• Drag on a tangent handle to change its 
position or move it. This action causes 
the path segment to change. 

If the initial constraint is Unconstrained, 
the constraint is changed to Symmetri-
cal. The two tangent handles are oppo-
site each other and move appropriately 
as you drag.

If the initial constraint is Symmetrical, 
Smooth or Angle Locked the constraint is 
changed to Unconstrained and the tan-
gent handles move independently of 

2Click on a path segment. 

Adding a point to a B-Spline path con-
verts the path to a Bézier path. 

Adding a point to an existing path seg-
ment does not affect the shape of the 
path. 

Clicking on a point has no effect. 

The Add Node tool. 

3Click
poin

It is eve
controls
controls

The cu
end or 
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sing Path Direction

e beginning point and the direction 
 are important considerations in 
 apply Skeletal Strokes, Expression 
ou to define which point is the 
g point as well as set the direction 
.

ing the Starting Point
sed path such as a rectangle or cir-
 may want to change the starting 
r your path. This affects the way 
Strokes are applied to the path.
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Deleting Points
The Delete Node tool allows you to remove 
points from an existing path segment.

To delete a point:

1Using the Object Selection tool from the 
Tools toolbar, select an object.

2Click the Path Tools icon in the Tools 
palette and choose the Delete Node tool.

The Delete Node tool. 

2Click the Path Tools icon in the Tools 
toolbar and choose the Split Path tool. 

3Click on a path segment to define the 
point to split. The path splits at the point 
of the click.

The Split Path tool.

Rever

Since th
of a path
how you
allows y
beginnin
of a path

Chang
On a clo
cle, you
point fo
Skeletal 
t a different start point on a 
hape:

 the Object Selection tool from the 
toolbar, select an object. 

 object.
3Click on a point. The point is removed 
and the shape of the path changes 
accordingly.

Splitting Paths
The Split Path (scissors) tool allows you to 
split an existing open path into two paths, 
or to open an existing closed path.

To split a path:

1Using the Object Selection tool from the 
Tools toolbar, select an object.

Click on the path segment to split the path.

To selec
closed s

1Using
Tools 

Select an
rranging and Editing Objects 159
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2Click the Path Tools icon in the Tools Changing the Path Direction 3Click the path you want to reverse. The 
 arrow changes direction. If a 
etal Stroke was applied to the path, 
troke also reverses direction. 

 also choose Objects menu> 
se Path to reverse the direction of a path.

ection of the path is changed.
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palette and choose the Change Start 
Point tool. 

3Click at the desired start point.

If there is no existing point at the place 
you wish to designate as the new start 
point use the Add Point tool to add a 
point then use the Change Start Point 
tool to select the new point.

Using the Change Start Point tool on an 

The Change Start Point tool.

Expression allows you to change the direc-
tion of your path. This is especially useful 
with Skeletal Strokes that are not symmetri-
cal.

There may be times when you want to 
reverse the direction of a path and other 
times when what you really want to do is 
mirror the image. For additional informa-
tion on mirroring, see ➤“Mirroring 
Images,” earlier in this chapter.

To change the direction of the path:

1Using the Object Selection tool from the 
Tools toolbar, select an object. 

path
Skel
the s

You can
Rever

The dir
open path causes the path to become 
closed. 

The starting point is now more appropriate.

2Click the Path tools icon in the Tools 
toolbar and choose the Reverse Path 
tool. 

Select an object.
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The Reverse Path tool.



erting Objects to 
r Paths

ay be instances when it would be 
 start out with a regular text or 

bject, such as a letter or an ellipse, 
vert it to a Bézier path (or paths). 
ws you to have more control over 
e of an object.

ert an ellipse or text object to 

 the Object Selection tool from the 
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Unstructuring Objects

Expression allows you to take a Skeletal 
Stroke that has already been applied to a 
path and unstructure the stroke so you can 
edit its shape.

Before you can unstructure a stroke 
applied to text, you must first convert the 
text to a path using the Convert to Path 
command. For more information on con-
verting text to a path, see ➤“Converting 
Objects to Bézier Paths,” later in this chap-
ter.

2Choose Object menu> Unstructure. 
The Skeletal Stroke is converted to a 
path or group of paths that you can now 
edit. 

An unstructured object.

Conv
Bézie

There m
easier to
shape o
then con
This allo
the shap

To conv
Bézier:

1Using

toolbar, select an ellipse or text 
t. 

 ellipse or text object.
To unstructure a stroke:

1Using the Object Selection tool from the 
Tools toolbar, select an object with a 
Skeletal Stroke. 

Select an object containing a Skeletal Stroke.

Tools 
objec

Select an
rranging and Editing Objects 161
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2Choose Objects menu> Convert To Editing Ellipses 3Drag the point to open up the ellipse. 

ne the open ellipse style:

g the Object Selection tool from the 
s toolbar, select an open ellipse. 

 open the ellipse.
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Path. The Selected object is converted to 
a Bézier path. 

You can select any object or combina-
tion of objects to work on separately. 
You can edit the shape of an individual 
letter by selecting a point with the Node 
Selection tool.

The selected objects are converted to Bézier 
paths.

Unlike circles or ovals from other drawing 
applications, the Expression ellipse is a 
special case shape object. An ellipse con-
sists of only one point. By dragging this 
point, you can create a partial ellipse.

To create a partial ellipse: 

1Using the Object Selection tool from the 
Tools toolbar, select an ellipse.

2Using the Node Selection tool, click the 
ellipse node to select it. 

To defi

1Usin
Tool

Drag to
 an Ellipse Closure Control button 
 the Actions toolbar. 

and open ellipse.

Arc

Pie

Add Chord
Select the ellipse node. 2Click
from

Select 

Open 
tion toolbar, Ellipse Closure controls.
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Open Arc No connection between the 
ends of the ellipse. 

Pie A straight line segment connects 
each end of the ellipse with the center 
point of the ellipse. 

Open arc ellipse.
Add Chord A straight line segment con-
nects each end of the ellipse with the 
other end. 

Pie ellipse.
rranging and Editing Objects 163
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7

 

Printing

 

You can print your Expression 
artwork on your desktop or 
networked printer in black and 
white or in full color. Because 
Expression is a vector-based draw 
program, your artwork will look 
great when printed at any size and 

 

resolution.
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Printing from Expression

  

Printing Images with 

     

Quality Considerations

 

 Expression rasterize an image is 
lly the best way to ensure that the 
 image will faithfully reproduce the 

on screen. However, many images 
k equally good when rasterized by 

rinter, and may require less time and 
 resources to print (see 

  

formance Considerations,” later in 
apter). 

ral, it is best to rasterize your image 
solution (dpi) one and a half to two 
he linescreen frequency (lpi) of your 
. Most laser printers have a line-
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Like other draw programs, Expression pro-
duces artwork which is vector-based. 
Unlike bitmap images, which simply consist 
of many colored pixels (dots), vector 
images consist of mathematically defined 
curves with control points. This is why 
Expression artwork is so highly editable, 
and why it prints beautifully at any size. 
However, because printers work by placing 
tiny dots of ink, toner, or dye on the page, a 
vector image must be converted to dots 
(rasterized) before it can be printed.

When you print artwork from Expression, 

Transparency

Because printers do not yet support trans-
parency in vector images, the only way to 
preserve transparency when printing an 
Expression image is to have Expression ras-
terize the image before sending it to the 
printer. If you choose to let your printer 
rasterize an image with transparency, the 
transparency will simply be ignored; 
objects which are transparent will be 
printed as if they were opaque.

Having
genera
printed
image 
will loo
your p
system
➤“Per
this ch

In gene
at a re
times t
printer
 frequency of approximately 60 lpi. 
igh-end image setters have a line-
 frequency of 100-150 lpi.

ay want to rasterize at lower resolu-
hen printing proofs to speed up the 
g process. You will rarely, if ever, 
o rasterize at a higher resolution 
han your printer is capable of print-
ou are not sure of your printer’s res-
 (dpi) or linescreen frequency (lpi), 
t the printer’s documentation or 
t its manufacturer.

rinters are capable of rasterizing 
 images, but not all printers rasterize 
 in the same way. Expression sup-
ostScript-compatible printers (Mac-
you can let your printer rasterize the 
image, or you can have Expression raster-
ize the image before sending it to the 
printer. Which option you choose depends 
on the image itself and the capabilities of 
your printer. A checkbox in the Print dialog 
allows you to choose each time you print 
an image.

Many of the Natural-Media strokes included with 
Expression use transparency to achieve subtle 
effects, so your image may include transparency 
even if you have not explicitly applied it.

screen
Most h
screen

You m
tions w
printin
want t
(dpi) t
ing. If y
olution
consul
contac

Most p
vector
images
ports P
 and Windows), PICT-compatible 
s (Macintosh), and WMF-compati-
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intosh
printer



          

ossible, and that you have some 
ce on your hard disk. If you are still 
o print the image, try printing with 

 

erize Before Printing

 

 option dis-
ransparency and perhaps certain 
atures of your artwork will not be 
ed in this case, as explained in 

  

ing Images with Transparency,” 
 this chapter).
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ble printers (Windows). PostScript printers 
tend to do a better job of rasterizing 
Expression artwork than non-PostScript 
printers, because non-PostScript printers 
do not support some Expression features 
(e.g., clipping, Bézier curves, and the Non-
zero Winding rule for fills). As a result, cer-
tain Expression images may not print satis-
factorily when rasterized by PICT- or WMF-
compatible printers.

If you are not satisfied with a printed image which 
was rasterized by your printer, try printing the image 
again with the Rasterize Before Printing option 
enabled.

Performance 
Considerations

When Expression rasterizes an image, your 
computer will be busy for a time (perhaps 
up to several minutes for a complex image 
printed at high resolution). However, once 
the image has been sent to the printer, it 
will print in less time, since the printer 
does not have to rasterize it.

In general, the total time required to print 
should be comparable whether the image 
is rasterized by Expression or by your 
printer; the option you choose simply 

sion as p
free spa
unable t
the Rast
abled (t
other fe
support
➤“Print
earlier in
determines how the printing task is divided 
between the computer and the printer. 
However, if you are running Expression on 
an older or lower-powered system, you 
may find that images print considerably 
faster when rasterized by your printer. 
Likewise, if your printer is older or less 
powerful, rasterizing the image before 
printing may yield faster results.

The amount of RAM and hard disk space 
available to Expression may also affect 
your choice. Expression requires addi-
tional memory to rasterize an image. If 
there is not sufficient memory available, a 
scratch disk is automatically used to tem-
porarily store information. If you experi-
ence trouble when rasterizing an image in 
Chapter 7 • Printing 167
Expression, check to make sure that you 
have as much memory available to Expres-



   

Printing Color Separations 

     

Printable Area

   

 up your printer:

  

ose 

 

File menu> Printer Setup

 

. 
standard printer setup dialog 
ars. This dialog varies depending on 
rinter driver you are using.
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of Expression Artwork

Expression does not directly support color 
separations. However, Expression artwork 
can be exported in either bitmap or vector 
format and separated in another applica-
tion. When you export for separations, 
some of the printing limitations described 
above apply, most notably the fact that 
vector formats do not support transpar-
ency. 

If you want to produce separations from an 
image which includes transparency, you 
should export the image in a bitmap for-

Each printer and paper size combination 
has a specific printable area associated 
with it. Expression allows you to place art-
work elsewhere but only the artwork within 
the printable area prints. 

Generally, place your artwork inside the 
Workspace within the Expression docu-
ment window. If you change your printer 
you need to check that your artwork still 
lies within the confines of the printable 
area.

Outside Printable area

To set

1Cho
The 
appe
the p
e your selections as needed.

 OK.

inter Setup dialogs, Macintosh and 
ws.
mat. It can then be converted to CMYK and 
separated in an image editing application. 
For more information on exporting, see 
➤“Opening and Saving Documents” in 
Chapter 1, “Overview of Expression.”

2Mak

3Click

The Pr
Windo
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Expression’s printable area.

Inside Printable area
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Printing Your Work

Expression allows you to print to most 
color and black and white printers. Some 
print options vary depending on the printer 
and driver you choose.

To print:

1Choose File menu> Print. The 
standard Print dialog appears. This 
dialog varies depending on the printer 
driver you are using.

2Select Rasterize Before Printing if 
desired, and select a resolution. For 
more information regarding this option, 
see ➤“Printing from Expression,” earlier 
in this chapter. 

3Follow the directions for your particular 
printer.

4Click Print.
Chapter 7 • Printing 169
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A

 

Technical Tips

 

Fractal Design Corporation has 
thoroughly tested Fractal Design 
Expression to ensure that it runs 
correctly with most Macintosh and 
Windows software and hardware. If 
you experience a problem with 
Expression, first complete the steps 
given in “Before You Call Technical 
Support.” Then refer to the list of 
commonly asked questions and 
their answers. If you cannot resolve 
the problem, please see the end of 
this appendix for information on 

 

how to contact Technical Support.
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Before You Call Technical 

                     

6

 

What kind of problem are you having? 

                

3

 

Run the software to see if the problem 
occurs.

  

e problem goes away when you start 
omputer with Extensions off, you 
 that the culprit is an item in the 

nsion folder or Control Panel. Once 
tified, it is usually just a matter of 
ng the most current version of the 
uct to solve the problem 
anently. Or the problem may be 

ed by replacing the extension or its 
erences.

 

ntify the item that causes the 
t:
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Support

When you first experience a problem with a 
software program you might be able to find 
the solution yourself without calling Tech-
nical Support. If you do call Fractal Design 
Technical Support, please have the follow-
ing information available. Filling out the 
Troubleshooting Worksheet included as 
the last page of this chapter will also be 
helpful.

1Which Fractal Design product are you 
using? 

7Do you get an error message? If so, what 
message? 

8Is there anything unusual about your 
computer set up? Do you have a special 
video card or accelerator, for example.

9Do you have a CD-ROM player? When 
was it last used?

ºAre you running virus protection or disk 
compression software, and if so, what 
products are you using?

Once you have answers to the above ques-
tions, call Fractal Design Technical Sup-

still 

4If th
the c
know
Exte
iden
getti
prod
perm
solv
pref

To ide
conflic
em 7.5 Choose Apple menu> 
trol Panels> Extensions 

ager. If you need more instructions 
 what appears in this control panel, 

your System 7.5 documentation. 
r turning off one half of your 
nsions, go to Step 2.

System 7.5 Create a new folder and 
e it Extensions Off. Open the Exten-
 folder and drag half of the items 
 the Extension folder into the new 
r. 

art your computer in the usual way. 
if the problem still occurs. If the 
lem persists, go to step 3. If the 
2Which version? 

Macintosh Look under the Apple menu 
if the program is running or highlight the 
application icon and choose File 
menu> Get Info.

Windows Look under the Help 
menu> About Expression.

3What is your serial number? (See the 
label attached to the Read This First card 
or the Registration card) 

4What kind of computer are you using? 

5How much RAM does your computer 

port. To investigate the problem yourself, 
look below for instructions based on your 
computer platform.

Macintosh
The most common cause of problems when 
running Macintosh software is a conflict 
with Extensions. 

To find out if an Extension conflict is 
causing a problem:

1Restart the computer while holding 
down the Shift key.

2When you see the message “Welcome to 

1Syst
Con

Man

than
see 
Afte
exte

Pre-
nam
sion
from
folde

2Rest
See 
prob
lem is solved, go to step 4.
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have? Macintosh. Extensions off.” release the 
Shift key. prob



                                        

problems are gone, you know the 
 was the video driver. Contact the 
facturer of your video card to get 
ost current video driver. Some 
facturers change drivers every few 
s. The new version is most likely 

nd can usually be downloaded from 
etin board or on-line service.

 

s 95/Windows NT 4.0

  

the 

 

Start

 

 menu, choose 

 

Settings> 

ol Panel

 

.

  

e-click 

 

Display

 

 and select the 

 

gs

 

 tab.

   

Change Display Type /Record 
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3If the problem still occurs you know the 
culprit is still active. Turn off or remove 
half of the still active extensions and 
repeat step 2.

4System 7.5 If the problem goes away, 
you know that the extension is turned 
off. Turn half of the extensions back on. If 
a problem still occurs, turn off half of the 
remaining extensions. Keep turning 
extensions on or off until you zero in on 
the extension that causes the problem.

Pre-System 7.5 If the problem goes 
away, you know the culprit is in the 
Extensions Off folder. Whichever folder 
contains the culprit, cut that group in 

If you have the most current version, 
contact Fractal Design Technical Sup-
port. We will want to have the name and 
phone number of the developer’s techni-
cian you spoke with so we can work with 
them to create a permanent solution.

8If the problem is identified as an Apple 
Control Panel, contact Fractal Design 
Technical Support.

Windows 
If you are running Windows, sometimes 
there is a video driver incompatibility. The 
solution is easy so try this test to see if 
your problem is caused by a video driver.

If the 
cause
manu
the m
manu
month
free a
a bull

Window

1From 
Contr

2Doubl
Settin

3Click 

er Type.

Change under Monitor Type and 
 Show All Devices. Make a note of 
rrent setting so you can return to it 
his test. 

 to Standard Monitor Types and 
 Standard Display Adapter (SVGA).

OK.

off hardware graphics acceleration 
ing to the Control Panel> 
rmance tab. 

the Graphics button then set it to 
half and restart again. Keep cutting the 
group in half until you zero in on the 
extension that causes the problem.

5If you get all the way through the 
Extensions folder without locating the 
item that causes the problem, it is 
possible that the culprit is in the Control 
Panels folder. 

6Follow the same procedure with the 
Control Panels folder, starting by 
removing all items that are not included 
in Apple’s standard system. 

7If you identify the problem as an 
Extension or a third-party Control Panel 
device, contact the developer of that 

Windows NT 3.5

1Close all applications except Windows.

2In your Main directory, locate and 
double-click the icon labeled Windows 
Setup. 

3Write down the current Display setting 
so you can return to it after this test.

4Choose Options menu> Change 
System Setting. 

5Where it shows Display, scroll down and 
select plain vanilla VGA. 

6Restart Windows. 

Adapt

4Click 
select
the cu
after t

5Scroll
select

6Click 

7Turn 
by go
Perfo

8Click 
None.
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software to verify that you have the most 
current version. 

7Run Expression to see if the problem 
persists. 



   

If running under SVGA does not solve the 

 

Set Up

            

•

 

Any virus protection software.

  

you are using disk compression, try 
stalling to an uncompressed volume.

  

stall Expression. If installation is still 
ccessful, contact Fractal Design 
nical Support.

 

ograms (Windows)

  

t is a TSR (Terminate and Stay Resi-
) application?

  

R or memory resident application is 
gram or driver that stays in memory 
 it is loaded and works in the back-
nd. The program normally responds 
 to a specific command or event 
h as the deletion of a file or a specific 
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problem or if the manufacturer verifies that 
you are running the most current driver, 
contact Fractal Design Technical Support.

Q:The Expression installer does not install 
Expression on my machine. What can I 
do?

A:Try the following:

1Do you have enough hard disk space? To 
install the default Expression package 
including the tutorial files, you need to 
have 10MB of hard drive space reserved 
for program files.

To install the full collection of Skeletal 
Strokes, you will need considerably more 

• Ι f 
in

3Rein
unsu
Tech

TSR Pr

Q:Wha
dent

A:A TS
a pro
once
grou
only
(suc
stroke combination). 

 can I turn some or all TSR’s off?

urn off TSR’s:

dows 95:

ess Control-Alt-Del.

d all tasks other than Explorer.

e the computer restarts, start Win-
s then start Expression. 

e problem persists, even with TSR’s 
ontact Fractal Design Technical Sup-
.

space—run the Expression Installer from 
the CD to see the exact requirements. If 
possible, you should also have several 
megabytes of free hard drive space. 
Expression makes use of free space when 
printing or rasterizing high resolution 
images.

2Macintosh If you have enough hard 
drive space and are still having 
problems, use Extension Manager to turn 
off all extensions except Apple CD. Then 
reinstall Expression. 

Windows If you have enough hard 
drive space and are still having prob-
lems, try rebooting the computer with 

key 

Q:How

A:To t

Win

1Pr

2En

Onc
dow

If th
off, c
port
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the following turned off:



                       

Ways to Contact Technical 
rt

  

upport@fractal.com
upport@fractal.com

 

a Online

 

ord: Fractal

  

430-4200 8:00 AM to 5:00 PM
ay through Friday

  

438-9672
 Technical Support
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Q:Can TSR’s cause conflicts and how can I 
resolve them?

A:TSR conflict occurs when a specific TSR 
conflicts with another TSR, application or 
a function within an application. You can 
resolve a possible TSR conflict by:

1Restarting the computer with only 
those TSR’s turned on that are 
required to run Windows.

2Retry the operation. If the conflict 
does not recur, the problem is proba-
bly caused by a TSR conflict.

Contacting Technical 
Support

Q:How can I contact Technical Support?

A:Make sure that you register your copy of 
Expression so you can benefit from Frac-
tal Design Technical Support.

Please fill out the Troubleshooting 
Worksheet included at the end of this 
book before contacting Technical Sup-
port.

Fractal Design Technical Support encour-

Other 
Suppo

email

mac_s
win_s

Americ

Keyw

Phone

(408) 
Mond

Fax

(408) 
Attn.:
l Design Corporation
Technical Support
ox 66959
 Valley, CA  95067-6959

ponding by fax, internet or email, 
nclude your full name, address, and 
one number where you can be 
. Never post such information on a 
iscussion board.
If restarting with TSR’s off resolves the problem, a 
TSR conflict is probably the cause of the original 
problem. Try to identify the specific TSR or 
combination of TSR’s that cause the problem. Once 
identified, verify with the manufacturer that the 
version is up-to-date. Then contact Fractal Design 
Technical Support for additional instructions.

ages you to use the Troubleshooting 
Worksheet before you contact Technical 
Support. Having the information ready 
not only makes it easier to find a solu-
tion—sometimes the questions help you 
solve the problem. Feel free to make cop-
ies of the form. You can fax it to us and 
we will then contact you, or have it ready 
when you call us. Always include this 
information in your email.

Many of the Technical Support questions 
you have may already be answered 
on-line at our Website in the Support sec-
tion. If you have access to the Internet, 
please check there first. You can also use 
our on-line forms to contact us via email.

Mail

Fracta
Attn: 
P.O. B
Scotts

If corres
always i
a teleph
reached
public d
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Internet 

www.fractal.com
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B

 

Glossary

 

This appendix contains terms used 
throughout this User Guide and in 
the Expression application. Refer to 
the Index for more information on 

 

where the term is used.
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additive color model

 

The color model 

              

save an Expression image as a bitmap, 

             

Boolean Operation

 

 Allows you to create 
 paths based on the area enclosed by 
urce paths. Unite, Intersect, Front 
Back and Back minus Front are the 
n functions supported by Expres-

 

ing box

 

An onscreen aide which is 
allest rectangle that can completely 
e a selected object or group of 
s. The bounding box includes invisi-
nts such as tangent and shear/width 
s.

 

e

 

A type of smooth curve com-
 used in computer graphics. A 
e curve is defined by a set of control 

 governing the shape of the curve, 
he control points might not neces-
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which describes color based on direct light 
or transmitted light (as in television or 
computer screens). The RGB model is addi-
tive. All color values set to their highest, 
create white. See also Subtractive color 
model. 

alpha channel An extra color channel 
which provides an 8 bit mask so that you 
can composite your image with other bit-
map images in an application such as Frac-
tal Design Painter or Adobe Photoshop.

anchor point A point, or set of coordi-
nates defining a position which remains 
constant as an action or transformation 
occurs.

Expression automatically anti-aliases the 
image to make its edges smooth. Disable 
the Anti-aliasing option when saving to 
override this default.

Back minus Front Creates a new path that 
contains areas in the back path that are not 
overlapped by areas in the front path.

base objects The objects and layers 
beneath a mask object. Once a mask is 
clipped out of the base objects, only the 
clipped portion remains visible.

Bézier curves The Pen tool is used to cre-
ate Bézier curves. Bézier curves define the 
shape of the path by a combination of point 
position and tangent handle position.

closed
two so
minus 
Boolea
sion.

bound
the sm
enclos
object
ble poi
handle

B-Splin
monly
B-Splin
points
while t
ie on the curve itself.

Defines the way Expression displays 
d points of an open path. Expression 
play a stroke with a flat cap, round 

 square cap. 

ee mask.

 path A path wherein the start and 
int are at the same location, such as 
, rectangle or polysided object. Or a 
at completely encompasses some 

e Applies color to black and white 
k or changes the color scheme of an 
 by substituting the primary colors 
anchoring A technique that allows the 
user to constrain specific points of a stroke 
so selected parts of the picture are not dis-
torted as the Skeletal Stroke is applied 
along the path.

angular interpolation When using the 
Blend Path command, interpolates the 
angle and distance between consecutive 
points instead of interpolating the posi-
tions of the nodes explicitly. This some-
times results in more shape constancy 
along the steps of the blend.

aspect ratio The length of a line as com-
pared to the width of the stroke.

anti-aliasing  The process of removing the 

bitmap Bitmapped artwork is defined by 
a grid of pixels. There is no outline. Resiz-
ing such an image may result in 
stairstepped edges. Graphics created by 
Fractal Design Painter, Adobe Photoshop, 
scanned images and other paint programs 
are examples of bitmapped artwork.

Blending The Blend Path command cre-
ates a series of new paths based on two dif-
ferent source paths. After you define the 
number of step, Expression automatically 
generates the new paths whose character-
istics are determined by the characteristics 
of the source paths. Both geometry (shape) 
and paint characteristics (color, width, 
transparency, etc.) are interpolated.

sarily l

caps
the en
can dis
cap or

clip S

closed
end po
a circle
path th
area.

coloriz
artwor
object
ew colors.
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jagged stairstepped edges (aliasing) which 
are typical of bitmap images. When you 

with n



                                  

See 

 

tangent handle

 

, 

 

shear/width 

  

Resize handle

 

 or

 

 transformation 

   

A pattern of strokes whose char-
cs vary based on the contrasting 
s/darkness of the source imagery 
 it. It is a technique to mimic pen 
drawing or woodcut prints.

 

r model

 

Refers to Hue, Satura-
 Lightness. This is the color model 
sts use to describe color.

  

sic color family, such as red, 
tc.

 

ate

 

Estimate values inserted 
 specifically defined values.
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color separation Creates separate pieces 
of film or printed image for each color of 
ink used in the artwork.

Color Table A visual representation of 
colors from which the user may select a 
color to apply to an object.

compound path A compound path is a 
path that describes an object made from 
two or more shapes, wherein one shape 
cuts a hole or void in the other. The letters 
“A” and “O” are examples of compound 
shapes.

corner point A vector point (node) with 
both tangent handles retracted. Since the 
tangent handles are at the same location as 
the node itself, they can not be seen when 

Even-Odd rule On any shape where a 
path crosses itself, or where one path 
encloses another path, Expression must 
decide which areas to fill and which to 
leave empty. The Even-Odd rule deter-
mines whether a point is inside a path (and 
therefore filled) by drawing a ray from that 
point in any direction and counting the 
number of path segments that the ray 
crosses. If the number is odd, the point is 
inside; if even, the point is outside. See also 
Non-Zero Winding Number rule.

fill Color or pattern used to define inside 
areas of an object as in stroke and fill. On 
an open path, an imaginary straight line 
connects the beginning and ending points 
to specify which areas are inside the stroke 

handle
handle, 
handle.

hatching
acteristi
lightnes
beneath
and ink 

HSL colo
tion and
that arti

Hue Ba
green, e

Interpol
between
t Creates a new path that con-
as where the selected source 
erlap. Areas and paths that do not 
are ignored.

e Specific image (view) in a Multi-
oke. Expression automatically 
ates views between keyframes.

s The property which makes 
pear to reflect or transmit more or 
t. A color with no lightness appears 
 color with full lightness appears 

terpolation When using the 
mmand, each pair of correspond-

ts is interpolated without regard to 
the node is selected. A corner point defines 
an angle intersection of two line segments, 
rather than a curved intersection.

curve point A vector point (node) with 
tangent handles extended and visible when 
the node is selected. A curve point defines 
any intersection of two line segments other 
than an angle. The angle and distance of 
the tangent handles define the shape of the 
adjoining line segments.

cusp point A point on a curve at which a 
point tracing the curve would abruptly 
change its direction of motion. In Expres-
sion, this term is used to describe a corner 
point of a B-Spline or Bézier path. Generally 

and therefore contain the fill color or pat-
tern.

Freehand tool The Freehand tool allows 
you to create paths by freely drawing with 
the mouse or tablet stylus.

Front minus Back Creates a new path that 
contains areas in the front path that are not 
overlapped by areas in the back path.

gamut An entire range or series. In 
Expression the term gamut refers to the 
gamut of printable colors, that is, the whole 
range of printable colors.

Graphic Element stroke A vector picture 
used as a stroke.

Intersec
tains are
paths ov
overlap 

keyfram
view str
interpol

Lightnes
color ap
less ligh
black. A
white.

linear in
Blend co
ing poin
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onship with other pairs of points.

a B-Spline path is all smooth, but a cusp 
point can be created by Option-click. grayscale An image consisting entirely of 

shades of gray.
its relati



   

marquee

 

A dotted rectangle indicating a 

          

After counting all the crossings, if the result 

                      

(CY), Cyan-Yellow (CY), Magenta-Yellow 
Cyan-Magenta-Yellow (CMY), White 
ack (K).

 

ze

 

To convert vector (outline) 
ation into bitmap information for a 
stScript printer or for use in bitmap 
g application.

 

 handles

 

Triangles shown at each 
 of the imaginary bounding box of 
d object(s). Drag to resize selection. 
rence controls whether or not 

 handles are visible.

 

tion

 

Number of pixels per inch 
eferring to monitor screen. Number 
 per inch when referring to printer 
.
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selected area.

mask A mask or clipper allows only those 
objects or parts of objects that lie inside 
the mask path to be seen. The topmost 
object is used as the mask and its original 
fill is discarded. Strokes and fills from 
objects on lower layers are shown in the 
masked area only.

Multi-view stroke A stroke composed of 
two or more pictures or keyframes. Expres-
sion automatically interpolates the 
between views. A Multi-view stroke can 
also be saved as an animation.

Natural Media stroke A stroke that mim-
ics traditional artist tools and brushes.

is zero, then the point is outside the path. If 
the result is anything other than zero, the 
point is inside the path and is filled. See 
also Even-Odd rule.

open path A path with distinct beginning 
and ending points; not a closed shape.

original path The source path for objects 
of cloning or Boolean operations.

path A path is a continuous line made up 
of one or more curved or straight path seg-
ments. Each path segment is defined by 
two or more points (nodes) which can be 
edited.

pixel Small, discreet points on the com-
puter screen. Computer images are com-

(MY), 
and Bl

rasteri
inform
non-Po
imagin

Resize
corner
selecte
A prefe
Resize

resolu
when r
of dots
output
tion Describes the intensity of 
Less saturation results in a muddy 
more saturation results in a clear, 
 color.

on Object(s) currently active and 
to be acted upon. 

width handle Controls a Skeletal 
’s shear and width. The angle of the 
 from the point controls shear. The 
e of the handle from the point con-
idth.

l Stroke A simple or complex pic-
at has been defined as a stroke.

 imagery Original artwork used for 
node A control point or vector point, 
used to define the shape of an object.

Non-Zero Winding Number rule On any 
shape where a path crosses itself, or where 
one path encloses another path, Expres-
sion must decide which areas to fill and 
which to leave empty. 

The Non-zero Winding Number rule deter-
mines whether a point is inside a path (and 
therefore filled) by drawing a ray from that 
point to infinity in any direction then evalu-
ating the places where a segment of the 
path crosses the ray. Starting with zero, 
you add one each time a path segment 
crosses the ray from left to right and sub-

posed of pixels.

point See node.

PostScript The printer description lan-
guage created by Adobe Systems Incorpo-
rated and used by most high quality 
printers, PostScript defines the appearance 
of type and images on the printed page.

preferences User definable options 
located under File menu> Preferences 
that allow you to customize the way 
Expression behaves.

progressive color bar A printed sample of 
the standard color combinations used in 
Color Monitor Calibration. Includes Cyan 

Satura
color. 
color, 
intense

Selecti
ready 

shear/
Stroke
handle
distanc
trols w

Skeleta
ture th

source

ng. Hatching is applied based on the 
ale value of the source imagery.
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tract one each time a path segment crosses 
the ray from right to left. 

(C), Magenta (M) Yellow (Y), Cyan-Magenta hatchi
graysc
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source path Original artwork used for 
blending or for Boolean operations.

stroke A mark or path made by a single 
movement of an instrument. Also refers to 
the outline or edge of a piece of artwork, as 
in stroke and fill. Traditionally an artist 
defines an area with a stroke then fills the 
area with color or pattern. The stroke itself 
may have particular attributes, such as 
width and color assigned to it. 

stylus A pen-like tool used when drawing 
with a digitizing tablet.

subtractive color model The color model 
which describes color based on reflected 
light, such as when using pigment. The 
CMYK model is subtractive. All CMY values 

tangent handles are retracted and placed at 
the same coordinates as the point itself and 
so are not visible.

tint A variation of a color produced by 
adding white. A 100% tint includes no 
white. A 0% tint is completely white.

transformation handles Paired arrows 
shown at the midpoint of the right, left, top 
and bottom of the imaginary bounding box 
of selected object(s). Drag to shear selec-
tion. Drag while holding down the Shift key 
to rotate selection. A preference controls 
whether or not Resize and transformation 
handles are visible.

Union Creates a new path based on the 
outline of all selected source paths as if 
set to their highest create black. See also 
additive color model.

tablet A computer accessory that 
replaces the standard computer mouse 
input device with a flat tablet and stylus. 
Clicking and dragging with the stylus on the 
tablet moves the cursor on the monitor. 
Some tablets also include a pressure sensi-
tive function so strokes drawn respond dif-
ferently based on the amount of pressure 
applied while drawing.

tangent handles Each vector point (node) 
of a path includes two tangent handles that 
control the shape of the path as it moves 
from the vector point to the next or previ-

they were merged into one object. Paths 
inside are ignored.

vector Vector artwork defines an image 
by placing points then using the vector 
points’ tangent handles to control the path 
that connects the points. Since the informa-
tion is always mathematical, vector art-
work is resolution independent, printing 
out beautifully at any size.
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ous vector point. On a corner point, the 
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 Dropper tool 88
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okes 99
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sking and 70
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nverting to 162
ating 62
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fined 178
orting 31

derstanding 28
tton 74, 75
Arrangin
ob
win

Aspect ra
de
Mu

Attribute
Attribute

co
co
en
Gr
str

Auto app
AVI, savi

B
Back min

de
op

Back-Fro
Base obje

de
ma

Bevel joi
Bézier pa

co
cre

Bézier pe
Bitmaps

de
exp
un

Blend bu
Index

A
Accumulated transformations 143
Actions toolbar 12
Active layers 155
Active Perspective Frame 142
Actual Size command 22
Add Chord button 13, 163
Add Node tool 7, 158
Adding points 158
Additive color model 82, 93

defined 178
Address ix, 175
Adjusting, pressure sensitivity 76
Adobe Illustrator

Anchor to Start command 119
Anchor tool 12, 118, 119, 120
Anchor/Repeat tools

Anchor tool 12, 118, 119, 120
Repeat tool 53, 120, 122

Anchors
creating 118
defined 178
moving 120
removing 119

Angle Locked button 13, 157
Angle Locked continuity 157
Angular interpolation

blends and 73
defined 178
exporting 31

importing 30
Adobe Photoshop, exporting 31
Align command 149
Aligning objects 147
Alignment command 152
Alignment palette 19, 149
Alignment, preferences 27
Alpha channel 178
America Online address 175
Anchor at End button 14, 119
Anchor at Fixed Point button 14, 119
Anchor at Start button 14, 119
Anchor Control tools

Anchor at End button 14, 119
Anchor at Fixed Point button 14, 

119
Anchor at Start button 14, 119
Free Anchor button 14, 119

Animations
resolution 127
saving 32
saving as 126
speed 127

Anti-aliasing 32, 127
defined 178

Applying
colors 79
gradient fills 111
Gradient strokes 89, 102
hatching 114
pattern fills 111
Skeletal Strokes 102
solid fills 110
strokes 103
transparency 98

Arcs, creating 162
Anchor point, defined 178
Anchor to End command 119

Arrange Icons command 22



   

Blend Paths button 15, 74

  

Clipper command 71 Colors
calibration 95
CMYK 82
copying 87
custom 85, 86
fixed width strokes, and 100
gradients 89
HSL 79
layers and 155
RGB 82
saving 84
Skeletal Strokes 92
substitution 114
it Transform command 144
atibility, file format viii
osition toolbar 6
ound Object command 69, 70
ound path
defined 179
understanding 60
Blend Paths command 74, 75
defined 178

Blending
multiple paths 75
paths 73

BMP file format, exporting 31
Boolean operations

defined 178
preferences 26, 72
using 71

Boolean Operator buttons 15, 73
Bounding box 135, 178
B-Spline objects

creating 63
defined 178

B-Spline tool 9, 63

Clipping
objects 70
releasing objects 71

Clone command 146
Cloning objects 146
Close command 34
Closed path

defined 178
understanding 60

Closing, documents 34
CMYK colors, creating 82
Color Dropper tool 10, 87

preferences 27
Color match, preferences 26
Color models

selecting 79
using 79

Color palette 18, 78
CMYK tab 83

Comm
Comp
Comp
Comp
Comp
ound shapes
creating 68
filling 69
ression, video 128

training objects 133
inuity

angle locked 157
smooth 157
symmetrical 157
unconstrained 157

inuity, node 156
entions, manual ix
ert Node tool 7, 158
ert To Path command 147, 162
erting
points 158
to Bézier paths 162

 button 6
C
Calibration, color 95
Caps

defined 178
editing 102

Cascade command 22
Center View command 22
Center Zoom command 22
CGM

exporting 31
importing 30

Change Start Point tool 8, 160
Circles

creating 66
Circles, creating 66
Classic Drawing tools 8

Freehand tool 8, 61
Pen tool 8, 62

HSL tab 79
preferences 27
RGB tab 82

Color separations 85, 179
Color Table command 84
Color tables

creating 83
defined 179
displaying 78
editing 83
loading 84
saving 84
sorting 85

Colorize tab 93
Colorizing

defined 178
Multi-view strokes 92
objects 92

Comp

Comp
Cons
Cont

Cont
Conv
Conv
Conv
Conv

Copy

 command 31
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Clipboard, importing 30
Clipper 70 removing 94 Copy



    

tterns 113
ints 159

ews 125
 All button 6, 133
ing object 133
n, paths 160
Pressure Sensitivity button 14, 76
ng
ids 21
lers 21
olbars 5
ting objects 149
toolbars 5
nts
osing 34
eating 20
ening 30
naming 33

  
Copying
attributes 88
colors 87
fills 88
strokes 88

CorelDRAW!
exporting 31
importing 30

Corner
attributes 101
handles 133
points 62, 179

Creating
anchors 118
arcs 162
Bézier paths 62
B-Spline objects 63
circles 66

smoothed polyline objects 64
squares 65
text objects 66

Curve points 62
defined 179

Cusp points
B-Splines 158
defined 179
understanding 64

Custom Color palette 18, 86
Custom colors

creating 86
defining 86
deleting 87
selecting 86
tint 87
using 85

Cut button 6

pa
po
vi

Deselect
Deselect
Directio
Disable 
Displayi

gr
ru
to

Distribu
Docked 
Docume

cl
cr
op
re
solution 29
ving 31
 inch (dpi), setting 29

ne button 6
ing 29
 tools 10
tribute Dropper tool 10, 88
lor Dropper tool 10, 87
e command 145
ing
ones 146
jects 145

ke Definition command 117, 127

ps 102
CMYK colors 82
color tables 83
compound shapes 68
custom colors 86
dashed lines 100
dashes 101
documents 20
ellipses 66
Freehand paths 61
HSL colors 79
layers 153
lines 65
Multi-view strokes 122
new view 24
ovals 66
paths 59
patterns 111
polyline objects 63

D
Dashed lines 100
Dashes

creating 101
editing 101

Define Stroke command 117
Defining

custom colors 86
patterns 111
Skeletal Strokes 116

Definition tools 11
Pattern Definition Box tool 11, 112
Stroke Definition Box tool 11, 116, 

123
Delete Node tool 7, 159
Delete Selection button 6

re
sa

Dots per
Down O
dpi, sett
Dropper

At
Co

Duplicat
Duplicat

cl
ob

E
Edit Stro
Editing

ca
185

lor tables 83
rners 101
shes 101
rectangles 65
RGB colors 82
Skeletal Strokes 103, 116

Deleting
custom colors 87
layers 153

co
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da



   

ellipses 162 Targa files 31

  

Freehand tool 8, 61
defined 179
preferences 27
pressure sensitivity 76

 minus Back
defined 179
operation 72

-Back button 15, 72

  

t
Color palette 80
defined 179

ber tool 8, 23
ient Editor palette 19, 90
ient tool 10, 89
ients

applying 88, 89, 102
Gradient strokes 89, 102
gradients 89
Multi-view strokes 108
paths 156
points 156
Skeletal Strokes 105, 117
strokes 99, 117

Ellipse Closure controls 13
Add Chord button 163
Open Arc button 163
Pie button 163

Ellipse tool 10, 66
Ellipses

creating 66
editing 162

Enable Pressure Sensitivity button 15, 76
Endpoints

attributes 102
caps 102

TIFF/TIF files 31
transparency and 29
vector graphics 31
WMF files 31

Extensions, conflicts with 172

F
Fax number, Fractal 175
Fill tab 110
Filling

compound shapes 69
objects 109

Fills
copying 88
defined 179
gradient 88, 111
patterns 111

Front

Front

G
Gamu

Grab
Grad
Grad
Grad
attributes 89, 102
colors, and 89
editing colors 89
fills 88, 111
linear 91
radial 91
strokes 88

hic Element strokes
defined 179
understanding vii, 3

hics
exporting 32
importing 30

scale 179
king 27

displaying 21
hiding 21
EPS file format, exporting 31
Even-Odd rule

defined 179
using 69

Exit command 34
Exiting 34
Exporting

Adobe Illustrator files 31
Adobe Photoshop files 31
bitmap graphics 31
BMP files 31
CGM files 31
CorelDRAW! 31
EPS files 31
JPEG files 31
movies 31
PCX files 31
PhotoPaint files 31

preferences 27
solid 110

Fixed width strokes 100
Flat cap 102
Floating toolbars 5
Font command 67
Font palette 19
Fractal Design ix

address 175
America Online address 175
Fax number 175
Internet address 175
MSN address 175
technical support 172, 175

Free Anchor button 14, 119
Free Anchor command 119
Freehand paths

creating 61

Grap

Grap

Gray
Gree
Grids
preferences 27
p command 145
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PICT files 31
editing 136

Grou



            

ommand 153
alette 19, 153
ngle interpolation 74
s 79
l 9, 65
radient 91
terpolation
plying 74
fined 179

eating 65
shed 100, 101
en frequency 166

 layers 154

  

r tool 8, 22
Group Selection tool 7, 132
Grouping objects 144

H
Handles

corner 133
defined 179
preferences 25
Repeat frame 121
Resize 135, 137
Shear/Width 106
tangent 156
transformation 133

Hatch command 115
Hatching

applying 114
defined 179

text 30
vector graphics 30
WMF files 30

Info command 153
Installation, problems with 174
Internet address ix, 175
Interpolate

blends and 73
defined 179

Intersect 179
Intersection button 16, 72
Intersection operations 72
Invisible strokes 99

J
JPEG file format, exporting 31

Layers c
Layers p
Length A
Lightnes
Line too
Linear g
Linear in
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de
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cr
da
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Locking

M
Magnifie
oming in and out 22
n-repeating button 14, 122
nrepeating command 122
peating button 14, 120
peating command 120

fined 180
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ab 140
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neous toolbar 15
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ck-Front button 16, 72
end Paths button 15, 74
ont-Back button 15, 72
understanding 114
Hiding
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layers 153
rulers 21

HSL colors
creating 79
defined 179
understanding 79

Hue 79, 179

I
Importing

Adobe Illustrator files 30
CGM files 30
clipboard 30
CorelDRAW! files 30

K
Keyframe

defined 179
Multi-view strokes and 123

L
Launching Expression 2
Layer command 153
Layering objects 152
Layers

changing the active 155
color 155
creating 153
deleting 153
hiding 153
locking 154

zo
Make No
Make No
Make Re
Make Re
Marquee

de
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Masking
de
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Ba
Bl
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in 101
graphics 30
PICT files 30

naming 155
unlocking 154
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Models

   

Natural-Media strokes

    

duplicating 145
filling 109
grouping 144
layering 152
masking 70
moving 133, 136
resizing 137
rotating 138
scaling 133, 137
selecting 132, 133, 134
shearing 141
stacking 151
transforming 136
ungrouping 145
unstructuring 161
viewing 135

ity 98
 Arc button 13, 163
 command 30
 File button 5

  
additive 93
color 79
subtractive 93

Modes
ribbon 106
sausage 106
Skeletal Strokes 105

Monitor, resolution 29
Movies

exporting 31
saving 31

Moving
anchors 120
images 23
Multi-view stroke views 126
objects 133, 136
points 156
toolbars 5

MSN address 175

defined 180
understanding vii, 3

New
command 2, 4, 20
documents 20

New command 2
New File button 2, 5
New Stroke Definition command 116, 123
New View command 24
New view, creating 24
Node Continuity controls 12

Angle Locked button 157
Smooth button 157
Symmetrical button 157
Unconstrained button 157

Node Continuity Mode command 157
Node Selection tool 7, 156
Node tools 7

Opac
Open
Open
Open
 path
defined 180
understanding 60

ing, documents 30
n, text object 68
nal path 115

defined 180
keeping 72

ut device, resolution 29

creating 66
editing 66

, sizing 20
 Style palette 17, 70, 98
Multiple paths, blending 75
Multiple windows 21
Multi-view strokes

adding views 124
animating 126
colorizing 92
creating 122
defined 180
editing 108
moving views 126
saving 32, 126
Shear/Width handle 125
understanding vii, 3

N
Naming

Convert Node tool 7, 158
Node Selection tool 7, 156

Nodes
defined 180
See also, Points

None Continuity controls 157
Non-Zero Winding rule 69

defined 180

O
Object Selection tool 7, 132
Objects

aligning 147
arranging 147
cloning 146
colorizing 92
constraining 133

Open

Open
Origi
Origi

Outp
Ovals

P
Page
Paint
Colorize tab 93
Fill tab 110
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lor palette 27
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ls 27
eehand tool 27
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tterns 27
roke Warehouse palette 27
do 27

ew 27
 Sensitivity controls 14
sable Pressure Sensitivity 

button 14, 76
able Pressure Sensitivity 

button 15, 76
Stroke tab 99
Palettes 16

Alignment palette 19
Color palette 18
Custom Color palette 18
Font palette 19
Layers palette 19
Paint Style palette 17
Panner palette 18
Stroke Warehouse palette 18
Transformation palette 19

Panner palette 18
Paste button 6
Path Operations command 73
Path tools 7

Add Node tool 7, 158
Change Start Point tool 8, 160
Delete Node tool 7, 159

preferences 27
removing 113
saving 113
scaling 115
strokes and 114
transforming 112

patterns and 115
PCX file format, exporting 31
Pen tool 8, 62
Perspective 142
Perspective Control Frame 142
Perspective tool 11, 142
Phone number ix, 175
PhotoPaint file format, exporting 31
PICT file format

exporting 31
importing 30

Pie button 13, 163

Bo
Co
co
Co
de
fil
Fr
gr
ha
pa
St
un
vi

Pressure
Di

En
 sensitivity, setting 76
 view 135
tton 6, 169
mmand 169
e area 168
esolution 166
etup command 168

ages 169
rformance 167
ality 166
sterized images 166
solution 166
parations and 168
ansparencies and 166
sive color bar
lor calibration 96
fined 180
Reverse Path tool 8, 160
Split Path tool 7, 159

Path view 135
Pathfinder operations 15
Paths

blending 73
creating 59
defined 180
direction 160
editing 156
reversing 160
splitting 159
tagging 74
text on 67
understanding 60

Pattern Definition Box tool 11, 112
Patterns

color substitution 114

Pixels, defined 180
Plug-ins 28
Points

adding 158
continuity 156
converting 158
corner 62
curve 62
defined 180
deleting 159
editing 156
moving 156
selecting 132, 134, 156
viewing 135, 136

Polyline objects, creating 63
Polyline tool 9, 63
PostScript

defined 180

Pressure
Preview
Print bu
Print co
Printabl
Printer r
Printer S
Printing
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pe
qu
ra
re
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tr

Progres
co
de
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fills 111
hatching 114

printers 166
Preferences

alignment 27
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Repeating Control tools 14

  

Save As command 31, 33
Bitmap command 32
command 31
File button 6
Stroke as Movie command 33, 127
g
animations 32
AVI format 32
color tables 84
colors 84
documents 31
Multi-view strokes 32
patterns 113
QuickTime format 32
strokes as animation 126

 tab 138
 tool 10, 138
ng

objects 133, 137
patterns 115
QuickTime
animation 126
compression 128
saving as 32

Quit command 34
Quitting 34

R
Radial gradient 91
Randomizing Skeletal Strokes 108
Rasterize

defined 180
graphics 28

Ratio, zoom 22
Rectangle tool 10, 65
Rectangles, creating 65
Redo command 34

Make Non-repeating button 14, 122
Make Repeating button 14, 120

Repeating Skeletal Strokes 120
Reset Transform command 144
Resize handles 133, 135, 137

defined 180
Resizing

objects 137
toolbars 5

Resolution 29
animation 127
defined 180
document 29
monitor 29
output device 29
printing 166

Reverse Path command 161
Reverse Path tool 8, 160

Save 
Save 
Save 
Save 
Savin

Scale
Scale
Scali
ch disk 28
ling images 23
t All button 6
ting
color models 79
custom colors 86
objects 132, 133, 134
points 132, 134, 156

tion objects
defined 180
understanding 132

tion tools 7
Group Selection tool 7, 132
Object Selection tool 7, 132

tivity, pressure 76
rations, color 168
l number 2
s Quick Stroke command 104
Registration 2
Releasing, clipped objects 71
Removing

anchors 119
colorization 94
patterns 113

Removing, views 125
Renaming, documents 33
Repeat Accumulated Transform 

command 144
Repeat frame 121
Repeat Last Transformation 

command 143
Repeat tool 12, 53, 120, 122
Repeating

strokes 120
transformations 143, 144

Reversing paths 160
Revert to Saved command 34
Reverting 34
RGB colors 82
Ribbon mode 106
Rotate tab 139
Rotating objects 138
Rotation tool 10, 139
Round

cap 102
join 102

Rulers
displaying 21
hiding 21

S
Saturation 79

Scrat
Scrol
Selec
Selec

Selec

Selec

Sensi
Sepa
Seria
Set A
e Object tools 9
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porting 30
 a path 67
leasing from a path 68
Path command 68
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 file format, exporting 31
mand 22
, 181
m button 6

t command 70
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tion 12
Ellipse tool 10, 66
Rectangle tool 10, 65

Shape, Skeletal Strokes and 108
Shear tab 141
Shear tool 11, 141
Shear/Width handle 105, 106

defined 180
Multi-view strokes and 125

Shearing
objects 141
strokes 106, 142

Show Grid command 21
Show Rulers command 21
Skeletal Strokes

applying 102
color and 92
creating 103, 116
defined 116, 180

Starting Expression 2
Status bar 21
Stroke Definition Box tool 116, 123
Stroke Definition window 116, 123
Stroke tab 99
Stroke Warehouse palette 18, 103

preferences 27
Strokes

applying 103
attributes 99
copying 88
defined 181
editing 99, 117
fixed width 100
gradient 88
Multi-view 122
none 99
patterns and 114
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ols 7

olbar 7
mation handles 133
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irror tab 140
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editing 105, 117
modes 105
randomizing 108
repeating 120
reversing 160
shape 108
width 105

Smooth button 13, 157
Smooth continuity 157
Smoothed polyline objects, creating 64
Smoothed Polyline tool 9, 64
Solid, fills 110
Source imagery 180
Source path 181
Speed, animation 127
Split Path tool 7, 159
Splitting, paths 159
Square cap 102

repeating 120
shearing 106, 142
twisting 107
width 100

Stylus
defined 181
using 76

Subtractive color model 82, 93
defined 181

Supplemental Drawing tools 9
B-Spline tool 9, 63
Polyline tool 9, 63
Smoothed Polyline tool 9, 64

Symmetrical button 13, 157
Symmetrical continuity 157
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anslate tab 137
Squares, creating 65
Stacking objects 151
Standard toolbar 5

Tagging, paths 74
Tangent handles 156

defined 181
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Transformation tools 10, 112, 134

  

Unstructuring, objects 161

    

Windows
arranging 22
multiple 21

frame view 135
 file format

exporting 31
importing 30

space 20

  

 in command 22
 out command 22
ing
in and out 22
Zoom ratio 22
Mirror tool 10
Perspective tool 11, 142
Rotation tool 10, 139
Scale tool 10, 138
Shear tool 11, 141

Transformations
accumulated 143
committed 144
patterns and 112
repeating 143
shortcuts 143

Transforming objects 136
Translate tab 137
Transparency

applying 98
exporting and 29
printing and 166

TSR applications

Up One button 6
Up One command 71
Use Quick Stroke command 105

V
Value Picker 80
Vector graphics

defined 181
exporting 31
importing 30
understanding 28

Video compression 128
Video drivers, incompatibility 173
Video for Windows

animation 126
compression 128

View

Wire
WMF

Work

Z
Zoom
Zoom
Zoom
conflicts 175
turning off 174

Twisting strokes 107

U
Unconstrained button 13, 157
Unconstrained continuity 157
Undo

command 33
operations 33
preferences 27

Ungroup command 145
Ungrouping objects 145
Union

defined 181
operations 72

Union button 15, 72

adding 124
moving 126
Path 135
preferences 27
preview 135
removing 125
Wireframe 135

View All command 22
View bar 123
Viewing

objects 135
points 135, 136

W
Width

Skeletal Strokes 105
stroke 100
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Fractal Design License Agreement

 

THIS LICENSE AGREEMENT IS A LEGAL 
AGREEMENT BETWEEN YOU, THE END 
USER, AND Fractal Design Corporation. IT 
IS A LICENSE AGREEMENT AND NOT AN 
AGREEMENT FOR SALE. PLEASE READ 
THIS LICENSE AGREEMENT CAREFULLY 
BEFORE OPENING THIS SEALED PACK-
AGE. IF YOU DO NOT AGREE WITH THE 
TERMS AND CONDITIONS OF THIS 
LICENSE AGREEMENT, PROMPTLY 
RETURN THE PACKAGE UNOPENED TO 
THE PLACE YOU OBTAINED IT AND YOUR 
MONEY WILL BE REFUNDED.

 

Fractal Design Software License

 

1) License

 

 

This software can only be used on a single 
computer at any one time. This means 
that the software should be loaded on 
only one hard drive at a time. If you wish 
to use this software on more than one 
computer, you must either erase the soft-
ware from the first hard drive when you 
move the software to a second hard drive, 
or else purchase two copies of the soft-
ware. You may not under any circum-
stances have this program loaded onto 
the hard drives of two or more computers 
at the same time. You also may not copy 
this software onto a hard drive and then 
use the disks on another computer. The 
software may be executed from a com-
mon disk shared by multiple computers 
provided that one authorized copy of the 
software has been licensed for each com-
puter executing the software.

 

2) Copyright

 

 

This software is owned by Fractal Design 
and is protected by United States copy-
right laws and international treaty. By law, 
you, the end user, may do the following:

a) make a copy of the software solely

 

 

 

for 
backup or archival purposes; or

b) transfer the software to a single hard 
disk, provided you keep the original 
solely for backup or archival purposes.

United States copyright laws prohibits 
you from making any other copy of the 
software for any reason without our per-
mission. These federal copyright laws 
also prohibit you from copying the writ-
ten materials accompanying the software 
without first obtaining our permission. 

 

3) Restrictions

 

 

You may not rent, lend, lease, or assign 
this software. You may, however, transfer 
the software and the accompanying writ-
ten materials on a permanent basis. When 
you transfer the software on a permanent 
basis, you may not keep any copies, and 
you must remove the software from your 
hard disk. Also, the person to whom you 
transfer the software must agree to the 
terms of this License.

You may not alter, modify or adapt the 
software or accompanying materials. In 
addition, you may not translate, decom-
pile, disassemble or reverse engineer the 
software. You also may not create any 
derivative works based on this software. 
A derivative work is defined as a transla-
tion or other form in which the software 
may be recast, transformed or adapted.

 

4) Limited Warranty

 

 

Fractal Design Corporation warrants that 
this program will perform in substantial 
compliance with the published specifica-
tions and documentation supplied in this 
package, provided it is used on the com-
puter hardware and with the operating 
system for which it was designed. This 
warranty is limited to a period of 90 days 
from the date of the original purchase. 

Fractal Design Corporation warrants that 
the original disks and documentation are 
free from defects in material and work-
manship, assuming normal use, for a 
period of 90 days from the date of pur-
chase. 

 

5) Remedies

 

 

If you report a significant defect in perfor-
mance of the software in writing, within 
90 days of purchase, Fractal Design Cor-
poration will attempt to correct it or, at its 
option, authorize a refund of your license 
fee.

If a defect in the disk or documentation 
occurs during this period, you may return 
the faulty disk or documentation, along 
with a dated proof of purchase, and Frac-
tal Design Corporation will replace it free 
of charge.

 

6) No Other Warranties

 

 

Except as specifically provided above, 
Fractal Design Corporation makes no 
other warranty or representation, either 
express or implied, with respect to this 
software, the disks or documentation, 
including their quality, merchantability, 
or fitness for a particular purpose. In no 
event will Fractal Design Corporation be 
liable for direct, indirect, special, inciden-
tal, or consequential damages arising out 
of the use or inability to use the software 
or documentation, even if Fractal Design 
Corporation has been advised of the pos-
sibility of such damages.

The warranties and remedies set forth 
above are exclusive and in lieu of all oth-
ers, oral or written, express or implied.

Fractal Design Corporation is not respon-
sible for any costs including, but not lim-
ited to, those incurred as a result of lost 
profits or revenue, loss of time or use of 
the software, loss of data, the costs of 
recovering such software or data, the 
cost of substitute software, claims by 
third parties, of other similar costs. In no 
case will Fractal Design Corporation’s lia-
bility exceed the amount of the license 
fee.

The warranties provided give you specific 
legal rights. You may have other rights 
which vary from state to state. Some 
states do not allow the exclusion of inci-
dental or consequential damages, or the 

limitation of how long an implied war-
ranty lasts, so some of the above may not 
apply to you.

 

7) U.S. Government Restricted Rights

 

 

Fractal Design Expression and documen-
tation thereto are provided with 
RESTRICTED RIGHTS. Use, duplication or 
disclosure by the Government is subject 
to restrictions as set forth in subpara-
graph (c)(1)(ii) of the Rights in Technical 
Data and Computer Software clause at 
52.227-7013. The contractor/manufac-
turer of Fractal Design Expression and 
documentation thereto is Fractal Design 
Corporation, 335 Spreckels Dr., Suite F, 
Aptos, California 95003, (408) 688-8800.
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ctal.com, to see

ollowing conditi

m, step by step: 

Mac

No Whe

No
Fractal Design E
Troubleshooting

Fractal Design Technical Support 

Phone: (408) 430-4200 

Fax: (408) 438-9672 

Date:__________________________________

Do symptoms appear: Consistent

Description of Problem: 
Your Name: ___________________________

Phone: ________________________________

Fax:___________________________________

❐ Macintosh ❐ Windows

System Software version: _______________

Fractal Design Software version (ex. 4.1.2)

Found on the splash screen:___________________

Serial #: _______________________________

Have you checked our Website, www.
already posted?  ❐ Yes ❐ No

Does the problem still occur under th

Describe how to duplicate the prob

1)

2)

3)

4)

Windows 

Using Standard VGA video driver? Ye

When all TSRs are off? Ye
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